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Description 

The course provides a solid foundation on the concepts of MicroStation set in the Florida 

Department of Transportation (FDOT) Workspace. Beginning with setting up a drawing and 

concluding with complex elements, the participant is walked through a typical workflow using the 

tools and features of MicroStation.  Interspersed throughout are real-world design problems solved 

using the concepts in the course.  Various engineering disciplines are represented in the form of 

hands-on exercises. 

Objectives 

This course includes but is not limited to: 

• Design Files 

• Design Environment 

• Viewing and Zooming 

• Models 

• Levels 

• Basic Drawing Tools 

• Drawing with Precision 

• Changing Elements 

• Selecting and Grouping 

• Drawing Annotation  

• Cells and Points 

• Hatching and Patterning  

• Placing Dimensions  

• Information and Measuring Tools  

• Reference Files, Raster Images & Point Clouds  

Prerequisites 

No prior CADD experience required, but some manual drafting or related CADD product 

experience is recommended. 
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1 DESIGN FILES 

INTRODUCTION 

This course was developed to introduce MicroStation users to the V8i SELECTseries4 Essentials tools for the 

design and development of Florida Department of Transportation (FDOT) projects.  The intent is to cover the basics 

and give the user general knowledge of MicroStation with FDOT’s customization to assist the user in producing a 

product that is in compliance with the FDOT Computer Aided Design and Drafting (CADD) Standards. 

OBJECTIVES 

This chapter reviews the MicroStation design environment within the Florida Department of Transportation 

(FDOT) Workspace. Special consideration is given to: 

• MicroStation Design Files 

• FDOT Seed Files 

• Launching MicroStation in FDOT Workspace 

• File Open in FDOT Workspace 

• FDOT Discipline Configurations 

• Creating Files in FDOT Workspace 

• Design File Settings 

• FDOT Preferences 

• MicroStation Help and Support 

• FDOT Help and Support 

MICROSTATION DESIGN FILES 

The MicroStation V8i format is a subset of the .DGN file format used by previous versions of MicroStation, and 

the .DWG file format used by AutoCAD.  This gives MicroStation native support for both products, as well as the 

.DXF format. 

A design file (.DGN), often referred to as design herein, is a container for smaller containers called models.  Each 

model consists of graphical elements such as arcs, lines and circles.  Each model is a unique drawing within the 

design file, which allows multiple drawings to reside in the same design file.  For example, a roadway design, 

profiles, and plan and profile sheets can exist as separate models in a single design file.   

Note Only one design file is opened at a time in MicroStation, but other design files may be viewed by 
attaching them as References to the active model in the open design file. 

 

MicroStation Design File

DGN

Roadway Design 
Model

Profile Model
Plan & Profile 

Sheet Model
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FDOT SEED FILES 

Each MicroStation design file is created form a seed file. A seed file is a previously stored design file, with user 

specified settings, used as a template to create a new DGN.  The Florida Department of Transportation (FDOT) has 

created seed files for use in production that have standard settings stored within them.  Available seed files for the 

FDOT’s purposes are: 

FDOTSEED2D.DGN  Contains settings to create a 2D design file. 

FDOTSEED3D.DGN  Contains settings to create a 3D design file. 

FDOTSEED2D.DWG  Contains settings to create AutoCAD files. 

FDOTSEEDKEYMAP.DGN A 2D design file containing additional model setup for Key Maps. 

FDOTSEEDXS.DGN  A 2D design file containing additional model setup for Cross Sections. 

RWSEED2D.DGN  A 2D design file containing unit labels specific to Right of Way. 

STRUCTURESSEED.DGN A 2D design file containing unit labels & settings specific to Structures. 

STRUCTURESSEED3D.DGN A 3D design file containing unit labels & settings specific to Structures. 

LAUNCHING MICROSTATION IN FDOT WORKSPACE 

FDOT has created and provided a custom workspace to standardize the MicroStation environment for agency use.  

This workspace determines how MicroStation displays on the screen and sets up certain default files and search 

paths.  FDOT’s customized MicroStation workspace can be launched by the following common avenues:  

Double-click the FDOT icon from the FDOT desktop folder. 

From the Windows Start menu, select Start > All Programs > FDOTSS4 > FDOTSS4. 

Drag and Drop any design file with a DGN extension onto the FDOTSS4 icon in the FDOT desktop folder. A 

MicroStation session with the FDOT workspace will launch with the selected file. 

   

 

Note Opening a MicroStation session from the Bentley program group or by double clicking on a DGN file will 
open MicroStation in an Untitled workspace and not within the FDOT workspace. 
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FILE OPEN IN FDOT WORKSPACE 

When MicroStation launches without a specified a design file, the File Open dialog will display.  File Open is used 

to manage design files, performing file-related tasks, such as creating and opening drawings. 

 

Note The “Classic” Open dialog is set to display through the MicroStation menu option Workspace > 
Preferences > Look and Feel by “un-checking” the Use Windows File Open Dialog checkbox.  

The File Open dialog contains standard navigation tools such as a drive list and files list.  Selecting a file from the 

central window displays a preview of the selected file on the right-hand side.  Right clicking on a file opens a drop 

down menu with file options for use on the selected file. 

 

The File name identifies a specific file selection and List Files of Type filters which type of files display in the Files 

list box.  For example, to view DGN files only, change the option to MicroStation DGN Files [*.dgn].  

The Options button only displays when selecting DWG file formats.  FDOT Software delivery provides preset 

settings found within this option and does not recommend users to make any changes. 
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FDOT WORKSPACE COMPONENTS 

A workspace in MicroStation is a collection of predefined settings and configuration variables that 

accommodate agency standards and configurations for their work environment. FDOT has created its own 

workspace to accommodate FDOT CADD Standards. 

Project configuration files exist in order to facilitate sharing of configurations among users in a workgroup.  

The settings in each User configuration file allow each user in a workgroup to customize MicroStation, 

while the shared settings of the Project configuration file provide uniformity within the workgroup.  The 

project configuration file is the file that is selected when the Project component is set in the Workspace 

section in MicroStation Manager.  The FDOT created workspace is composed of 3 areas: 

 

• User - Sets User configuration variables. This component in effect points to the active 

workspace's Project and Interface components. The user name identifies the user configuration 

file (.ucf), which is stored in FDOTSS4 \ Workspace \ Users directory.  This should default to 

FDOTSS4. 

 

• Project - Sets Project configuration variables specific to a certain project, such as path location 

of files. A project consists of customized data files identified by configuration variables in the 

project configuration file (.pcf), which is stored in the local E \ Projects directory created for 

FDOTSS4. The dropdown list views all Projects created with a .pcf file and defaults to the last 

Project opened. If no projects have been previously created then this will default to No Project. 

 

• Interface - Sets the active user interface. FDOT has a customized user interface defined in a 

DGN library that is stored in the local FDOTSS4 \ Workspace \ Interfaces\ MicroStation 

directory. This should default to FDOTSS4. 

 

Note FDOTSS4 has customized (User) Preferences defined in a user preference file (.upf) that is stored in the 
local FDOTSS4 \ Workspace \ Prefs directory. This file is updated when the user makes any preference 
selections and “Saves Settings”. 
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SWITCHING DESIGN FILES 

Once a DGN file is open, users are allowed to switch to other DGN files by selecting the MicroStation menu 

option File > Open <OR> hold the Control key down and select the letter ‘O’ (Ctrl+O). The Open dialog 

displays with abbreviated options as in the File Open dialog.  It is not necessary to return to the MicroStation 

File Open dialog to open another drawing. 

 

To navigate to a different directory, select the directory form the Directories list in the middle of the dialog. 

To open a design file, select it from the Files list and click OK, <OR> double-click on the file name to open 

it. 
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FDOT DISCIPLINE CONFIGURATIONS 

FDOT CADD Software is delivered with Configurations within the FDOT Workspace which dictate discipline 

specific FDOT Menu options, file specification and resource files for each of the FDOT Standards for Roadway, 

Structures, Right of Way, Utilities and Photogrammetry Disciplines.  Users may change to the appropriate 

Configuration while in a MicroStation session from the FDOT Menu option:  Standard > Configuration. 

The following reflects just the FDOT Standard menu bar which discipline specific menus build upon.  Further details 

regarding the FDOT Menu options are covered in Chapter 2 of this document. 

Any design file can be opened in any configuration, but the appropriate Configuration must be used with the 

associated discipline design files to gain access to the corresponding tools and resource files used within the FDOT 

automated tools and utilities. 

 

 

Roadway Menu (Only three of the available Standard Menu Discipline Options display below): 

 

Structures Menu: 

 

Right of Way Menu: 

 

Photogrammetry Menu: 
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CREATING FILES IN FDOT WORKSPACE  

While standard MicroStation tools can be used to create new files, FDOT provides a utility to create new files with 

the correct seed file and file naming structure already in place.  This FDOT utility can be used within a MicroStation 

session or outside of MicroStation.   

To access this FDOT utility within a MicroStation session, select the FDOT Menu option Actions > Create/Edit 

File: 

 

<  
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CREATE FILE / PROJECT DIALOG  

The Create File/Project application is used to create MicroStation design files, Compbook Excel files, and 

other files in accordance with the FDOT standard file naming conventions.  Create File/Project uses an ASCII 

text file, called a Control File (*.ctl) to perform these task(s).  

Note This application can also create projects, although Electronic Delivery is the recommended method for 
creating new FDOT projects.  
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A description of the Create File/Project dialog is listed below: 

Project Defines the file path where files for the project will be created.  Clicking the Project 

Settings button allows for the creation of a new project <OR> navigation to select an 

existing project to use.   

Workspace Defines the current workspace. 
Control File Defines the control file, which sets all other information in Create File/Project dialog.  Use 

the Control File dropdown arrow to select the appropriate control file. There are five 

available control files: 

GEOTECH.CTL for Geotechnical related files. 

MECHELEC.CTL for Mechanical and Electrical related files. 

ROADWAY.CTL for Roadway related files. 

RW.CTL for Right-of-Way related files. 

STRUCTURES.CTL for Structures related files. 

Upon selection of a Control File, all other fields automatically populate with FDOT 

standard information. 

File Group Each control file has several File Groups to choose from.  Each group is a specific area of 

design.  Selecting a file group automatically loads the file types related to that group into the 

File Type list box.  

File Type Selecting a File Type automatically sets all of the settings for the Output File (Name), Output 

folder, and Seed File fields, of the file to be created. If a file with the same name already 

exists, the numbering is automatically incremented. 

Output File 

These settings are automatically set when the Control File, File Group and File Type are 

specified.  Only the Output File may be modified directly.  Browse buttons are provided to 

change the Output Folder or the Seed Path, if needed. 

Output Folder 

Seed File 

Seed Path 

Action When a MicroStation design file is created and opened, this text field can be used to enter 

MicroStation commands, such as set active scale to 10 (AS=10).  To execute the command, 

click the Apply Action button.  Action functions similarly to the MicroStation Key-in 

utility. 

Create Selecting the Create button executes the creation of a new DGN file as specified by the 

selections made and saves the file to the Output File and Output Folder specified. Click the 

Create button more than once to create multiple new DGN files where needed. The 

application will automatically increment the numbering of subsequent files with the same 

file name. This is useful when more than one blank copy of a particular type of DGN file is 

needed, such as, Plan and Profile Sheets. 

Open File Selecting the Open File button opens the newly created MicroStation file. 
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➢ To create a new design file: 

1. Open the Create File/Project dialog by selecting FDOT Menu option: Actions > Create/Edit File.  

The Create File/Project dialog displays. 

2. Click the Project Settings button, and then click the Select Active Project button to select an existing 

Active Project.   

Note Create a New Project is covered in the Plans Preparation training course. 

 

 

3. From the Select Active Project dialog, click OK and then click OK to close the Project Settings 
dialog.  The Create File/Project dialog displays. 

4. From the Create File/Project dialog, click on the Control File dropdown arrow to select appropriate 

Control File: 

 

5. Click on the File Group dropdown arrow to select the applicable Discipline Group. This will populate 

the File Type window with the associated files for selection. 

6. Select the File Type to create and then click the Create button.  The new design file is automatically 

created as specified and saved under the corresponding discipline folder. The Create File/Project 
dialog remains open to continue creating as many new design files as needed.  

Note If creating a new Project, the FDOT standard project directory structure will be automatically created and 
saved where specified.   

7. Select the Open File button to open the newly created design file in MicroStation. 
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DESIGN (DGN) FILE SETTINGS  

When a new design file is created, it is recommended to review the set-up of the design file parameters that control 

how the drawing functions.  The most common file settings are found in the design File Settings dialog which 

provides control over such settings as highlight colors, coordinate readout and grid settings.  To access design File 

Settings, select the MicroStation menu option Settings > Design File. 

 

Note It is important to note that, if the proper Seed File is used when the MicroStation file is created, then 
there should be NO need to change any of the design file settings. 

WORKING UNITS 

Working Units consists of controls that are used to set “real world” units of measurement for design models.  

MicroStation recognizes Metric and English units, either of which may be selected.  Additionally, users can 

create their own custom units, by relating them to the standard units (Metric or English).  Changing between 

the units used in a model makes no difference to the size of geometry in the model; alternatively, changing 

the Resolution setting in the Advanced Settings does change the size of existing geometry in the model.  In 

practice, the Resolution setting will rarely, if ever, have to be changed from the default. 

 

Note Different models, contained in the same design file can have different Working Units assigned to them.  
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GLOBAL ORIGIN 

The global origin for FDOT’s standard seed files are set to an XY coordinate of 0, 0. The global origin can 

be relocated to specific coordinate values to create a custom coordinate system.  

When using Create/File Project to create MicroStation files, a predefined seed file is used to create each 

design file automatically and thus the global origin is set to FDOT standards. 

FDOT PREFERENCES 

COMPRESSING DESIGN FILE 

When elements are deleted from a MicroStation design file, the elements no longer display in the design, 

but a record of the deleted elements remains in the design file.  The Compress Design File command removes 

the records, which reduces the file’s size. 

The undo buffer is cleared when a design file is compressed, so after compressing, the user will no longer be 

able to undo any previous operations. 

It is best to use the Compress Design File command at the end of an editing session. This can also be set to 

happen automatically upon exiting the design file. To enable this setting, select Workspace > Preferences 

from the MicroStation menu bar, select the Operation Category and populate the checkbox for Compress 

File on Exit. 
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SAVING DRAWINGS 

By default, MicroStation saves drawing changes automatically.  MicroStation design files are saved in DGN 

format while AutoCAD drawing files are saved in DWG format. 

The fact that the file is saved automatically is a very powerful feature of the software.  This gives the user 

security of knowing that in the event of a computer crash or power failure, the design changes for the last 

completed command are saved. 

Only changes to design elements are saved automatically.  File settings (active color, view setup) must be 

saved using the MicroStation menu option:  File > Save Settings <OR> [Ctrl] + [F] on the keyboard. This 

preserves all file settings to ensure reflection of current settings in future openings of the file. 

Note Right-clicking on the FDOT Menu displays a popup menu with a Save Settings option.  This is NOT the 
same function as described above, but only saves the location of the FDOT Menu when repositioned by 
the user. 

To disable this feature, select the MicroStation menu option: Workspace > Preferences and then select the 

Operation Category in the Preferences dialog.  Uncheck the Automatically Save Design Changes checkbox. 

 

If Automatically Save Design Changes is disabled, the user must manually save the file by clicking the 

MicroStation menu option: File > Save.  Selecting File > Save As allows the user to save the file as a V8, 

V7, DWG, or DXF file format.  The Save As command can also be used to create a backup of the design file. 

Note Save Settings can be set to execute automatically from this Operation Category of the Preferences dialog, 
by checking the Save Settings on Exit checkbox. 

To return to the File Open dialog during an editing session, select the MicroStation menu option:  File > 

Close. 
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MICROSTATION HELP AND SUPPORT 

MicroStation provides Help and product support thru online services, documentation and Tool Tips that can be 

accessed from the MicroStation menu bar once a session is opened. 

 

CONTENTS 

The on-line help file is accessed under the Contents tab on the Help menu. The user can find solutions to 

frequently asked questions or search for help on a specific topic. 

 

If the Index tab is selected, then an index is presented in the left window pane where the user may sort and 

select topics of interest.  Once selected, the right window pane is populated with information on the selected 

topic. 
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FDOT HELP AND SUPPORT 

The FDOT Production Support Office | CADD provides many venues of help and support whether one-on-one; self 

help; or group assistance.  The FDOT Customer Support Guide is published on the CADD website under the 

Publications link to explain how to get help, who to contact and what to expect. 

From the FDOT Desktop folder, the user will find links to join a GoToMeeting for one-on-one support; connect to 

FDOT’s forum on the Bentley Communities website; connect to the FDOT PSO|CADD’s website for on-line 

support; and an option to submit their own Support Request via FDOT PSO|CADD’s online support portal. 

 

From within a MicroStation session, the user will find many Help and Support links under the FDOT Menu option: 

Standard as shown below. 

• Throughout the FDOT Menu, Help icons, such as , can be found next to most menu options which 

will link the user to Help files specific to those options.  

• The FDOT CADD Office has many links to contact Support staff for assistance or find resource material 

within the CADD website. 

• There is an FDOT CADD Support Forum for users to globally submit issues for any CADD user to 

respond.  This forum is maintained and  monitored by the PSO|CADD staff , but also opens the door to 

many other resources for assistance. 

Through the CADD’s website, the user will have access to much more Help and Support assistance through 

Publications; Downloads; Training Courses; FDOT Training Manuals; GoTo Webinars; Quick Clips; Frequently 

Asked Questions (FAQ); Quick Links and links to other offices and outside professional resources. 
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2 DESIGN ENVIRONMENT 

OBJECTIVES 

This chapter discusses the design environment within MicroStation.  Highlights of this chapter include: 

• DGN / DWG Work Modes 

• Workspace Preferences 

• Screen Layout 

• Standard FDOT Menu 

• MicroStation Drawing Tools 

INTRODUCTION 

MicroStation provides an interface that is user friendly and customizable. Most tools are accessed from toolboxes.  

In addition to various tools, MicroStation also works in one of three modes; DGN, DWG or V7.  The various modes 

maintain uniformity when working on older files or files in DWG format. 

Additional controls for the actual design environment can be accessed via Workspace > Preferences from the 

MicroStation menu.  The options and settings located here control several aspects of the design environment 

including mouse operation, look and feel and view options. These settings can be stored as defaults so that every 

session of MicroStation operates in a standard manner. 

Drawing attributes are easy to control with MicroStation.  The main controlling application is the Attributes tool bar, 

which facilitates setting the element symbology with which elements are placed into the design files. 

DGN / DWG WORK MODES  

MicroStation natively reads and writes both the MicroStation DGN file format and DWG file format, thus enabling 

less data loss from sharing. To ensure compatibility with AutoCAD DWG and MicroStation V7 files, MicroStation 

V8 allows users to work in three different environments; DGN Capacity Work Mode, DWG Restriction Work Mode, 

and V7 Work Mode. 

  DGN Work Mode is the native format and is indicated with a blank field in the status bar.  The Work 

Mode changes automatically according to which file type is opened and is indicated in the lower right of the status 

bar by an icon.  

 DWG Work Mode is a working environment within MicroStation specifically adapted to edit and 

review DWG files.  DWG files can also be directly referenced from a MicroStation DGN file.  When a DWG file is 

opened in MicroStation, various MicroStation tools are restricted to ensure that no DWG-incompatible features are 

added to the DWG file while editing it in MicroStation. To create DGN files that are DWG compatible, turn on 

DWG Work Mode.  In both cases MicroStation restricts its tools to create only elements that are compatible with 

DWG format.  
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WORKSPACE PREFERENCES 

The Preferences dialog contains settings that customize the way MicroStation operates and looks.  To access the 

dialog, select the MicroStation menu option: Workspace > Preferences. 

 

The settings in this dialog work at the system level, which means that they are not specific to any design file, but are 

active no matter which design file is being worked in.  This dialog has many options which are referred to throughout 

this course manual. 

MOUSE BUTTON FUNCTIONS 

When using a mouse with MicroStation, the mouse buttons are used for three primary functions: Data, Reset, 

and Tentative.  The Data button can also be called the pick button because it is used to “pick” tools and points 

on the screen.  The Reset button cancels or restarts a command.  The Tentative buttons snaps to points on 

existing elements. 
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By default, the middle button is not set to Tentative, but instead Tentative is invoked by a two button chord; 

(clicking the left and right buttons at the same time).  To change the default button assignments, select the 

MicroStation menu option: Workspace > Button Assignments to display the Button Assignments dialog. 

 

➢ To Change Button Assignments: 

1. Click Remap Buttons button. 

 

2. Select a Buttons function to assign a selected mouse button. 

3. Complete instructions displayed in the Button Definition Area. 

4. Click OK twice to exit  

Note  A two button mouse generally uses the two button chord to invoke a tentative point. 
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MOUSE WHEEL FUNCTIONS 

The Mouse Wheel can be used to pan and zoom in a drawing.  Different zoom functions can be assigned to the 

wheel alone, using the wheel while holding the Ctrl key <OR> using the wheel while using the Shift key. 

Users can change the way that the wheel works through the Mouse Wheel category of the Preferences dialog.  

To access the Preferences dialog, select the MicroStation menu option: Workspace > Preferences. 

 

Wheel Sets the mouse wheel to zoom in and out by default. Options are Zoom In/Out, 

Walk Forwards/Backwards, Pan With Zoom, Pan Left/Right, Pan Up/Down, 

Slide Up/Down, or (none). 
Ctrl + Wheel Sets the mouse wheel to walk forward and backward (3D only) by default. 

Options are Zoom In/Out, Walk Forwards/Backwards, Pan With Zoom, Pan 

Left/Right, Pan Up/Down, Slide Up/Down, or (none). 
Shift + Wheel Sets the mouse wheel to zoom and re-center by default. Options are Zoom In/Out, 

Walk Forwards/Backwards, Pan With Zoom, Pan Left/Right, Pan Up/Down, 

Slide Up/Down, or (none). 
Alt + Wheel Sets the mouse wheel to change the Z elevation (3D only). Options are Zoom 

In/Out, Walk Forwards/Backwards, Pan With Zoom, Pan Left/Right, Pan 

Up/Down, Slide Up/Down, or (none). 
Zoom In/Out 

Ratio 

Sets the zoom ratio increment for each turn of the mouse wheel. Default is 1.750. 
Navigate 

Distance 

(Cursor/Wheel) 

Obsolete, no longer supported. 

Navigate 

Distance (Mouse) 

Obsolete, no longer supported. 
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SCREEN LAYOUT 

MicroStation’s screen layout may be customized to open with components in the same position for every editing 

session.  It may also be reorganized or changed on the fly during an editing session. FDOT has established a default 

layout that is set by the predefined FDOT workspace. 

The following is a review of the different components that make up the screen layout. 

 

MICROSTATION MENU BAR 

 

The MicroStation menu bar is located at the upper portion of the screen layout and may be docked or undocked 

based on the user’s preference.  It contains nine standard pull-down menus that provide access to the majority 

of the MicroStation dialogs, tools, and settings.  Additional software products may add additional menu 

options such as the Applications pull-down for GEOPAK.  The top portion contains information about the 

active file, including file path and name of the active design file, active model name, type of model, active 

design file format and the version of MicroStation loaded. 

By default the Primary Tools and Attributes toolboxes display docked in this upper portion when a new 

MicroStation session is opened.  The user may modify what toolboxes are displayed in this upper portion by 

selecting on the MicroStation menu option: Tools, selecting any toolbox and then docking that toolbox to the 

upper portion.  Each toolbox can be customized as well by right clicking on the toolbox and selecting or 

deselecting in the tools popup window. 
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TASKS DIALOG 

MicroStation supports task-based workflows, predefined or customized. A task is a set of any tool references 

grouped to facilitate a particular job, which can be grouped into standard toolboxes, custom toolboxes, or a 

combination of both types to suite any production need. The Task dialog, usually located docked to the left of 

the MicroStation window, displays those tools, tasks, and workflows for easy selection.  A detailed discussion 

is found later under the Accessing Tools Section of this chapter. 

 

VIEW/APPLICATION WINDOW 

The View Window is the area where the design elements are displayed.  MicroStation allows a maximum of 

eight view windows to be open at any one time.  The arrangement of the view windows can be customized 

within the application window. 

   

VIEW CONTROLS 

Each view window has its own view controls to View Attributes, Update View, Zoom In/Out, Window Area, 

Fit, Rotate, Pan, View Previous and Next, Copy, Display Mode, Clip Volume and Mask.  By default these are 

located at the top left of the MicroStation view window.  

Note View controls are discussed in detail in Chapter 3. 
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VIEW GROUP TOOLBOX  

A View Group is a named collection of eight view windows which allows for the set up of the desktop to 

display preferences including number of open view windows, window size and view orientation. Each view 

group is associated with a model making it easy to access and navigate through different models in the active 

DGN file, via the View Group drop-down menu. By default this is docked at the bottom of the Layout Dialog 
above the Status Bar. 

 

ACCUDRAW TOOL SETTINGS 

This is used to facilitate data point entry. The AccuDraw Tool Settings opens or closes when clicking the 

AccuDraw icon on the Primary Tools toolbox. If using the default Function key menu, pressing <F11> opens 

the AccuDraw Tool Settings. If it is already docked or open, pressing <F11> sends focus to the AccuDraw 

Tool Settings. 

           

AccuDraw (Docked)                                                             AccuDraw (Floating) 

STATUS BAR 

 

The Status Bar is located across the bottom of the screen layout and provides 

prompts, context-sensitive assistance and some interactive functionality, 

which are described next. The label for the Status will display by hovering the 

cursor over any box. The user may customize the Status Bar by right-clicking 

on it to open a check list of options to check on or off for display. 
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  Selected Tool > Prompt shows the name of 

the selected tool or view control and (usually) a prompt for the next step in the normal procedure for using it. 

 

   Message Center shows the system message information. Clicking in the Message Center 

portion of the status bar (field following the >Prompt) opens the Message Center window. This window 

contains a running log of system messages and any further description about the message if applicable. 

 

  Snap Mode shows the type of snap selected with the associated icon.  

Clicking the Snap Mode field posts the pop-up Snap Modes menu. The effect is 

the same as pressing the Tentative button while holding down the <Shift> key. 
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  Active Locks icon provides access to the Locks submenus. (It does not 

indicate status information.)  

  

 

 

  Active Level area indicates the Active Level setting.  

Clicking the Active Level field opens the Level Manager dialog, which is used to 

control level display and level symbology for the open DGN file and attached 

references. 

  Selection Set, if shown, indicates elements are selected 

and displays the number of selected elements.  If no elements are selected, this field 

on the Status Bar is blank.  Clicking the status bar when it shows the number of 

selected elements opens a pop-up menu containing the following items: 

 

 Tasks (Hidden by default) shows the name of the current task. 

 Running Coordinates displays the longitude and latitude coordinates of 

the current position as the cursor moves across the view. Click the box to open the pop-up menu of options 

 

  Fence Indicator, if shown, indicates the fence mode of the fence that was placed.  If there is no fence 

placed in the design file, this field on the Status Bar is blank. 
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  DGN Work Mode indicates which Work Mode is in effect. MicroStation natively reads and writes 

both the MicroStation DGN file format and the DWG file format thus enabling less data loss from sharing.  

DGN Work Mode is indicated with a blank field. 

•  DWG Work Mode is a working environment within MicroStation specifically adapted 

to the editing and reviewing of DWG files. In DWG (“DWG”) mode, certain functionality is 

disabled by default in order to restrict MicroStation to creating only information that can be 

stored in DWG format. A DWG file can be directly referenced from a MicroStation DGN file. 

  File Changed, if shown in the lower right-hand corner, indicates that the DGN file has been modified 

during the current session. If the preference Automatically Save Design Changes is off, it indicates that there 

are changes that have not been saved. If the diskette is red and has an “X” through it, it means that the file is 

read-only. 

  Design History is indicated by an icon in the status bar.  If design 

history is not initialized, the icon is dimmed. If design history is initialized but 

there are uncommitted changes, a pencil is superimposed on the scroll. Clicking 

this icon opens a pop-up menu containing the following items:  

 

 

  

  Input Focus indicates the focus 

location. MicroStation follows actions 
and attempts to move input focus for 

common operations; for example, when 

placing a line the focus moves from Home 

to the AccuDraw dialog, then back to 

Home. 

 

 

 

 

 

 

  Digital Rights indicates if the file is protected and digitally signed. If none exists, then the box will be 

blank.   

Note Caution must be advised in using this option. 

•   When a pre-File Protection version of MicroStation V8 tries to open a protected file, it 

recognizes the file as a V8 encrypted file. MicroStation displays an explanatory message but 

will not open the file. 

•  The MicroStation status bar displays a signature icon when a file contains any file or 

model signatures. 
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STANDARD FDOT MENU  

The FDOT Menu is part of FDOT’s delivered customized workspace.  It is a floating menu bar that contains a 

collection of standard and discipline specific menus and command buttons designed to assist in plans production for 

FDOT projects.  The FDOT Menu automatically loads when the File Open dialog Interface is set to FDOTSS4 and 

is used to activate commands inside MicroStation through an efficient, portable, pull down menu interface that 

accesses all FDOT CADD standards and customization. 

The Standard FDOT Menu is the base menu setup from which all selected discipline specific menus build upon.  The 

menu bar settings, such as display color, opacity or menu location, can be modified by the user by right clicking 

anywhere on the menu bar to open a popup menu.  

Note The FDOT (right click) Menu option:  Save Settings must be selected to save any display modifications for 
this menu for future MicroStation sessions.  The MicroStation menu option: File > Save Settings does 
not apply to the FDOT Menu settings.  

 
 

 

Note The Help icons located by any FDOT Menu option provide links to associated Help files. 

STANDARD MENU 

Provides links to the FDOT software versioning, Discipline configuration access, CADD Training/Support 

links, external resource links and Level Library attachments.  Help icons located by any FDOT Menu option 

provide links to associated Help files. 
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CELLAPPS MENU  

Provides Cell Utility tools for easy access to select and place 

cells from the many Cell Libraries delivered and supported by 

FDOT. Help icons located by any FDOT Menu option provide 

links to associated Help files. 

 

 

 

 

 

 

ACTIONS MENU 

Provides links to FDOT Tools and Utilities commonly used by 

all disciplines, such as Project/File creation, Adhoc 

Management, and Sheet Clipping & Labeling.  Help icons 

located by any FDOT Menu option provide links to associated 

Help files. 

 

 

 

 

 

 

 

DESIGN APPS MENU 

Provides links to additional FDOT design-related apps commonly used by all 

disciplines, such as File Cleanup, Custom Line Style Apps, Reference File Apps 

and more.  Help icons located by any FDOT Menu option provide links to 

associated Help files. 
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DISCIPLINE MENU 

The standard FDOT Menu is the basis on which the user can choose to build configurations for FDOT 

Discipline specific menu options.  One or more may be selected through the FDOT Menu option: Standard 

> Configuration to display and provide links to FDOT tools and utilities directly associated to those specific 

disciplines for the ease of selection by the user.  Note that icons located by any FDOT Menu option provide 

links to associated Help files. 

 

COMMAND BUTTON OPTIONS 

 

    Run Plotscale opens the Set/Update Plot Scale dialog to establish Plot Scale. 

 

   Run QC Quick opens the QC Software for interactive reporting and correction of level and symbology 

for the active design file in compliance with the FDOT CADD Standards. 
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   Show Command List opens the Cadpilot UI TabList table which provides listings of discipline 

related Level Names and Level Descriptions for selection. 

 

   Open Browser opens the Internet Browser window. This Command button remembers the last browser 

window previously opened and returns to that window when executed. 
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   Label Sheet (Sheet Navigator) opens the Sheet Navigator dialog.  Sheet Navigator can be also accessed 

from the FDOT Menu option: Actions > Label Sheet (Sheet Navigator). 

 

MICROSTATION DRAWING TOOLS  

PARENT-CHILD RELATIONSHIP 

The MicroStation toolboxes are hierarchical; that is, there are 

“parent-child” relationships between toolboxes. The “parent” toolbox 

displays one tool from each of its “child” toolboxes.  The toolboxes 

can be closed by clicking on the close button (  ) on the far right 

side of any toolbox or by selecting the MicroStation menu option 

Tools > Close Toolboxes.  Any tool can be selected from a “child” 

toolbox thorough the dropdown menu of the “parent” toolbox without 

floating the “child” toolbox. This aspect of toolboxes helps minimize 

the screen space. 

DEFAULT TOOLBOXES AND DIALOGS 

When starting MicroStation for the first time, the Attributes toolbox, 

Primary toolbox, Main task and Tasks dialog are opened by default and 

docked.  The Main task is embedded at the top of the Tasks dialog.  The 

Attributes and Primary toolboxes are docked at the top of the MicroStation 

window along with the MicroStation Menu. These toolboxes control many of 

the settings for creating elements and individual tools. If not displayed when 

MicroStation is first launched, the user can open them by selecting Tools 

from the MicroStation menu. 

  



Chapter 2 ____________________________________________________ DESIGN ENVIRONMENT - MicroStation Drawing Tools 

2-16 © 2018 FDOT FDOT Bentley CADD Essentials  

ATTRIBUTES TOOLBOX 

The Attributes toolbox contains controls for setting the active element attributes that control the appearance 

of elements in a design file. These attributes include color, line style and weight, and are collectively referred 

to as symbology. 

 

While symbology can be set per element, FDOT uses the ByLevel feature in MicroStation and has created a 

set of CADD Symbology Standards.  FDOT has a standard listing of Levels preset with ByLevel Color, Line 

Style and Weight symbology. Users need only change the active level to change the active symbology. These 

Levels are grouped into specific FDOT Standard Rules which are used for compliancy checking of each FDOT 

standard design filename.  

To override the ByLevel setting of one of the symbology components, users can select an option from the 

Attributes Toolbox and choose the new symbology from the drop-down list. 

Note FDOT does not recommend overriding the ByLevel symbology settings. This will cause catastrophic 
consequences when other tools using symbology perform other functions.  This is especially true when using 
the GEOPAK application used by FDOT in conjunction with MicroStation for surveying and roadway 
design. 

All tools in a toolbox are not always visible by default.  A simple right-click on the toolbox will display a 

listing of available tools to populate the toolbox. 

PRIMARY TOOLS TOOLBOX 

The Primary Tools toolbox provides easy access to frequently used MicroStation tools that are production 

oriented such as Models, References, Levels, and Cells. By default it is docked to the top of the MicroStation 

window (directly beside the menu bar). 

 

• PopSet - A tool that toggles on/off and is used to automatically prevent the display of a Tool settings 

dialog while not adjusting its controls. This is a great way to reclaim valuable screen “real estate” and 

reduce pointer movement. PopSet is enabled by default. 

                                     

PopSet (Enabled)           PopSet (Disable) 
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• Set PopSet settings by right-clicking on the PopSet Icon and selecting Properties. 

 

• Key-in - A dialog that allows users to type in any MicroStation command, as well as browse through 

a command’s options. While nearly all of MicroStation’s commands can be accessed from either a 

toolbox or a pull-down menu, there are times when the user may want to type in a command.   

• The Key-in icon contains an adjacent down arrow. Clicking on the down arrow opens the building 

dialog in a pop-up mode to build the key-in when unsure of the run command key-in information. It 

closes automatically when the pointer moves off the dialog.  

 

Clicking on the Key-in icon opens a floating Key-in dialog with only the key-in field, which can be 

docked as shown below.  The Browse Key-in icon ( ) found on this dialog is used to open the 

building dialog shown above. 
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If the Key-in dialog is open, additional settings are available to make the display options more user 

friendly.  Right-clicking anywhere in the Key-in window, except the key-in field at the top, opens the 

Key-in Settings dialog. 

 

STANDARD TOOLBOX 

The Standard tool bar provides standard Windows options: New, Open, Save, Print, Cut, Copy, Paste, Undo, 

Redo, and Help.  This toolbox is not open by default. 

 

MAIN TOOLBOX 

The Main toolbox provides frequently used MicroStation tools used for element selection, manipulation, and 

modification. By default it is embedded as the Main task at the top of the Tasks dialog on the left of the 

MicroStation window (directly beside the view window). The toolbox can be opened by right-clicking on this 

task item and selecting Open ‘Main’ as Toolbox <OR> by through the MicroStation menu option Tools > 

Main.  

 

MicroStation offers Positional Keyboard Navigation (Keyboard Input). Each  “Parent” tool option of the Main 

task is associated with a keyboard number (1 – 9) as with each of the “child” options.  The user needs only to 

set the focus on the task bar and type the “Parent” number then the “child” number to access the specific tool.  

(See the section: Accessing Tools & Controlling The Focus below to see a chart of the Keyboard.) 
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TASKS DIALOG  

The Tasks dialog is docked by default on the left side of the MicroStation application window, but can be 

docked to the right by selecting the title bar and dragging the cursor over a docking indicator . The Tasks 

dialog may also be hidden (minimized) by selecting the Auto-Hide (push-pin) icon. Hovering the cursor 

over the minimized Tasks opens the Tasks window for selection. Reselecting the Auto-Hide (push-pin)   

icon restores Tasks to an open display. 

    

The previous drill down version of the Tasks Navigation tool is still available for navigational search by 

selecting the arrow to the right of the Task tab. 
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Each task item listed in the Tasks dialog extends to display the tasks groupings in three Layout Modes: Icon, 

List and Panel by way of selecting the applicable icon located on each Task title bar.   

  

Icon Layout 

     

  List Layout          Panel Layout 

MicroStation provides Positional Keyboard Navigation with mapping each Task “Parent” entry to a letter on 

the keyboard. Each “Child” tool within the toolboxes is mapped to a number or letter.  With the Focus placed 

on the Task, the user may type the “Parent” letter then the “Child” number to execute the tool.  For example: 

after placing the focus by selecting the Drawing Task group, the user my type ‘Q’ then ‘1’ to execute the Place 

Smart Line tool.  

Each Task may be opened as a toolbox by right-clicking on the Task and selecting Open…. as Toolbox from 

the pop-up menu.  As with the Icon Layout, these toolboxes have arrows to open dropdown selection lists of 

tools.   
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The FDOT Workspace provides a customized FDOT Task Workflow setup to assist the user in meeting the 

FDOT CADD Standards for specific disciplines. Upon selection of the FDOT workflow, an additional FDOT 

Task Tab displays at the top of the Tasks dialog and opens for selection.  Note that each of the FDOT Tasks 

may be opened as floating toolboxes as well. 

   

Note Click on the Tasks Tab to return to the main Tasks listing. 

DISPLAY / HIDE TOOLS 

MicroStation has dozens of drawing tools.  These drawing tools are grouped and displayed for convenient 

selection in Toolboxes.  The toolboxes can be grouped and referenced to facilitate a particular job to form a 

collection called a Task. A sequence of tasks can be grouped into Workflows.  All toolboxes and tasks can be 

customized.  MicroStation provides many preset toolboxes for the users.  FDOT has also customized many 

toolboxes. 

Note Only one task is active in MicroStation at any given time.  
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Tools are represented in toolboxes by icons. For simplicity, the term “tool” is used to refer both to a tool and 

its icon.  The arrangement of tools in a floating toolbox can be changed by resizing its window.    

MicroStation toolboxes and any specific tool can be displayed or hidden by:  

• Opening the Tool Boxes dialog to select or deselect toolboxes to display or hide by selecting 

from the MicroStation menu option Tools > Toolboxes at the bottom of the drop down list.   

 

• Opening the Show/Hide Tools dialog to select or deselect desired tools of a specific toolbox to 

show or hide by right clicking on any Toolbox and selecting the last option on the fly out menu, 

List.  
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DOCKABLE DIALOGS 

MicroStation allows for many dialogs to dock on the edges of the application window to save screen space. 

When a dockable dialog is dragged across the screen over any docking indicator, a transparent box displays 

towards the side allowable for docking. The user needs only to drag a dockable dialog over one of the indicators 

where the cursor touches the desired indicator, and then release it to attach to selected side. 

     

The following is the list of dockable dialogs, and which edges they can be docked to: 

• Tool settings window (left or right) 

• Element Information dialog (left or right) 

• Project Explorer dialog (left or right) 

• Link Sets dialog (left or right) 

• Tasks dialog (left or right) 

• Markups dialog (left, right, top, or bottom) 

• Item browser (left or right) 

• Details dialog (left, right, top, or bottom) 

• Feature Manager dialog (left or right) 

• References dialog (top or bottom) 

• Raster Manager dialog (top or bottom) 

• Models dialog (top or bottom) 

• Saved Views dialog (top or bottom) 

• Level Manager dialog (top or bottom) 

• Level Display dialog (left, right, top, or bottom) 

•  

Note These dialogs can be found on the Primary Tools toolbox.  The way in which one of these dialogs is docked 
differs from the way in which a toolbox is docked. 

Once a dockable dialog is docked, the user can hide it by clicking the Auto Hide (push pin) icon and minimizing 

it to a tab. The user needs only to hover the cursor over the tab to open the dialog for selection. 
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DOCKABLE TOOLBOXES 

MicroStation allows toolboxes to be docked along any edge of the application window. The user needs only 

to drag the toolbox by the title bar toward the edge of the window to allow it to dynamically jump to an 

appropriate sized docking area. When docked, the title bar does not display and borders become narrower. A 

single dragging operation can be used to undock by placing the cursor on the toolbox’s narrow border or on a 

blank area and dragging the box away from the edge. 

Note To move a toolbox or other dockable window to a docking area without docking it, hold down the <Ctrl> key 
while dragging the title bar. 

 KEYBOARD INPUT & CONTROLLING THE FOCUS 

In Microsoft Windows, the Input Focus (keyboard focus) is defined as the location to which the keyboard 

input is directed.  In MicroStation there is a hierarchical focus model with Home as the top level.  The current 

focus location is indicated in a Status Bar field at the bottom of the screen layout. The user needs only to hover 

the cursor over this field to determine location of the focus. 

When the focus is Home, the user does not need to use the mouse to navigate toolboxes, tasks or the Tools 

Settings window.  MicroStation provides positional keyboard navigation for the user with easy keystrokes 

using letters and numbers to select tools and adjust tool settings controlled through option menus and check 

boxes.  

Note Selecting the <Esc> key on the keyboard brings the focus back to Home.  It also reveals mapping codes on 
tool icons and tool setting windows. 

MicroStation position maps the keyboard by default with the following position mapping: 
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Exercise 2.1  Reviewing the Design Environment 

➢ Open a MicroStation Session in FDOT Workspace 

1. Click on the FDOT folder  to open the FDOT Desktop window and review options. 

2. Except for the FDOTSS4 icon, double-click the various other icons to open their respective windows and 

then select the Exit  icon from the upper right corner of each window to close, when review is 

complete.  

 

3. To open MicroStation in the FDOT Workspace, double-click on the FDOTSS4 icon.  The File Open 
dialog displays for review and setup. 

4. Set the FDOT workspace settings:  User set to FDOTSS4; Project set to 12345678901; and Interface set 

to FDOTSS4. 

5. Set Files of type to CAD Files (*.dgn,*.dwg,*.dxt) 

6. Select the design directory in the Look in: field by using the dropdown arrow next to the field to navigate 

to the e\projects\12345678901\roadway directory. Once selected the Name list box should populate. 

7. Select File Name: dsgnrd01 from the list. A preview of selected file will display on the right. 

 

8. Click Open.  A MicroStation session will open with selected file. 
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9. Review the MicroStation application window: 

a.   Title Bar with all the file and setting information;  

b.   Default toolboxes docked at the top with the standard MicroStation menu;   

c.   Default Tasks dialog docked to the left side;  

d.   Default Element Selection Tool settings window; 

e.   Default View Groups and AccuDraw docked to at the bottom along with the Status Bar. 

 

10. From the MicroStation menu, select Settings > Design File…. The Design File Settings dialog will 

display for review. 

11. Select each Category item to review the changing settings pane for each. 

12. Select Working Units Category and confirm/set the settings as shown below. 

 

13. Click OK when completed. 
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14. From the MicroStation menu, select Workspace > Preferences… The Preferences dialog will display for 

review. 

15. Select each Category item to review the changing settings pane for each. 

16. Select Operations Category and confirm/set the settings as shown below. 

 

17. Click OK when completed. 

18. Do not Exit MicroStation. 
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Exercise 2.2  Accessing and Displaying Tools and Toolboxes 

➢ Exploring the Tasks Dialog 

1. Continue with dsgnrd01.dgn for this exercise. 

2. From the Tasks dialog, select the FDOT Plans Development Task Workflow.  Notice that an additional 

FDOT Plans Development task tab displays with the preset FDOT tasks.  

 

3. Select the down arrows of Roadway Plans on the FDOT tasks to review the tools. 

     

4. Click on the FDOT Tools task bar and select each of the Layout Modes  icons. 

         

Icon Layout Mode   List Layout Mode   Panel Layout Mode 
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5. Right-click on the Roadway Plans task bar and select Open ‘Roadway Plans’ as Toolbox. 

 

 

6. Select the Tasks tab. The Tasks dialog displays. 

7. Click the down arrow to the right on the Tasks tab and review the Task Navigator drop down list. 

8. Click the plus (+) icon next to Main Classic task to expand the toolboxes, and then select Fence. 

9. The Tasks dialog tab changes to Fence tab. 

10. From the Task Navigator dropdown, select Tasks to return to the Tasks dialog.  

➢ Toolboxes 

1. From the MicroStation menu, select Tools and hover the cursor over the tools in the list to review the 

popup menus of respective tools.  

2. Hover over Text and select Place Text <OR> key-in the number ‘1’ to open the Text Editor window.  
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3. From the Text Editor window, select the Close  icon. 

4. From the MicroStation menu, select Tools > Tool Boxes to review all Toolboxes, Tool Frames and Tasks 

available for the user to select and open. The Tool Boxes dialog displays. 

5. Select the down arrow on the right side of the tool listing and review the different tool listings from the 

dropdown menu. 

 

6. From the tool listing window, scroll down and select the Modify toolbox and click OK. The Modify 

toolbox displays and the Tool Boxes dialog disappears. 

 

7. Right click on the Modify toolbox to bring up the tool selection popup menu. Notice that only one tool at 

a time can be checked or unchecked for displaying in toolbox. 
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8. From the tool selection popup menu, select List… Show/Hide Tools dialog displays. Notice that multiple 

selections can be made by checking or un-checking tool options for display in the toolbox.  

 

9. Un-check Trim to Intersection and Insert Vertex, then click OK.  These tools are removed from the 

Modify toolbox. 

 

10. Select and hold the title bar of the Modify toolbox and then drag it to the right side of the application 

window. The toolbox will ‘jump’ to the side and reduce in size to a tool bar. Release the hold on the title 

bar.  It is now docked to the side of the screen layout.  

11. Select and hold at the front dotted bar of the Modify toolbox, and then drag to the center of the drawing 

area to make it “float” again.  

12. To resize the Modify toolbox, select and hold the lower right corner, and then drag to the right of the 

toolbox until desired size. 
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➢ Tool settings 

1. From the Main Classic task, click on the Place Line. The Place Line tool settings dialog displays.   

 

2. From the Main Classic task, click on the arrow on the right side of Place Line and select Place SmartLine 

from the popup menu.  The tool settings dialog changes to accommodate data entry specifically for placing 

a SmartLine. 

3. Click the down arrow in the lower right corner to open additional tool setting options. 

     

4. Press Esc key and reveal the Keyboard Input for the tool settings options. 

5. Click OK, then  to close dialog. 
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➢ PopSet 

1. (Optional) If the Primary Tools toolbox is not displayed, select the MicroStation menu option Tools, 

then check Primary.  The Primary Tools toolbox will display at the top. 

2. (Optional) If the Primary Tools toolbox is displayed, but the PopSet icon is not included, right click on 

the Primary Tools toolbox and check PopSet.  This will display the PopSet icon. 

 

3. Right click on the Enable/Disable PopSet icon and select Properties.  

 

4. Check ON the Auto-Position Tool Settings and click OK. 

 

5. Move the cursor over an active (highlighted) tool icon and notice the tool settings dialog displays next to 

the icon.  Move the cursor away and the Tool Settings disappears. 

6. Move the cursor over the Enable/Disable PopSet icon and notice the tool settings dialog displays under 

this icon.  Move the cursor away and the Tool Settings disappears. 

7. Right click on the Enable/Disable PopSet icon and select Properties.  Review the dialog for additional 

settings for PopSet and then click OK. 
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➢ Quick Select Dialogs 

1. Locate the Primary Tools toolbox and drag it to the middle of the screen.  

 

2. Notice that for many of the icons, there is a dropdown arrow beside it.  Select these to make dialog settings 

available without actually “floating” the dialog. 

Note Notice that most of the options are dockable dialogs. 

3. Right-click on the toolbox and select Show All and review each of the options available. 

4. Select the arrow beside the Level Display icon. 

 

5. From the Level Display, double-click the level named EOP to set as the Active Level. The EOP level 

highlights in the level listing, the elements flash within the view window and the Active Level option on 

the Attributes toolbox at the top of the MicroStation application window changes. 

6. From the Primary Tools toolbox, click the Level Display icon instead of the arrow.  Now the Level 
Display dialog opens as a floating dialog and can be accessed until it is no longer needed. 

Note Notice that there is a FDOT Standards Filter (DSGNRD) applied to the design file. This only displays valid 
levels within this specific design file.  
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7. To see all levels used within the file, select the down arrow on the List Filter and select NONE.  

          

 

 

8. Click the Close  icon to close dialog. 

9. Select and hold the Primary Tools title bar and drag to the top of the MicroStation application window 

to re-dock the toolbox. 
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Exercise 2.3  Dockable Dialogs 

1. Continue with dsgnrd01.dgn for this exercise. 

2. From the Main Classic task, select Copy from the 

Manipulate Classic toolbox. The Copy Element dialog 

displays. 

3. Select and drag the Copy Element Tool Settings by the title bar across each of the docking indicators 

displayed in the window.  Notice a transparent box ‘jumps’ to the position indicated by the arrow. 
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4. Release to the right side. The Copy Element dialog docks along the side of the view window. 

 

5. From the docked Copy Element dialog, select the Auto Hide (pushpin) icon to minimize the dialog. The 

Copy Element dialog reduces to a tab.  From the docked Task dialog, select the Auto Hide (pushpin) icon 

to minimize and reduce to a tab. 

        

                    

6. From the Primary Tools toolbox, click on Models and then click on References dialogs. Dock each dialog 

to the bottom of the view window. 

 



Chapter 2 ____________________________________________________ DESIGN ENVIRONMENT - MicroStation Drawing Tools 

2-38 © 2018 FDOT FDOT Bentley CADD Essentials  

7. On each Models and References dialog title bar, click the Auto Hide (pushpin)  icon to minimized 

to tabs. 

 

8. To open docked dialogs, make sure the focus is on the MicroStation application window and then hover 

cursor over any tab.  The dialog will automatically open for selection. 

9. To return dialog to a ‘floating’ state, open and toggle Auto Hide (pushpin)  icon, and then drag dialog 

from the title bar into the View window. 

10. Click the Close  icon to close each dialog 

11. Exit MicroStation. 
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3 VIEWING & ZOOMING 

OBJECTIVES 

This chapter covers all the viewing tools available in MicroStation including: 

• View Windows 

• View Preferences 

• View Groups 

• View Controls 

• Saved Views 

• Dynamic Views 

INTRODUCTION 

As a drawing becomes more and more complex, it may be useful to open multiple view windows.  MicroStation 

can have as many as eight drawing view windows open at one time.  Opening multiple view windows allows users 

to focus on details, as well as an overview of the design, without getting lost in between.  The view currently being 

worked in is known as the Active View and indicated by a highlighted title bar. 

VIEW WINDOWS 

A View window in MicroStation is commonly referred to as a “view”.  Each view functions independently without 

affecting other views. They contain their own attribute settings with independent zoom, pan and rotate capabilities. 

Each can be resized or relocated independently by “clicking and dragging” the cursor at any edge of the view or on 

the title bar.  View Windows can be arranged manually or by automated tools found under the MicroStation menu 

option Window, as shown below. 

   

Views Opens or closes each view window by checking or un-checking the <view number> respectively 

and opens or closes a floating or dockable View Groups dialog as described in the next section. 

Cascade Layers the views on top each of each other. 

Tile Tiles the views to the best fit. 
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Arrange Fits the open views together according to their current position on the screen. 

Scroll Bars Adds or Removes the scroll bars along the side and bottom of the view windows. 

Task 

Navigation 

in Views 

Toggle to provide the Task Navigation tool within each view window. 

View 

Toolbox 

Toggle to provide the View Control tool bar within each view window as described in a separate 

section below. 

Note View Options under the Preferences dialog consists of controls for settings to customize the 
MicroStation view window look/layout. To access the Preferences dialog, select  the MicroStation 
menu option Workspace > Preferences. 

VIEW PREFERENCES 

The workspace Preferences dialog contains controls for settings to customize MicroStation's view window 

look/layout. 

  

Show View ToolBox If on, sets the position of where to dock the tools in a view window. The default is top, but 

can be docked to the left, right or bottom as well. 

Scroll Bars on View Windows  If checked on, displays the view windows with borders, including scroll bars and 

view control bars. The default is off. 

Black Background -> White  If checked on, (if set to black) is displayed in white. The default is off.  

  



VIEWING & ZOOMING - View Groups __________________________________________________________________ Chapter 3  

FDOT Bentley CADD Essentials © 2018 FDOT 3-3 

VIEW GROUPS 

A View Group is a named collection of eight view windows which allows for the setup of the desktop to display 

preferences including number of open view windows, window size and view orientation. Each view group is 

associated with a model making it easy to access and navigate through different models in the active DGN file.  The 

View Groups dialog provides for this navigational capability and is accessed through the MicroStation menu 

option Window > Views > Dialog.   

 

  Previous Model  Accesses the previous model in the session history by clicking the left arrow. 

Alternatively, clicking the down arrow and selecting a previously accessed model from a drop-down list. 

  Next Model  Accesses the next model in the session history by clicking the right arrow.  

Alternatively, clicking the down arrow and selecting the next model from a drop-down list. 

  All Models Visited Clicking the down arrow displays a drop-down list of all models accessed, from 

which a model can be selected to open. 

View Groups  Drop-down list that displays the name of the view group as well as the model with which it is 

associated and allows for the selection of different view groups. 

 

 Manage View Groups  Creates, manages, edits and deletes view groups. MicroStation allows an 

unlimited number of view groups to be saved. When users create a model, they are prompted to create a view group 

associated with that model by populating the Create a View Group checkbox in the Create Model dialog. 

 

Create View Group Opens the Create View Group dialog to specify a name and description for the new 

view group. 

Edit View Group 

Properties 

Opens the View Group Properties dialog to edit the name and description of the selected 

view group. 
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Delete View Group Deletes the currently selected view group. 

List Box Displays a complete list of all view groups for all models in the design file. The active 

view group is highlighted in green. 

Apply Applies the selected view group to MicroStation, opens the views in that view group 

and activates the model associated with the view group. 

Close Closes the Manage View Groups dialog. 

 Toggles  Click the numbered buttons to open or close individual view windows (equivalent 

to choosing the numbered items in the Window menu's Views submenu.)  The numbered button grouping is also 

present in various other dialoges, such as the References and the Level Manager dialog (Settings > Level > 

Manager). 

VIEW CONTROLS 

MicroStation contains a complete set of viewing tools, including tools for zooming, rotating and panning views 

and fitting designs to a view window.  Using the View Control tools is one of the most common tasks in 

MicroStation. 

In the upper left corner of each view window is the View Control tool bar, which contains a row of tools used to 

perform a variety of viewing and zooming operations. Right clicking on the tool bar, offers the user a popup menu 

to customize the display of tools by checking or un-checking any tool. 
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VIEW CONTROL TOOLS 

 
View Attributes Opens the View Attributes dialog to adjust view attribute settings. 

 

View Display 

Mode 

Sets the view display mode from the list of display styles or from the 

Display Styles dialog. 

 

Adjust View 

Brightness 
Applies scene lighting to a view and adjust brightness of shaded views. 

 
Update View Refreshes (redraws) the current view to display elements correctly. 

 
Zoom In Increases the magnification of a design by a user specified Zoom Ratio. 

 
Zoom Out Decreases the magnification of a design by a user specified Zoom Ratio. 

 
Window Area Magnifies an area of the design by a user defined window.   

 
Fit View 

Display all displayable elements in the active design and attached 

references in a view. 

 
View Rotation Opens the View Rotation toolbox and rotates/un-rotates the view. 

 
Pan View 

Views a different part of the design without changing the view 

magnification. 

 
View Previous Undoes the last viewing operation. 

 
View Next Redoes the last undone viewing operation. 

 
Copy View Copies content from one view window to another. 

 

Apply or 

Modify   Clip 

Volume 

Opens the Clip Volume toolbox and applies a clip volume to a view. 

 
Clip Mask Applies a clip mask to a view. 

The View Control toolbox also provides tools for the 3D design, which are disabled when working in a 2D 

design. To access these 3D tools, select the MicroStation menu option Tools > View Control.  This toolbox 

may be docked anywhere in the screen layout. 
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VIEW ATTRIBUTES 

The View Attributes dialog contains a series of toggles that allow users to set view attributes that affect 

whether and how certain types and classes of elements are displayed and whether certain drawing aids are 

displayed.  

Each view can have its own view attributes settings and the view number at the top of the View Attributes 
dialog determines which view window the settings are applied to when the Apply to selected view button is 

selected. Selecting the Apply to open views button applies the current settings to all open view windows.  

View Attributes are saved with the design file settings.  To save changes to the View Attributes, select the 

menu option File > Save Settings.   

The View Attributes dialog can be invoked by one of the following methods: 

• Type the key combination [Ctrl] + [B]. 

• From the MicroStation menu, selecting Settings > View Attributes. 

• From the View Control toolbox, select the down arrow of the View Attribute  icon to 

display a temporary popup of the View Attributes <OR> click on the View Attribute icon to 

open a “floating” View Attributes dialog. 

 

  View Number Sets the view for which attribute settings are displayed. 

  Apply to Open Views If on, any settings changes are applied to all the open views. 
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  Apply to Selected Views If on, any settings changes are applied to selected open views. 

  

ACS Triad If on, a coordinate triad representing the Active Auxiliary Coordinate System (ACS) 

displays. The ACS is controlled using the Auxiliary Coordinates dialog, which is 

opened by choosing Auxiliary Coordinates from the Utilities menu.   

Background If on, the background displays. 

Boundary 

Display 

Controls whether the boundaries of the clip volume are displayed for a given view, as 

well as reference clip boundaries. 

Camera If on, the view camera is on for the view. Applies to 3D designs only. This control is 

disabled (dimmed) if the active DGN file is 2D.  

Clip Back Toggles the display of elements and parts of elements located outside a 3D view's 

clipping planes. If on, a back clipping plane is active in a view. 

Clip Front Enables toggling the display of elements and parts of elements located outside a 3D 

view's clipping planes.  If on, a front clipping plane is active in a view. 

Clip Volume Toggles the display of elements and parts of elements located outside a defined Clip 

Volume for a given view. If on, and a clip volume has been applied to the view, the 

view volume is restricted to the defined volume. If no clip volume has been applied to 

the view, it has no effect. 

Constructions If on, construction elements (those with the Class attribute of Construction) display. 

Constructions typically are turned off in a view before plotting or rendering. 

Dimensions If on, dimension elements display. Turning Dimensions off can decrease view update 

time. 

Data Fields If on, Enter data fields are displayed. 

Display set If on, display of elements is restricted to only those elements in the current display set. 

Fast Cells If on, cells display as outlines. Turning Fast Cells on decreases view update time. 

Fast Curves If on, curve elements display as line strings (with line segments connecting the 

vertices). If off, curves are smooth. 

Fill If on, solid, closed elements with Fill Type of None or Opaque and text characters in 

a filled font display with color fill. 

Grid If on, the grid displays. Its uniformly placed dots (grid points) and crosses (grid 

references) provide an indication of distances as a visual aid and a means of facilitating 

drawing precision with Grid Lock. 

  

Level 

Overrides 

If on, level symbology overrides — the override color, numbered line style, line 

weight, and material associated with each level — display in the view, instead of the 

color, numbered line style, and line weight of each element. 
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Line Styles If on, elements display with their custom line style, if they have one. If off, all elements 

with custom line styles display with the standard solid line style (0). Turning Line 

Styles off can decrease view update time. 

Line Weights If on, elements display with their line weight. If off, all elements display with a line 

weight of zero. Turning Line Weights off can decrease view update time. 

Patterns If on, pattern elements display. Turning Patterns off can decrease view update time. 

Pattern/Bump 

Maps 

If off, pattern and bump maps are not displayed for Phong or Smooth rendering. This 

can reduce rendering times.  

Tags If on, tags display in the selected view(s). 

Text  If on, text elements display. Since text elements take longer to display than most other 

elements, turning Text off can decrease view update time. 

Text Nodes If on, empty text nodes displayed as small crosses with numeric identifiers. However, 

in most cases displaying text nodes is unnecessary. 

Transparency If on, applies transparency to elements, references, and levels. 

 

Saved Views Allows the recall of a saved, predefined view definition to a destination view window 

and allows use of the selected attributes in the saved view. 

Models Displays the name of the model to which the settings are applied. 

 

  



VIEWING & ZOOMING - Saved Views __________________________________________________________________ Chapter 3  

FDOT Bentley CADD Essentials © 2018 FDOT 3-9 

SAVED VIEWS 

MicroStation allows users to save views for easy retrieval at a later time.  A saved view stores the area of the design 

shown in the view window, view window proportions and location, levels displayed, view attributes and reference 

settings.  The Saved Views dialog can be accessed by selecting Utilities > Saved Views from the MicroStation 

menu bar. 

 

 
Saved Views 

in Active 

Design File 

A dropdown list displaying the saved views in the active design file. 

Click the down arrow and select Active link Sets to see the available link 

sets in Project Explorer. 

 

Create 

Saved View 

Opens the Save View dialog, which is used to name and describe the 

view being saved.  

 

Update 

Saved View 

Settings 

Updates a saved view to include changes to the settings. For example, 

the levels or view attributes can be modified for the saved view, then use 

this icon to save the changes to the saved view. 

 

Apply Saved 

View 

The effect is the same as clicking the Apply Saved View toolbox. 

 

Edit Saved 

View 

Properties 

Opens the Edit Properties dialog, which is used to change the name and 

description of the saved view selected from the list box.  

 
Delete Saved 

View 

Deletes the selected saved views. 

 

Import 

Saved View 

Opens the Open File dialog used to select the file that has the saved views 

to import into the active file. Once a file has been selected, the Import 

Saved Views dialog opens to import saved views from another file. If no 

saved views are found to import, an error displays in the status bar. 

 

Update 

From 

Library 

Updates the saved view in the DGN file to reflect changes in the 

configured DGN library. 

 

List Filter If on, displays a filter row in the list box that allows for the defining of 

any column. 
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DYNAMIC VIEWS 

Dynamic Views is a general name that encompasses several related technologies which share a common goal of 

making model analysis and documentation more interactive and intuitive.  One of these technologies allows clipping 

of models and generating section graphics on the fly. Section views, detail views, and elevation views are types of 

dynamic views.  Dynamic views have the ability to create live, intelligent sections of design composition that 

updates automatically as the design evolves. More will be discussed in chapters to follow. 

Exercise 3.1  Working with Views 

➢ Zooming and Rotating 

1. Open the MicroStation file c:\e\projects\12345678901\roadway\dsgnrd01.dgn and select the Fit View 

 icon. 

2. From the MicroStation menu, select Workspace > Preferences and then select the View Options 

category. 

3. From the Show View toolbox dropdown option, select Bottom, and then click OK.  The View Controls 

will display at the bottom of the View window. 

4. From the View Controls located at the bottom of View 1, click the Zoom In icon. A transparent box will 

attach to the cursor and the Zoom In tool settings dialog displays. 

5. From the Zoom In tool settings dialog, set the Zoom Ratio to 5.0, and then zoom in to the last intersection 

in the bottom right side of the design by using the following methods. 

6. Center over the last intersection and click. Repeat until details are displayed as shown below, then right 

click to accept. 

7. Center over the last intersection and scroll with the scroll wheel of the mouse until details are displayed 

as shown below. 
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8. From the View Controls, click the Rotate View  icon.  The Rotate View tool settings dialog 

displays. 

 

9. From the Rotate View dialog, set the Method to 2 Points. The prompt ‘Rotate View > Define first point’ 

displays in the MicroStation Status Bar lower left hand corner. 

10. Define the first point by selecting the intersection of BL Survey 20th PL (W) and BL Survey SR 5.  

The prompt ‘Rotate View > Define X-axis of view’ displays in the MicroStation Status Bar. 

11. Define the X-axis of view (second point) by selecting the end of BL Survey SR 5. The image rotates to 

match the following.  The prompt ‘Display complete’ displays in the MicroStation Status Bar. 
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➢ Arranging Views 

1. From the View Controls, click the Fit View icon to fit the entire roadway section in the view window. 

2. Use the Window Area  icon to zoom the left most intersection as shown below. 

 

3. Use the Pan View  icon to pan the view over to the next intersection by picking a point at the left 

and then choosing a point at the right. 

4. From the View Groups toolbox docked at the bottom of the MicroStation application window, open a 

second view window by clicking on the number 2 button. 

5. From the MicroStation menu, select the option Window > Tile to arrange the Views. 

 

 View 1 should be at the left and View 2 should be at the right. 



VIEWING & ZOOMING - Dynamic Views ________________________________________________________________ Chapter 3  

FDOT Bentley CADD Essentials © 2018 FDOT 3-13 

6. From the View Controls in View 1, click Fit View. 

7. From the View Controls in View 1, click Window Area and change the tool setting Apply to Window to 

2. 

 

8. With the Window Area tool selected in View 1, window into the far left intersection.  The results will be 

reflected in View 2 instead of View 1.  Use Window Area several times on different features. 

 

9. From the View Groups toolbox, close View 2 by clicking on the number 2 button. 

10. Expand View 1 to fill the entire work area by double-clicking on the Title Bar. 
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➢ Create and Apply Saved Views 

1. From the View Controls, click the Window Area  icon to zoom in on the first intersection from the 

left.  This sets the source for the first Saved View. 

2. Open the Saved Views dialog by selecting one of the following: 

3. From the MicroStation menu, Utilities > Saved Views <OR> 

4. From any view window, click the  icon in the upper left hand corner of the view window 

  and then select View Save/Recall from the popup menu <OR> 

5. In the Primary Tools toolbox, click Saved View <OR> 

6. Select the default function key <F6> 

 

7. From the Saved Views dialog, select the Create Saved View  icon and set each setting as shown 

below. The Create Saved View dialog displays.  

o Accept Method as From View. 

o Accept View Type as Saved View. 

o Enter the Name as: First Intersection. 

o Leave Description blank. 

o Accept Clip Volume as From View. 

o Check On Associative Clip Volume 

o Leave check box unchecked for Create 

Dynamic View. 

8. Click onto the View 1 window to select the source view.  The Saved Views list box will update with the 

newly created listing. 



VIEWING & ZOOMING - Dynamic Views ________________________________________________________________ Chapter 3  

FDOT Bentley CADD Essentials © 2018 FDOT 3-15 

9. Fit View and repeat this process (steps 1-4) to store a saved view for the Second and Third Intersections 

as shown below. 

 

10. From the View Groups toolbox, open View 2 and View 3 by clicking the corresponding buttons, and 

then select the MicroStation menu option Window > Tile. 

11. From the Saved Views dialog, right-click on the First Intersection and select Apply from the popup 

menu. The Apply Saved View dialog displays. 

  

12. Enter a data point in View 1 to accept the First Intersection saved view. 

13. From the Apply Saved View dialog, change the Saved View option by selecting Second Intersection 

from the dropdown menu, and then enter data point in View 2. 

  

14. Repeat step 9 for the Third Intersection to View 3. 

15. From the View Groups toolbox, close View 2 and View 3 by clicking the numbers 2 and 3, and then 

maximize and fit View 1.   

16. Close the Save Views dialog. 



Chapter 3 ________________________________________________________________ VIEWING & ZOOMING - Dynamic Views 

3-16 © 2018 FDOT FDOT Bentley CADD Essentials  

➢ View Groups 

1. From the View Groups dialog, open an additional view such as View 2. 

  

2. First, arrange the views as shown below.  Then, using the zoom control to arrange the views similar to 

the illustration below with one view smaller showing more detail and the other view depicting with a 

larger view. 

 

3. From the View Groups toolbox, select the Manage View Group  icon to access the Manage View 
Groups dialog. 

  

4. From the Manage View Groups dialog, select the Create View Group  icon to create a new view 

group. 
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5. Enter the Name as Detail. 

6. Enter the Description as 8th Str and SR5 

7. Click OK. The Manage View Groups list box updates with the newly created View Group. 

8. From the Manage View Groups dialog, highlight Detail in the listing, enter a data point in the view 

created, and then click Apply to set the view with the newly created Detail View Group. 

 

 

9. Switch between View Groups by double-clicking on Default Views to fit the design and close View 2.  

Double-click on Detail and see how the view returns to the way it was saved. 

10. Close all dialogs and exit MicroStation. 
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4 MODELS 

OBJECTIVES 

This chapter focuses on the use of Models and incorporating them into the FDOT environment.  Topics include: 

• Model Properties 

• FDOT’s Use of Models 

• Models Dialog 

• Creating a Model 

INTRODUCTION 

MicroStation offers many enhancements designed to facilitate the production of engineering information. One of the 

most beneficial enhancements to MicroStation is the introduction of Models in the design file environment.  

A design file is composed of models.  When users draw or place elements with MicroStation tools, the elements are 

added to the active model. A model can be either 2D or 3D and is stored within the design file.  When a design file 

is created from a seed file, an empty container setup is provided with a default model ready to create a design.  If a 

2D seed file is used, then the default setup is 2D, while a 3D seed file defaults to a 3D setup.  

In 2D drafting, the MicroStation equivalent of a sheet of drafting paper is the design plane. Unlike a sheet of drafting 

paper, the design plane in a design file is extremely large and allows the user to draw models at full scale. To draw 

various elements in a model, the user enters data points. Each data point placed in the design plane has associated X 

(horizontal) and Y (vertical) positions or coordinates.  The design plane is simply a Cartesian coordinate system upon 

which a model resides. 

MODEL PROPERTIES 

Each model also contains it own unique set of working units which theoretically would allow metric and English 

coordinate systems within the same design file. Every model has its own set of eight views. The model whose views 

are displayed or available for display at a given time is the active model. 

There are three types of models: Design Model, Sheet Model and Drawing Model.  

Design Models are similar to DWG models (model space), which consists of design geometry and can be either 2D 

or 3D.  A Design Model can also be used as a reference or placed as a cell.  In MicroStation, an unlimited number 

of design models can be created in a design file. By default, the view windows of these models have black 

backgrounds. 

Sheet Models are similar to DWG drawing layouts (paper space) and are commonly used to compose finished and 

annotated printable drawings. MicroStation allows an unlimited number of sheet models to be created in a design 

file. By default, the view windows of these models have white backgrounds. 

Drawing Models are a subset of a 2D or 3D design model, used to apply annotations, dimensions, callouts, and other 

embellishments to a design. By default, the view windows of these models have gray backgrounds. 
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FDOT’S USE OF MODELS  

FDOT has implemented the use of models for combining dependent data into a single MicroStation design file on a 

specific limited basis.  FDOT has chosen to use the Design Model for model creation.  One example of the use of 

models in the FDOT Workspace is with FDOT cross section files.  The FDOT cross section seed file (fdotseedxs.dgn) 

is setup with four distinct models.  Once a cross section file is opened the models are readily available via the Models 

dialog. 

 

View Groups are predefined for each model within the cross section file.  These are created automatically in 

conjunction with the models and allow easy access to and switching between models. 

 

Another example of the use of models in the FDOT Workspace is for alignment stations and tic marks at different 

scales.  This allows the use of one set of level names for all scales, and users of these files to only reference the one 

model with the needed scale. 
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MODELS DIALOG 

When a design file is first created, it has a built-in Default design model described as Master Model ready to place 

elements.  MicroStation’s Models dialog allows users to create, edit, manage, and quickly switch between any model 

(including this Default model) in the design file.  

This dialog can be accessed from the MicroStation menu option File > Models <OR>  

from the Primary Tools toolbox, by clicking on the Models  icon.   

 

Note This dialog can be docked at the top or bottom of the applications window. 

The Models dialog contains several tools to allow the user to create, modify and manage models. These tools are 

outlined in the table below. 

 

 Models in 

Active 

Design 

Displays the models in the active design file.  Clicking the down arrow opens a 

popup menu for selecting an Active Link Tree to see available link sets. 

 

Create a 

New Model 

Opens the Create Model dialog, which is used to create a new Design or Sheet 

model in the open DGN file.  Design models generally contain design elements, 

while sheet models are used for plotting. 

 

Copy a 

Model 

Opens the Copy Model dialog, which is used to make a copy in the open DGN 

file of the existing model selected in the list. 

 

Edit Model 

Properties 

Opens the Model Properties dialog, for the model selected in the list box. This 

dialog is used to modify properties of models contained in the open DGN file.    

 

Delete 

Models 

Deletes the model selected in the list box.  The default model is present in every 

design file and cannot be deleted. 

 

Import 

Models 

Opens the Import Model From File dialog, which is similar to the Open dialog 

that allows selection of a DGN or DWG file from which to select the model to 

import. After clicking OK, the Select Models dialog opens allowing selection 

of the model to import into the open DGN file. 

 

Define 

Sheet 

Layout 

(Sheet Models only) Opens the Define Sheet Layout dialog, allowing to set 

the Display status, and define the Size, Origin, and Rotation sheet layout 

parameters 
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List Filter If on, displays a filter row in the list box that allows for defining a filter for any 

of the list columns.   

To define a filter, click on the required filter field and enter the filter parameters. 

For information on defining filters by string, integer or Boolean expressions, 

refer to the tables in Defining and Deleting Filters. 

 List Box Lists the models in the open DGN file. An icon displays next to the model name 

indicating whether the model is 2D or 3D. Double-clicking a model here makes 

it the active model 

The model name and description can be edited by triple-clicking on the selected 

model name in the list box. To copy, delete, or adjust properties of a model, it 

must first be selected here.  

The columns displayed in the list box can be customized by right-clicking in the 

title row of the list box and using the menu to select which options are displayed.  

CREATING A MODEL 

Working with Design Models, the user can create one or more discrete models within a design files and move between 

various models using the Models dialog.  Where a design file contains many models, filters can be set to display only 

particular models, but filters are not saved from one design session the next. 

The user can create Sheet Models to compose design drawings which typically consist of references of the design 

models. References can be from the open design file or from other design files on disk.  As with the Design Models, 

the user can switch between Sheet Models using the Models dialog. 

The Drawing Models are the intermediates between the 3D design model and a printable Sheet Model. It is an 

unbound white space that contains one or more views of the design model. The Drawing Model can be used for 

centralizing annotations that need to be shared across multiple sheets. When a Drawing Model is attached to a sheet, 

the drawing model’s annotation scale is used as the attachment’s default detail scale. 

FDOT only supports the use of 2D Design Models within their seed files delivered with the FDOT CADD Software. 

When creating new models within the FDOT Workspace, the user should set the model Type to 2D Design. 

 

When creating models in a design file, the user has an option to specify whether or not that model “Can be placed as 

a cell”.  If this option is turned on, the model can be referenced as a model <OR> placed as a cell within another 

model.  When referencing a model, the link to the original is maintained and any modifications to the original will 

reflect in the reference.  When a model is placed as a cell, the link to the original is removed. 
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Exercise 4.1   Models 

➢ Creating Models (Manually) 

1. Open the MicroStation file c:\e\projects\12345678901\roadway\algnrd01.dgn. 

2. From the Primary Tools toolbox located at the top of the applications window, click the Models   

icon to open the Models dialog. 

 

3. From the Models dialog, select the Create a New Model  icon to open the Create Model dialog. 

4. Complete the Create Model dialog as shown below.  Click OK. Notice in the Models dialog that the list 

window updates with the new model named algnrd40.  At the same time the model was created, 

MicroStation switched the design environment to the new model for work to begin. 

  



Chapter 4 __________________________________________________________________________ MODELS - Creating a Model 

4-6 © 2018 FDOT FDOT Bentley CADD Essentials  

5. Repeat step 4 to create the Model Name algnrd200 with the Description:  Alignment at 200 Scale.  Click 

OK. 

  

6. From the Models dialog, double-click the Default listing to switch back to the Default Model. 

7. From the View Groups toolbox located at the bottom of the applications window, notice there is a new 

corresponding view group with names corresponding with each model created. 

  

8. Close the Models dialog. 

 

➢ Creating Models (Automatically) 

FDOT supplies specific preset models within their seed files the use with Cross Section files. This exercise 

will show how these models are created automatically. 

1. From the FDOT Menu, select Actions > Create Files to open the Create Files dialog. 
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2. From the Create Files dialog, verify/set the following settings as shown below. 

3. Project set to \e\projects\12345678901. Use the Project Settings button, and then click Select Active 

Project. From the Select Active Project, select Browse to navigate to this project directory, click Select 

and then click OK twice to accept. 

 

o Workspace set to FDOTSS4. 

o Control File set to ROADWAY.CTL. 

o File Group set to Roadway Design Files (DGN). 

o File Type set to ROADWAY XSECTIONS, PATTERN LINE & SHAPES. 
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4. Click the Create button at the bottom of the Create Files dialog.  Click OK on the Creates File 

confirmation dialog. 

5. After the file is created, click the Open File button at the bottom of the Create File/Project dialog. 

MicroStation automatically closes the current design file and opens the newly created roadway cross 

section rdxsrd.dgn file. The Set/Update Plot Scale dialog displays.  

6. From the Set/Update Plot Scale dialog, set Scale to 10 and Units to English, and then click OK to 

accept settings and continue.  

 

7. Click OK to close the Create File/Project dialog. 

8. From the Primary Tools toolbox, select the Models  icon to open the Models dialog. 

 

9. Review the models created in the roadway cross section file. 

10. Exit MicroStation. 
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5 LEVELS 

OBJECTIVES 

This chapter focuses on leveling functionality in MicroStation, which is comprised of the following: 

• Setting the Active Level 

• Level Libraries 

o By-Level Names 

o By-Level Symbology 

o Level Filters 

• Level Manager  

• Level Display 

INTRODUCTION 

A MicroStation design is made with basic building blocks called elements that are placed on a design plane within 

each model.  Each element placed in a model is on a drawing Level. Levels are analogous to transparent overlays 

which can be combined in different ways to visualize different parts of a model.  When creating a MicroStation 

design, the user can use many Levels to organize drawing information intelligently.  Each Level can have its own 

color, style, and weight symbology along with a number of other attributes. 

MicroStation has a limit of 4 billion levels that can be created and used in a drawing.  Obviously, using such a high 

number of levels is impractical at best.  FDOT has adopted a By-Level system utilizing FDOT Standard Level 

Libraries that define discipline specific Levels and associated color, style, and weight symbology for the production 

of all FDOT projects. These FDOT Standard Level Libraries are locked and cannot be modified by the user. 

MicroStation provides for the management and display options for levels through Level Manager, Level Filters, 
and Level Display applications.  FDOT has utilized these options in the setup of their CADD Standards as discussed 

in the following sections. 

SETTING THE ACTIVE LEVEL  

While a MicroStation design file has many levels available to the user, only one level is open for modification at 

any given time.  This open level is referred to as the Active Level.  All elements are created on the Active Level.  It 

is important to change the Active Level to the desired level before placing elements.  The level an element resides 

on may be changed later, but the best practice is to create it on the desired level to start with. The Active Level is 

the same in all views. 
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The following are ways to set the Active Level: 

The easiest way to set the Active Level is to click the Active Level combo box on the Attributes toolbox, Click the 

Active Level combo box to display available levels.  Choose the desired level to be set as the Active Level.  

 

The FDOT Menu contains a Show Command List  icon that opens the Cadpilot UI TabList dialog. This dialog 

contains several tabs related to various disciplines with level lists relevant to each discipline.  By selecting the 

logical level from one of the lists, the active MicroStation level is automatically switched to that selection. 
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From the Level Display dialog, the user can also set the Active Level.  The user can click on the Level Display 

 icon on the Primary Tools toolbox to open the Level Display dialog. The Active Level is highlighted in the 

Level list and can be changed by double-clicking on any other level <OR> by right-clicking on the desired level 

and select Set Active from the popup menu. 

 

From the Level Manager dialog, the user can also set the Active Level.  The user can double-click the Active Level 

box in the MicroStation Status Bar to open Level Manager and then double-click on any level to set the Active 

Level. 

 

From the Key-in dialog, enter ACTIVE LEVEL <level – spec> <OR> enter LV=<level – spec> Where <level – 

spec> specifies the level. 
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LEVEL LIBRARIES  

A MicroStation Level Library refers to a component of a DGN Library that contains a level structure; that is, one 

or more level definitions.  New level libraries can be created; and new and existing level libraries can be attached, 

detached, imported, and exported using the Level Manager dialog. A level definition does not technically attach 

from the Level Library to a design file until it is used.  

As outlined in the CADD Production Criteria Handbook (CPCH), FDOT defines CADD level/symbology Standards 

using Design Libraries, Color Tables, Line Styles Resource files, Line Weights and Toolboxes.  FDOT has created 

standard FDOT DGN Libraries (DGNLibs) within MicroStation to store FDOT Standards for: cells, levels, level 

filters, line styles, multi-line styles, text styles, dimension styles, element templates, menu customizations, 

customized tools, tool boxes, and tasks.  Each FDOT DGNLib contains data that is shared throughout files and 

among users. 

When a design file is opened in the FDOT Workspace in MicroStation, the corresponding FDOT Standards Level 

Libraries are automatically attached with preset FDOT Standard Filters activated. Only the valid levels from the 

attached libraries associated with the specific active design file are displayed for use.  

The following is a listing of all standard FDOT Level DGNLibs: 

DGNLib DESCRIPTION 

fdot_common_levels.dgnlib FDOT Standard Common Levels 

fdot_v8_levels.dgnlib FDOT Standard Roadway Levels 

rwlevels.dgnlib FDOT Standard Right of Way Levels 

StrLevels.dgnlib FDOT Standard Structure Levels 

survey_levels.dgnlib FDOT Standard Survey Levels 

V7_levels.dgnlib FDOT Standard V7 Levels 

countymappinglevels.dgnlib FDOT Standard County Mapping Levels 

BYLEVEL NAMES 

Each FDOT Standard defined in a Design Library (DGNLib) is identified by a unique Level Name. When 

used from a DGNLib, it is copied into the active design file and is given the same name. This allows for 

comparison of the local resource to the FDOT DGNLib resource for compliancy to FDOT CADD Standards. 

BYLEVEL SYMBOLOGY 

The standard FDOT Level Libraries define the CADD Levels for each Discipline with the associated ByLevel 

Color, ByLevel Line Style, and ByLevel Line Weight symbology.   Designers are to use these standard FDOT 

Levels to assign each element within FDOT CADD design files.   

The FDOT Levels and symbology are grouped and translated into specific Rule Files which are associated 

to each valid Standard Filename of each Discipline for the purpose of performing the Quality Control check 

for FDOT Standard compliancy of design files. Complete specifications can be found in the CADD 

Production Criteria Handbook (CPCH). 

When using MicroStation to create a FDOT drawing, the color, line style and line weight attributes should 

be set to “ByLevel”.  This setting allows the level to control these active attributes.  This ensures that the 

levels comply with FDOT standards. FDOT levels are predefined and delivered in specific .dgnlib files.  

FDOT does not recommend overriding the ByLevel settings. To do so would result in non-standard design 

files that would not be acceptable in FDOT Project submittals. 
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LEVEL FILTERS 

MicroStation levels can be filtered at any time to make only specific levels within a Level Library available 

during the design process. FDOT utilizes the MicroStation level filters to combine level definitions within 

the FDOT Level Libraries into Filter groups.  

FDOT created a Filter group called Standards that match the FDOT Standard Rule Files.  Each Standard 

sub-filter is associated with an FDOT Standard filename. When a design file with an FDOT Standard 

filename is opened in MicroStation, only the FDOT Levels approved for use in that design file are displayed 

for selection.    

These filter groups are not locked down and can be turned off at any time.  The users also may create filters 

specific to their needs. 

The FDOT Standard filter groups can be accessed: 

• From the Attributes toolbox Active Level Filter icon. 

The user may hover the cursor over the icon to reveal 

the Active Filter. In this case, the Standards filter is 

DSGNRD:  

• Selecting the icon reveals the filter listing for selection, 

defaulting to the current Active Level Filter to the top of the 

display: 

 

 

 

 

 

 

 

 

 

 

 

Note If non-standard levels have been used within the active design file, the filters will omit these levels from 
display.  The filters must be turned off to reveal all levels used within the active design file. 

• From the Level Manager by selecting from the List Filter icon <OR> from the Models, Levels, and 

Filters list pane as discussed further in the next section. 

 

• From the Level Display by selecting from the List Filter icon. 
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LEVEL MANAGER 

MicroStation Level Manager is used to control level display and level symbology for the open DGN/DWG file and 

attached references.  By default, the Level Manager includes a list of models, levels, and filters on the left, and a 

detail section of levels on the right.  Multiple design files and/or reference attachments can be selected from the tree 

by holding the left mouse button down and dragging the cursor over the desired files. The levels for all the selected 

files display in the level list.  

As previously stated, FDOT has established and delivers Standard CADD Symbology Levels within a set of 

DGNLIBs.  FDOT’s workspace disables the Level Manager’s modification/creation functions of levels and does 

not allow users to create, delete, import or export levels to ensure consistency in products submitted for FDOT 

Projects.  Every level needed for creating FDOT drawings should already exist, including miscellaneous levels for 

“scratch” drawing.  If a new level is desired, a request must be submitted to be addressed through the CADD 

Technical Advisory Committee (TAC) of the appropriate discipline. 

The Level Manager is accessed by selecting the Level Manager icon ( ) from the Primary tool bar 

<OR> selecting the MicroStation menu option Settings > Level > Manager  

<OR> by clicking in the Active Level field of the MicroStation Status Bar. 
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The Level Manager functions go beyond level editing, but provide much information to the user: 

➢ Model, Levels, and Filters List  

In the pane to the left of the dialog, the Level Manager displays the Active Design File, Model with all the 

references; the All Levels attached and used within the open design file and all Filters available for use by 

the user. FDOT has developed many filters from the various level libraries to match the FDOT CADD 

Standards and delivers them with the FDOT CADD Software.  Upon opening of any FDOT Standard 

filename within the FDOT Workspace, an associated standard filter will be automatically applied, displaying 

only those levels valid for the active design file.  The filter function can be disabled and / or utilized by the 

user to further customize other filters to best aide in the design process.  

 

Note The bracketed names refer to the FDOT Standard Level Libraries from which the filters are taken. 
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➢ Levels List –  

As previously stated, FDOT associates each FDOT Standard Filename with a Standard Filter.  This listing 

displays the attributes and properties of individual levels allowed for the selected file or reference. The 

highlighted level indicates the Active Level.  Bolded items represent levels that have been used within the 

design file. The listing can be sorted by double-clicking any of the titles.  The columns in this listing can be 

customized by right-clicking on the title bar and checking or un-checking available options.  

 

Note To display all levels used, regardless of validity, the user must turn off all filters by selecting None from the 
dropdown. 

➢ Right-click popup  

Level Manager has a right-click option to allow the user to Set Active Level, Jump To Active Level, and view 

Properties. 
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SYMBOLOGY OVERRIDES 

Symbology Override is another control that can be assigned to a 

level, allowing the user to override the FDOT ByLevel symbology 

for that level.  Once the Override is set in the level, the user can 

select the Symbology dropdown and set to Overrides to display 

those levels with an override setting.  

Note Overrides are NOT recommended by FDOT. 

To set overrides in a level in the Level Manager, select the menu option Levels > Properties <OR> right-

click on any level and select Properties from the popup menu. The Properties dialog opens and the user can 

review and/or change the override symbology in the bottom of the Level Properties dialog.   

 

Multiple target files can be selected by the user to allow application of 

override symbology on specified levels existing in multiple files.  For 

example, suppose several files have a level called Border and elements 

on that level appear as a different color in each file.  The color symbology 

can be changed once so the color is changed in all of the selected files. 

Note From the View Attributes dialog, the Level Overrides must be activated 
for the override symbology to display. 
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LEVEL DISPLAY 

MicroStation gives the user a great advantage by allowing them the ability to control level display.  The Level 
Display dialog provides for this action to turn on and turn off levels in a model and to apply filters created in the 

Level Manager dialog.  

This dialog can be accessed through the MicroStation menu option:  Settings > Level > Display  

<OR> by selecting the hotkeys [Ctrl] + [E] 

<OR> From the Primary toolbox, the user can select the Level Display  icon to open a floating dialog.  Note 

the down arrow next to the icon allows the Level Display to open in popup mode and automatically close when the 

cursor is moved off of the dialog. 

    

•   Apply to Open Views – If on, level display settings adjustments will apply to open views. 

•   Apply to Selected Views – If on, level display settings adjustments will apply to the selected 

view. 

•   Level Display Setting (Optional) – Sets the level display for the dialog. Turning 

these options ON or OFF is the same as thawing or freezing levels, with one difference.  These settings 

determine whether any  cells or references placed on that level will or will not be displayed. 

✓ View Display – Changes in the level display affect the chosen view in the active model. 

✓ Global Display – Changes in the level display affect all views in all models in the open 

file. 

✓ Global Freeze – (DGN files only) Indicates whether the level is frozen. If frozen, elements 

on the level are not displayed and cannot be printed. 

•   Change Level – Opens the Change Level tool, used to display or lock a level. 
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•   Show Target Tree – Changes the display of the Target Tree, used to set the target mode for level 

display settings changes or sets the model as a target. 

•   List Filter – If the Show Level Name or Filters option menu is set to Level, this option 

will allow the user to set a Filter, named or defined on-the-fly, applied to level display. 

•    Show Level Name or Filters – Determines the contents of the List box. 

✓ Filters – Lists level filters defined in the open file (and in reference attachments, if they 

are selected in the target tree). 

✓ Levels – Lists the levels in the open file (and in reference attachments, if they are selected 

in the target tree). 

•   Dialog Properties – Pops up a Level Display dialog, used to set the properties of the Level 

Display dialog. 

• Target Tree – Used to select the target model for level display settings changes.  This tree control 

enables selection of the active model, another model in the open DGN file, or an attached reference in 

the open file or another file, as the target. 

Right-clicking on the active file or the reference files in the target tree area opens popup menus with 

the following options: 
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• Levels (List box) – Lists the Levels (or filters if Show Level Names or Filters is set to Filters) in the 

target model. This listing has the same display, sorting, and function capabilities as the Level Manager.  

Right-clicking on the title bar opens a popup menu to customize the list display columns with the 

following options: 

   

 

Right-clicking within the listing opens popup menu with the following function options: 
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WORKING WITH LEVELS 

CHANGE ATTRIBUTES CLASSIC 

One set of tools that works with levels is the Change Attributes toolbox.  The tools contained in this toolbox 

can be used to easily move elements from one level to another.  They can also be used to match the current 

attribute settings to an existing element. 

The Change Attributes toolbox is accessed by selecting the icon ( ) from the Main Task <OR> by 

drilling down the Task Navigation tool <OR> by checking on the toolbox through the MicroStation menu 

option Tools > Toolboxes.  

 

 

Change 

Element 

Attributes 

Used to change an element(s) level, color, line style, line weight, or 

class. This tool may also be used to match one element’s attribute to 

another’s. 

 

Change to 

Active Area 

Used to change the area attribute of a closed element(s) (shapes, ellipses, 

complex shapes, or B-spline curves) to the Active Area (Solid or Hole). 

 

Change 

Element Fill 

Type 

Used to change a closed element fill type attributes (shape, ellipse, 

complex shape, or B-spline curve) to the Active Fill Type. 

 

Modify Line 

Style Attributes 

Used to interactively modify the line style attributes of an element with 

a custom line style.  The tool setting Method determines the type of 

modification. 

 

Change Multi-

line 

Used to change a multi-line's attributes to the active multi-line 

definition. 

 

Match Element 

Attributes 

Used to change the active element attribute settings so they match the 

attributes of an existing element. 

 

SmartMatch Used to change all active element attribute settings, including those 

specific to particular element types, so they match the attributes of an 

existing element.  When a cell is matched, the active scale factors and 

Active Cell attributes are also matched. 
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CHANGE ELEMENT ATTRIBUTES  

From the Change Element Attributes tool setting dialog, the 

user can control what properties of an elements’ symbology 

are changed.  Of all of the tools in the Change Attributes 

toolbox, Change Element Attributes is the most commonly 

used. 

 

• Use Active 

Attributes 

If on, active attributes are affected when the user changes or matches attribute 

settings.  If off (default), the active attributes settings are not affected when the user 

changes or matches attribute settings. 

• Eyedropper 

icon (Match 

Element 

Attributes) 

Used to match the element attributes of the element selected, and then use these 

settings to change the attributes of the next element(s) selected. 

If Use Active Attributes is on when clicking the eyedropper, the active attributes 

will change to match the element selected. 

If Use Active Attributes is off when clicking the eyedropper, only the settings in the 

tool settings window change to match the element selected. The active attributes 

do not change. 

• Level If on, level is included when changing or matching settings. 

• Color If on, color is included when changing or matching settings. 

• Style If on, line style (and any active line style modifiers) is included when changing or 

matching settings. 

• Weight If on, line weight is included when changing or matching settings. 

• Transparency If on, element transparency is included when changing or matching settings. 

• Priority (2D only) If on, element priority, is included when changing or matching settings. 

• Class If on, element class is included when changing or matching settings. 

• Use Fence If on, the tool will modify the element(s) based on the fence and fence setting used.  

Note that this option is grayed out unless there is an active fence placed in the 

design file. 

• Make a Copy If on, the element(s) are copied and the attributes of copy(s) are changed, but the 

attributes of the original are not changed.  Turn this setting on in conjunction with 

the Level setting to copy an element from one level to another or from a reference 

to a master file level. 

• Change Entire 

Element 

If on, the attributes for the entire element are changed. 
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Exercise 5.1  Level Manager 

➢ Reviewing Level Manager 

1. Open the MicroStation file c:\e\projects\12345678901\roadway\dsgnrd01.dgn. 

2. From the Primary Tools toolbox, select the Level Manager  icon. 

 

 

3. The FDOT CADD Software delivery includes an FDOT Workspace with a preset  Level Library that is 

locked, disallowing the user from creating new levels.  Also included are preset MicroStation Level 

Filters that are automatically associated to all FDOT Standard Files. 

4. From Level Manager, move the cursor to hover over the Filter List  icon. Note the Standards 

filter, DSGNRD that has been automatically associated and displayed.  

 

5. Select the down arrow to open the popup listing and then and scroll to 

the top to select (none).  The Level list pane updates with all 

available levels from the Level Libraries attached to the design file.   

 

 

 

 

 

 

 

 

 

 

 

Note Not all levels are embedded into the design file, only the levels used  displayed in bold in the Level 
Manager. 



Chapter 5 _____________________________________________________________________________ LEVELS - Level Display 

5-16 © 2018 FDOT FDOT MicroStation Essentials  

6. From the Level List, click on the column titled Used to sort all the Levels used within the design file to 

the top of the list.  The title may have to be toggled twice as the list can be sort ascending or descending.  

Select other column title headers and note how each sort ascending or descending. 

 

7. Right-click the Level List and select Jump to Active Level from the popup menu.  The Level List moves 

to and highlights the current Active Level as displayed in the Attributes toolbar. 

  

 

  



LEVELS - Level Display _____________________________________________________________________________ Chapter 5 

FDOT Bentley CADD Essentials  © 2018 FDOT 5-17 

8. From Model, Levels, and Filters List pane to the left of the window, expand the Filter sections by 

clicking the  icons.  Note the listing of preset FDOT Filters and what [Level Library] they are drawn 

from. 

   

9. Expand the STANDARDS [fdot_v8_levels] parent filter by clicking the  icon. All the filters displayed 

match directly to the FDOT Standard Rules.  Select the DSGNRD to display the FDOT Standard Levels 

allowable for use in the current active design file, dsgnrd01.dgn. 

  

10.   Close the Level Manager. 
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Exercise 5.2  Setting the Active Level 

➢ Active Level 

1. Continuing with the dsgnrd01.dgn file, zoom into the Precious Pet Tax Collectors office located near 

Station 273+00. 

2. From the Attributes toolbar located at the top of the application window, set the Active Level to Fence. 

 

3. From the Task Dialog under the Drawing task, the Place Line tool.  The Place Line Tool Settings 

box displays.  For this exercise make no entries. 
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4. Draw two Fence lines at the front of the Tax Collectors office by placing Data Points at the start, corner 

and end locations as shown below.  Right click to reset and end process after each line. 

  

 

➢ Level Override 

1. Continuing in the same location, from the Attributes toolbar located at the top of the applications 

window, select the Level Manager  icon. 

2. From the Level Manager, scroll down the Level List box and highlight the Level Fence. 
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3. From the Level List, right-click and select Properties from the popup menu. The Level Properties 

dialog opens displaying all the attributes of the highlighted level.  Review each of the tabs.  

   

4. From the Level Properties dialog, under the Symbology: Overrides section change the Attributes by 

clicking the down arrows and then selecting as shown below. 
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Note  Settings overrides in this dialog would change all the attributes of all the elements listed under the Usage 
tab within the active design file and cause them to become Non-Standard (non-compliant) to the FDOT 
Standards. 

5. Clicking Apply saves the Override changes with the dialog remaining open.  Click OK and the changes 

save and the dialog disappears.   

6. Close the Level Manager. 
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7. Review the graphics and the affect the override symbology has. 

 

8. From the View Controls, select the View Attributes  icon. 

9. From the View Attributes dialog, toggle OFF (un-highlight) the option for Level Overrides and notice 

the affect on the symbology of the Fence Line within the drawing. 

 

10. Close the View Attributes dialog and exit MicroStation. 
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6 BASIC DRAWING TOOLS 

OBJECTIVES 

This chapter reviews the understanding of the basic drawing tools provided in MicroStation, including: 

• Placing Elements 

• Tool Settings 

• Basic Workflow 

• Linear Task 

• Polygons Task 

• Arcs Task 

• Ellipses Task 

• Undo and Redo  

INTRODUCTION 

MicroStation has dozens of drawing tools (or tools, for short). These tools are grouped for convenient selection in 

toolboxes and are referenced in tasks. Tools referenced in a single task are used to perform a particular task, 

functionally speaking. For example, the Drawing Composition task references tools used to compose drawings. Only 

one task is active at any given time. The tools in the active task are grouped in a special dialog — the Tasks dialog. 

Each open toolbox is either floating in its own window or docked to an edge of the application window. The 

arrangement of tools in a floating toolbox can be changed by resizing its window.  Tools are represented in toolboxes 

by icons. For simplicity, the term “tool” is used to refer both to a tool and its icon. 

Within MicroStation, one tool or another is selected, or active, at all times. The default selected tool is Element 

Selection, which is used to select elements for manipulation or modification. When a design file is opened in 

MicroStation, the Element Selection tool is automatically selected or active. 
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As tools are selected and used within a MicroStation session, the last tool selected by the user becomes the default 

tool.     

FDOT has developed and delivers within the FDOT Workspace within MicroStation, many discipline-specific Tools, 

Toolboxes, Tasks and Workflows to assist the user in designing and producing projects to meet FDOT CADD 

Standards.  These have been incorporated into the Tasks Dialog as shown below.    

  

PLACING ELEMENTS 

The objects drawn, or placed, in a model, lines, polygons, circles, text, etc., are called elements.  Each element has 

several attributes that define the element:  

• Level 

• Color 

• Line weight 

• Line style 

• Fill color (for closed elements) 

• Class 

• Transparency 

• Priority (2D only, for display) 

FDOT defines the CADD level/symbology Standards for Level, Color, Line Weight and Line Style and has 

incorporated these standards in the FDOT tools delivered within the FDOT Workspace.  The users need only to utilize 

these tools to create elements set to the required level/symbology to pass compliancy with the FDOT CADD 

Standards. 
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In MicroStation, the left mouse button is mapped to a logical button called the Data button, which sends a type of 

graphic input called a data point when pressed.  The right-hand mouse button is mapped to the Reset button, which 

is used for resetting and for accessing Reset pop-up menu and View Control pop-up menu.  The pressing of both right 

and left hand mouse buttons at the same time, called a button “chord”,  invokes the Tentative button, which is used 

to enter tentative snap points.  If a three button mouse is available, it can have the center button mapped as the tentative 

button. 

When selecting an element within a design file <OR> or when placing the cursor into the design plane of a design 

file to create or manipulate an element, an element is being positioned to a specific location.  These positioning 

locations are called data points.  A data point is a graphic input that, depending on the context: 

• Designates a point in a design (for element placement or selection, for example). 

• Designates the view in which it is entered (for fitting or updating, for example). 

• Accepts an operation (deleting an element, for example), rather than rejecting it. 

While dragging to enter data points is fast and easy, the preferred technique is clicking to enter each data point for 

more precise accuracy.   

TOOL SETTINGS 

MicroStation has several aids to help to use tools. Notice a floating dialog whose title and contents change each time 

a tool or view control is selected. This dialog is the Tool Settings window.  Almost every MicroStation tool has 

settings that affect how the tool works and can be controlled in this Tool Settings window. If closed, the window 

opens automatically when a tool with settings is selected.  The status bar along the bottom border of the application 

window displays prompts and messages about the selected tool. 

   

Rather than forcing the adjustment of a tool's settings each time the tool is selected, tool settings remain in effect until 

changing them. This makes the product more efficient to use, but also means the active tool's settings must be kept 

in mind or displayed on the screen. 

Ordinarily upon selecting a tool, the settings are adjusted before entering any data points. However, some tool settings 

are not applicable until data points are entered.   

For example, while using Place SmartLine, after entering three or more data points and then move the pointer near 

the location of the first data point, a check box labeled Closed Element will appear in the tool settings window, 

enabling to the placement of a polygon. 

Tip   If using the default function key menu, press <F10> to open the Tool Settings window. If already open, pressing 

<F10> sends the input focus to the Tool Settings window. 
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BASIC WORKFLOW 

MicroStation has a basic workflow as a simple foundation to follow and remember when using drawing tools: 

1. Set the Active Element Attributes.  The recommended practice is to set the active element attributes 

first, even though, these can be changed after placement. It is advisable to always be aware of the active 

element attribute settings when placing elements.   

2. FDOT CADD Standards are based on pre-determined By-Level settings.  For FDOT projects, the Level 

attribute need only to be set and the Color, Line Style and Line Weight will automatically set to the By-

Level settings.   

Note Although not recommended, these settings can be overridden, if necessary, but will require an approval from 
the appropriate authorities of the FDOT project. 

 

3. This step can be skipped if not placing an element or using a tool that does not rely on element attribute 

selection. 

4. Select the Tool.  All Tools and Toolboxes in which the tools reside are accessible through the 

MicroStation Tools menu or Task Dialog or the FDOT Menu.  Throughout the learning process, 

experiment with different tools and utilize the Undo and Redo functions as needed. 

5. Adjust the Tool Settings.  When selecting different tools, review each of the Tool Settings functions as 

the window changes. The MicroStation help document contains descriptions of all tool settings.  The 

specific help can be accessed by clicking in the tool setting window and then press <F1>. 

 

Tip   The default Tool Settings is Element Selection, if no other tool is selected.  Pressing <F10> sends the input focus 

to the Tool Settings window. The Tool Setting of the last selected tool will always display. 

6. Follow the Status Bar Prompts.  In the beginning, remember to follow the prompts in the MicroStation 

Status Bar located in the lower left corner of the application window.  These tell how to proceed from step 

to step. 
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LINEAR TASK 

Lines are the most basic element in any design file.  No matter what discipline is involved, linear elements play a 

large role in the basic geometry.  The Linear Elements toolbox contains many tools that place linear elements into 

a design file. 

  

 

Place SmartLine Used to place a line, line string, shape, arc, or circle or a combination 

thereof as a complex element. 

 

Place Line Used to place or construct a line. 

 

Place MultiLine Used to place a multi-line, which can be made of up to 16 independently 

defined lines. 

 

Points Task 

 

Used to place the Active Point. 

 

Create Curves Task 

 

Used to draw curves and extract iso-parametric lines from a solid or B-

spline surface. 

 

Place Stream Line 

String 

Used to place a stream line string; primarily for tracing images when 

digitizing. 

 

Place Point or 

Stream Curve 

Used to place a curve using the points or stream method. 

 

Construct Angle 

Bisector 

Used to construct a line that bisects an angle defined by three data points. 

 

Construct Minimum 

Distance Line 

Used to construct a line between two elements at their closest points. 

 

  

Construct Line at 

Active Angle 

Used to construct a line that intersects a line segment (line or segment of a 

line string or shape) at a defined Active Angle. 
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Exercise 6.1  Placing Linear Elements 

➢ Place Line 

1. Open the MicroStation File c:\e\projects\12345678901\roadway\dsgnrd01.dgn. 

2. Zoom into the location of Station 206+00 to 208+00 at the beginning of the project.  This is the location 

where a sidewalk will be placed along the left side of the roadway. 

3. Set the Active Element Attributes from the Attributes toolbox located at the top of the application 

window, change the Active Level to SidewalkFront. 

 

4. Select the Tool from the Task Dialog under the Main Classic task by finding the Drawing task and 

clicking the Place Line tool. The Place Line Tool Settings box displays. 

    

Note This is displayed in List Layout Mode.  There may be a different Layout Mode (Icon or Panel) which can 
easily be toggled using the icons right of the Main Classic title.  
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5. Adjust the Tool Settings from the Place Line Tool Settings box by selecting the Length checkbox and 

enter 200 as shown below. 

  

6. Follow the MicroStation Status Bar Prompts at the bottom left of the application window to place a 

line along the shoulder along the left side of the roadway between Stations 206+00 and 208+00.   

✓ Place Line > Identify start of line – place a data point to start the line at Station 206+00. 

✓ Place Line > Identify end of line –place another data point to end the line at Station 208+00. 

7. Right click on the mouse to reset and end process. 

8. Repeat steps 3 – 7 to set the Back of Sidewalk. From the Attributes toolbar, change the Active Level to 

SidewalkBack and place another line offset from the front of the side walk. 
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POLYGONS TASK 

While it is possible to create closed polygonal shapes using the Place Line or Place SmartLine tools, it is often 

easier to use the tools contained in the Polygons toolbox.  The Polygons toolbox contains tools that facilitate the 

creation of both regular and irregular polygons. 

 

 

Place Block Used to place a block (rectangular shape). 

 

Place Shape Used to place a polygonal shape by entering a series of data points to define the 

vertices. 

 

Place Orthogonal 

Shape 

Used to place a non-rectangular shape in which each segment is either 

perpendicular or parallel to all other segments. 

 

Place Regular 

Polygon 

Used to place a regular polygon (one with all sides and angles the same). 

Note Because polygons are closed objects, they can be created with a user-selected fill color.  For the fill color to 
be visible, the Fill checkbox must be populated in the View Attributes dialog. 

Tool settings for placing polygons vary depending on the type of shape being placed.  However, each type of polygon 

allows setting of the Area, Fill Type and Fill Color. 
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PLACING POLYGONS USING PLACE SMARTLINE 

The Place SmartLine tool in the Linear Elements toolbox affords more flexibility to place polygonal shapes 

than the Place Shape tool, particularly when used in conjunction with AccuDraw. 

The Place SmartLine tool is used to automatically place a complex chain or shape containing a dynamically 

specified collection of segments and vertices. This tool is designed to be used in conjunction with AccuDraw.  

The main benefits of using  

 

AccuDraw with Place SmartLine are: 

• The drawing plane origin automatically moves to the location of a newly defined vertex. 

• The drawing plane automatically rotates to align with a newly defined segment. This allows tangent and 

perpendicular segments to be easily defined. 

• When defining an arc segment, the drawing plane coordinate system automatically switches to Polar. 

Exercise 6.2  Place Orthogonal Shape 

1. Continuing in the same area from the last exercise, from the Attributes toolbar, change the Active Level to 

Building. 
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2. From Task Dialog under the Drawing task under the Polygons toolbar, click the Place Orthogonal 

Shape tool. 

   

3. Set the Place Orthogonal Shape Tool Settings as shown below. 

 

4. Following the Status Bar prompt to Enter shape vertex, place a Data point at one of the corner locations 

of the building as shown in the image below.  Continue placing data points until the building is complete. 

  

Note This tool draws all consecutive lines perpendicular and parallel beginning from the first line. When closing 
the shape simply snap to the beginning element and MicroStation adjusts the last line to keep the shape 
square. 

5. When finished, Exit MicroStation. 
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CIRCLES TASK 

While a straight line is one of the most common geometry types, lines alone are not enough to fully describe everyday 

geometric shapes.  Circles and Arcs create curved segments of geometry. Out of the 8 Circles tools only five are for 

geometry creation.  Even though there are only a few tools, many arcs can be created by manipulating the tool settings. 

 

 
Place Circle Used to place a circle. 

 
Place Ellipse Used to place an ellipse, precisely positioning the center and one end of the 

primary axis. 

 

Place Arc Used to place a circular arc. Arcs can be placed clockwise or counterclockwise. 

 

Place Half Ellipse Used to place an elliptical arc with a sweep angle of 180°. 

 

Place Quarter 

Ellipse 

Used to place an elliptical arc with a sweep angle of 90°. 

 

Modify Arc Radius Used to modify a circular arc's radius, sweep angle, and center.  The endpoints 

do not move. 

 
Modify Arc Angle Used to extend or shorten the length (sweep angle) of an arc. 

 

Modify Arc Axis Used to lengthen or shorten an axis of an arc. 

The Place Circle tool is one of the most common tools and has many important 

settings that can be changed in the Tool settings dialog.  These settings control 

the method to place the circle. 

 

 

 

 

 

The Place Arc tool settings provide ample control for how an arc is to be placed.  

As with linear elements, any, all or none of the options may be used.  
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UNDO AND REDO 

No matter how meticulous a user is, errors occur when creating a design.  MicroStation stores commands in an Undo 

buffer that goes back a single step or multiple steps when a mistake is made. Redo is the opposite of undo. 

There is no limit to the number of Undos that can be performed.  After making the selection to Undo a drawing 

operation, the operation previous to the negated operation can be undone. A series of previous operations can be 

undone by repeatedly choosing Undo. Undo function cannot be used for settings changes. 

More advanced undo functions can be accessed through the MicroStation menu option Edit: 

 

Undo Negates the last drawing operation. Identifies the last placed element in the menu option. 

Undo Other > All Opens an alert box that lets the user negate all of the drawing operations recorded in the 

Undo buffer. 

Undo Other > To 

Mark 

Negates drawing operations performed after a mark was set by choosing Set Mark from 

the Edit menu. 

Redo Negates the last Undo operation.  Identifies the last undone element in the menu option. 

Set Mark Sets a mark in the undo buffer back to which subsequent drawing operations can be 

undone. 

 Each undo operation is a single re-doable operation regardless of the number of negated drawing 
operations.  

Note Any Compression done on the design will delete the Undo/Redo buffers. 
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7 DRAWING WITH PRECISION 

OBJECTIVES 

This chapter reviews the effects of using locks, snaps, AccuSnap and AccuDraw to control precision drafting.  The 

topics include: 

• Locks 

• Snap Modes 

• AccuDraw 

• AccuDraw Shortcut Key-ins 

INTRODUCTION 

The tools discussed in this chapter are used in conjunction with drawing tools to create drawings with greater 

precision.  These tools control accurate placement of elements by locking or constraining various settings. 

LOCKS 

Locks are drawing assistance tools that can be used to help produce drawings more effectively.  They are settings 

that allow more control of the actions of various tools.  These locks, to different degrees, control how the 

MicroStation controls the cursor, data point accuracy or groups of elements. 

Note These locks should not be confused with the element lock function.  This function, accessed through Edit 
> Lock,  allows the user to lock selected elements. The attributes and locations of locked elements cannot 
be changed, preventing accidental element manipulation.  If an attempt is made to change a  locked 
element, MicroStation will alert the user. 

The Locks may be accessed from the MicroStation menu option Settings > Locks  

<OR> From the MicroStation Status Bar at the bottom of the applications window as shown below. 
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LOCKS DIALOG 

The Locks dialog is used to set each of the locks and the Fence Selection 

Mode.  It is accessed from the MicroStation menu option Settings > 

Locks > Full or Status Bar Locks popup menu option Full. Each Lock is 

enabled by toggling ON the adjacent checkbox and settings selected to 

effect the use of each lock. 

Each lock performs a different function by controlling or constraining 

some portion of MicroStation.  A description of each lock is shown below. 

 

 

 

 

 

 

 

 

 

ACS Plane

  

(3D only) When on, each data point is forced to lie on the Active ACS's xy plane (z=0). The 

Active ACS is set in the Auxiliary Coordinates dialog, which is opened by choosing Auxiliary 

Coordinates from the Utilities menu. 

Grid Lock* When on, each data point is forced to lie on the grid.  

Level Lock

  

When on, only elements on the Active Level can be selected; elements not on the Active Level 

cannot be manipulated. 

Annotation Scale 

Lock*  

When on, the annotation scale is applied to any text or dimensions that are placed in the model. 

The annotation scale is set through the Model Properties dialog. 

Graphic Group 

Lock  

When on, any manipulation performed on one member of a graphic group is automatically 

performed on all members.  If off, the member elements of a graphic group can be manipulated 

individually. 

Text Node Lock*

  

When on, newly placed text is attached to empty text nodes, and text cannot be placed if there 

aren't any empty text nodes. 

Fence Mode Sets how the fence contents are determined for element manipulations. Fence (Selection) Mode 

is also a tool setting for the fence placement tools in the Fence toolbox. 

Snap Section The Snap section contains controls that are used to determine how tentative points snap to 

elements. 

Axis Section The Axis section contains controls that are used to adjust Axis Lock and related settings. 

Unit Section The Unit section contains controls that are used to adjust Unit Lock and a related setting. 

Isometric Section

  

The Isometric section contains controls that determine how data points relate to the Isometric 

Plane. 

* These locks are not used by FDOT.  
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LOCKS TOOLBOX 

The Locks toolbox is available to allow the user to turn locks on and off.  Clicking the tool has the same 

effect as selecting the check boxes in the Locks dialog.  It can be accessed from the MicroStation menu 

option Settings > Locks > Toggles or Status Bar Locks popup menu option Toggles.  This may be beneficial 

when constantly switching back and forth between multiple lock settings.  

  

SNAP MODES 

When Snap Lock is on, how a tentative point snaps to an element is set by the active Snap Mode (or the override 

setting if one is active).  The default Snap Mode can be set via the Locks dialog, Snap Mode button bar, pointer's 

pop-up menu or Status Bar.  The active Snap Mode (or Snap Mode override) is indicated by the icon in the Status 

Bar. The Snap Mode can be access from the MicroStation menu option Settings > Snaps or Status Bar Snaps popup 

menu.  

                         

To override the snap mode, select the Active Snap Mode icon on the Status Bar and then click a snap mode in the 

pop-up menu. This temporarily overrides the default snap mode for one operation, after which the override is 

canceled and the original snap mode becomes active again.  A solid dot indicates an override. 
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SNAP MODE BUTTON BAR 

With Snap Lock on, each snap mode setting has an effect on tentative snap points.   Using the Snap Mode 

button bar, a single click on a button overrides the current snap mode for one operation.  There is one button 

for each type of snap and a button  to turn AccuSnap on and off.  Only the buttons that are appropriate 

for the Active Tool will be enabled for use at any given time. All others that are contextually inappropriate 

are disabled (dimmed) 

The Snap Mode button bar is accessed by selecting Button Bar: from the Active Snap Mode icon on the 

Status Bar <OR> from the MicroStation menu option Settings > Snaps > Button Bar  

<OR> from the FDOT Menu option Actions > Snap Mode Button Bar. 

 

➢ Snap Modes 

 

Near Point Snaps to the closest points on elements. 

 

Keypoint Snaps to the pre-defined keypoints on elements (endpoint, midpoint and radius).   

 

Midpoint  Snaps to the midpoints of elements and segments of elements. 

 

Center Snaps to the center of elements (such as circles, arcs, text, etc.) with centers and the 

centroid of other elements, including shapes, line strings, and B-splines. 

 

Origin Snaps to the origin of a cell or text, centroid of a B-spline, the first data point in a 

dimension element, or the first vertex of a line, multi-line, line string, or shape. 

 

Bisector  Snaps to the midpoints of entire element. 

 

Intersect Snaps to the intersection of two elements. Two tentative points are required, although 

more can be used. The first tentative point snaps to one element, and that element is 

highlighted. The second tentative point snaps to another element, and the two segments 

used to find the intersection of the two elements are displayed in dashed lines. If the 

two elements do not actually intersect, but projections of the elements would intersect, 

the segments include projections of the elements to the intersection. Continue snapping 

until the desired intersection is found; the last two tentative points define where the 

intersection snap lies. 

 

Tangent The edge of the element being placed is constrained to be tangent to an existing 

element. The tentative point dynamically slides along the element to maintain the 

tangency as the pointer moves to finish placing the element. 

 

Tangent 

Point 

The edge of the element being placing is constrained to be tangent to the existing 

element at the tentative point.  The tentative point does not move dynamically as the 

pointer moves, but is locked in place. 

 

Perpendicul

ar 

The line being placed is constrained to be perpendicular to the element. The tentative 

point slides dynamically along the element in order to maintain the perpendicularity as 

the pointer moves to finish placing the element. 
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Perpendicul

ar Point 

The line being placed is constrained to be perpendicular to the element at the tentative 

point. The tentative point does not move dynamically as the pointer moves, but is 

locked in place. 

 

Parallel Does not define a point through which the line being placed passes. Instead, when the 

tentative point is accepted, the line placed is parallel to the line to which the tentative 

point was snapped. 

 

Through 

Point 

Defines a point through which the element being placed must pass. 

 

Point On Constrains an element to begin or end on an element in the design file. 

 

Multi-

snap1 

By default is Intersection, Keypoint, Nearest. 

 

Multi-

snap2 

By default is Intersection, Keypoint, and Center. 

 

Multi-

snap3 

By default is Midpoint, Intersection, and Center. 

Tip   If elements are overlapped, select the desired element with Element Selection tool and then select Edit > Bring 

to Front from the Menu Bar.  This brings the element to the top and makes it easier to snap to. 

MULTI-SNAPS DIALOG 

The Multi-Snaps dialog is used to set up groups of snaps known as multi-snaps. 

When multi-snaps is active, AccuSnap and Tentative Point snap processes the list 

of snaps that it represents. The order in which the snaps are processed can be 

changed by dragging and dropping the list entries. 

The Multi-Snap dialog is accessed by: 

selecting Multi-Snaps from the Active Snap Mode icon on the Status Bar 

<OR> from the MicroStation menu option Settings > Snaps > Multi-Snaps 

<OR> from FDOT Menu option Actions > Multi-Snap Dialog. 

The icon bar is used to set the multi-snap mode to define. 

• Multi-snap 1 — By default: Intersection, Keypoint, Nearest. 

• Multi-snap 2 — By default: Intersection, Keypoint, Center. 

• Multi-snap 3 — By default: Midpoint, Intersection, Center. 
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ACCUSNAP 

AccuSnap enhances many of the standard snap mode settings by displaying and automatically snapping to 

the next tentative snap point as the pointer is moved over an element. With AccuSnap enabled, a tentative 

snap point is very rarely needed to be placed manually. 

Note Tentative snap points can still be entered manually with AccuSnap enabled. 

AccuSnap can be toggled on or off by clicking the toggle AccuSnap button  on the Snap Mode button 

bar located at the far left. 

 

AccuSnap works in conjunction with the current Snap Mode setting and, for the most part, is similar in 

operation to the manual method of tentative snap points — minus the button presses. How close to an element, 

or a keypoint, the pointer must be before AccuSnap finds it is governed by the Locate Tolerance setting in 

the Input category of the Preferences dialog. 

The AccuSnap Settings dialog contains a series of controls that affect the behavior of AccuSnap.  Controls 

in this dialog are grouped into three tabbed sections; General, Elements, and Feel. To access the AccuSnap 
Settings dialog, select the MicroStation menu option Settings > Snaps > AccuSnap or click on the 

AccuSnap option from the Active Snap Mode pop-up menu on the Status Bar.  

      

• AccuSnap Settings General Tab 

The General tab contains controls to enable/disable AccuSnap, and to define the way it operates. 

• AccuSnap Settings Elements Tab 

This group controls whether or not AccuSnap snaps to Curves, Dimensions, Text, and/or Meshes. When 

snapping is turned off for any of these, AccuSnap will not snap to the particular element type, but it will 

display an icon to show that the element is being ignored.  

• AccuSnap Settings Feel Tab 

Using the controls in the Feel group of the AccuSnap settings allows for setting AccuSnap sensitivity when 

snapping to elements. 
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ACCUDRAW 

AccuDraw is a drafting aid that evaluates such parameters as the current pointer location, the previously entered 

data point, the last coordinate directive, the current tool's needs, and any directive entered via shortcut key-ins or 

AccuDraw options. AccuDraw then generates the appropriate precision coordinates and applies them to the active 

tool. 

Because of its versatility, the AccuDraw function reduces the need to rely on other drawing assistance tools such 

as grids or locks.  Nearly all drawing and editing techniques can be performed faster using AccuDraw than any 

other drawing aid.  

AccuDraw has two main areas; the AccuDraw Window and the AccuDraw Compass.  The AccuDraw Compass 

gives visual feedback as elements are added or modified. The AccuDraw Window is used to enter precision key-

ins. 

By default, AccuDraw is activated automatically when MicroStation is started.  With AccuDraw activated, all 

drawing tools utilize it for dynamic data input. 

ACCUDRAW WINDOW 

The AccuDraw window opens or closes when clicking the AccuDraw icon on the Primary Tools toolbox. 

If using the default function key menu, pressing <F11> opens the AccuDraw window. If it is already docked 

or open, pressing <F11> sends focus to the AccuDraw window. 

Once opened, the AccuDraw window automatically takes the focus whenever dynamic update occurs with 

a drawing tool selected. The AccuDraw window is dockable. 

 

                    

Rectangular coordinate system 

 

                    

Polar coordinate system 

 

The fields in the AccuDraw window depend on the type of drawing plane coordinate system is in effect.  

Rectangulate coordinates specify distances along the drawing plane axes X, Y, and (Z in 3D).  Polar 

coordinates specify distances and angles relative to the drawing plane origin and Z value in 3D. 
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ACCUDRAW COMPASS 

The most recognizable AccuDraw feature is its compass. Visible only when AccuDraw is active and in 

control of MicroStation coordinate input, the compass acts as both a status indicator and a focus for input.  

Normally, the AccuDraw compass does not appear until the first data point is placed after selecting a tool. 

AccuDraw behavior changes slightly with tools that utilize dynamics before the first data point. The Place 

Text and Place Active Cell tools are examples of such tools. Instead of “waiting” for the first data point to 

display the compass, AccuDraw activates the compass at the last data point location. In this way, the element 

can be placed with respect to this location by using any of AccuDraw relative directives. 

The shape of the compass indicates the type of drawing plane coordinate system is in effect.  Rectangular 

coordinate compass displays with a square shape.  Polar coordinate compass displays with a circle shape. 

When AccuDraw has focus, its compass has a transparent blue background. When it does not have focus, 

the compass displays grey. 

To shift from Rectangular to Polar coordinates, first check that the focus is in the AccuDraw window, then 

press the <spacebar>, which has a toggle effect between the coordinates. Rectangular or Polar coordinates 

also can be set from the AccuDraw settings dialog.   

          

Rectangular coordinate system.            Polar coordinate system 

THE ORIGIN POINT 

At the center of the compass is the AccuDraw origin point.  This is the focal point of all AccuDraw operations.  

As various AccuDraw options are selected, their functions operate from this origin point. 

This last point is important.  All AccuDraw commands (distance key-ins, shortcut key-ins, and so on) operate 

in conjunction with the compass.  In most cases, the compass is located at the last entered data point.  In 

addition, there are AccuDraw directives that move the compass to entirely different locations without 

generating a new data point.  

THE FRAME (DRAWING PLANE INDICATOR)  

Surrounding the origin point is the frame, or drawing plane indicator. Its primary purpose is to show the 

current orientation of AccuDraw' drawing plane and the current coordinate system in effect. When the frame 

displays as a rectangle, the rectangular coordinate system (X, Y) is in effect. When the frame displays as a 

circle then the polar coordinate system (Distance, Angle) is active. By default, when AccuDraw has focus, 

the frame's color is grey, and its fill color is blue, but this can be changed in the Display tab of the AccuDraw 
Settings dialog. 

THE X/Y AXES 

The final parts of the AccuDraw compass are the two axes. Oriented at right angles to one another, these 

axes represent the drawing plane X and Y axes. 

To differentiate between the two axes, each is color coded. By default, the positive or +X axis is displayed 

in red while the positive or +Y axis is green in color. If these colors not acceptable or are hard to discern, 

they can be changed via the Display tab section of the AccuDraw Settings dialog. As well, the highlight 

color can be changed for when the pointer is indexed to the X or Y axes.  

➢ To Index the Compass Axes  

• Move the pointer near one of the four axis indicators. 

• Once the pointer is close enough, it snaps to the axis and highlights. 
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➢ Notes: 

• The AccuDraw compass rotates itself automatically when the pointer is moved to an angle.  To 

return the compass to base rotation, type [B] on the keyboard. 

• AccuDraw remembers the last distance entered and accepted. When the pointer is near the 

previous distance, a small perpendicular segment displays at the end of the line.  Data point to 

accept the previous distance. 

• AccuDraw works with all drawing and modifying tools. 

• The easiest way to use AccuDraw is to move the pointer in the desired direction, type the desired 

distance, and then data point. 

• Pressing the [Spacebar] changes the AccuDraw compass from rectangular coordinates to polar 

coordinates. 

• Coordinates entered into the AccuDraw window are relative to the current origin point. 

USING ACCUDRAW 

Most of the time, a combination of mouse movements and keyboard entry is required to place elements with 

AccuDraw.  It is not necessary to delete existing information in the AccuDraw window to input new 

information.  To move from one input field to another, press the [Tab] key <OR> the up/down arrow key. 

ACCUDRAW AND THE TENTATIVE POINT 

Creating precision offsets is a fundamental function of the design process. AccuDraw performs this 

important function by utilizing tentative points. These can be input manually, or the process can be further 

streamlined using AccuSnap.   

Whether using AccuSnap or manually entered tentative points, the key to using AccuDraw and the tentative 

point is the Set Origin function (the <O> shortcut key-in). When there is a tentative point present, pressing 

the <O> key results in the relocation of the compass to the tentative point location. 

AccuDraw enters a dynamic tentative point mode where the final data point location can be manipulated as 

follows:   

• Enter coordinate data using the AccuDraw window. 

• Use a second tentative point and various locks (X/Y or D/A) to interactively set the offset. 

➢ To Create an offset from an element, along the x or y axis: 

1. With a tool active, use AccuSnap to display a tentative point at the required point on the element (or 

place it manually). 

2. Press the <O> shortcut key.  The compass moves to the tentative point location. 

3. Move the pointer so that it is indexed on the required X or Y axis.  This sets the focus automatically to 

the indexed axis. 

4. Key in the required distance. 

5. With the pointer still indexed to the axis, accept with a data point. 
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➢ Locking the X or Y values 

Another method of aligning with existing elements is to snap to the desired location and lock the axis.  The 

[X] and [Y] shortcuts lock the X and Y axes respectively, and [D] and [A] lock the distance and angle. 

1. With a tool active, use AccuSnap to display a tentative point at the keypoint of the first element (or place 

it manually). 

2. Press the <O> shortcut key.  The compass moves to the tentative point location. 

3. On the keypoint of the second element, use AccuSnap to display a tentative point (or place it manually). 

4. Press the <X> or <Y> key.  AccuDraw responds by locking the dynamic line to the appropriate X or Y 

axis, but at the offset from the first tentative point to the second one. 

5. Use another tentative point to “lock” the remaining axis of the tentative compass location.  <or>  Enter 

a data point to set the second axis value.  AccuDraw relocates the initial compass to the new indirectly 

derived location. From here the use of the current drawing tool can continue. 

➢ Using the Smart Lock 

Another method is to toggle on the Smart Lock tool.  It is activated by pressing the [Enter] key on the 

keyboard.  Smart Lock locks the axis that currently has AccuDraw focus. 

ACCUDRAW  POPUP CALCULATOR 

It is often useful to enter not only a distance, but the total length of many distances, or perhaps a distance 

minus a certain amount.  AccuDraw has a built-in calculator to handle many of these circumstances. 

The AccuDraw Pop-up Calculator performs standard mathematical operations, such as addition, subtraction, 

multiplication and division, on the values displayed in some MicroStation text fields and the values adjust 

accordingly.  Its use is extendable to support other controls, such as, Active Scale and Active Angle fields. 

➢ To use the Pop-up calculator 

1. With the input focus in a field that supports pop-up calculation, type any of the following:    

+  Addition Operator 

-  Subtraction Operator 

*  Multiplication Operator 

/ Division Operator 

2. Type a value or [Enter] Accepts Calculation expression to complete the calculation.   

3. Press <Enter>, enter a data point, or click outside the pop-up calculator to accept the calculated value.  

4. Press <Esc> if rejecting the value. 
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ACCUDRAW SETTINGS 

AccuDraw is a powerful drawing construction tool, and it has many associated control settings that are used 

to select preferences for operation and alter aspects of the way AccuDraw performs. Most of these settings 

are contained in the AccuDraw Settings dialog under three tabs to group the settings in an intelligent way.  

The AccuDraw Settings dialog can be accessed through the MicroStation menu options Settings > 

AccuDraw. 

OPERATION TAB 

 

Auto Load If on (the default), AccuDraw starts automatically when MicroStation is 

launched. 

Floating Origin If on (the default), the origin moves to the last point placed. 

Context  Sensitivity If on (the default), enables tools to provide “hints” to AccuDraw to override 

its default behavior for smoother operation.  This may include setting custom 

“Context” rotations, the origin, the coordinate system type and locking values. 

Smart Key-ins If on (the default), AccuDraw interprets a number as positive or negative, 

depending on the direction of the pointer from the compass.  In rectangular 

mode only, the Smart Key-ins will cause AccuDraw to move the focus to either 

the x or the y field depending on pointer position. 

Auto Point 

Placement 

If on, places data points automatically when they are fully constrained (if both 

the X and Y values are locked, or if one or the other is locked while the pointer 

is indexed to zero).  By default, this option is off.  

Sticky Z Lock If on, when the Z axis is locked, it remains locked through consecutive 

operations.  Normally, locks are cleared when the user enters a data point.  

Always Show 

Compass 

If on, when AccuDraw is active, the compass displays prior to placing a data 

point for the current operation. 

Auto Focus Fields (Polar coordinates only) If on, the <A> and <D> AccuDraw shortcuts set focus 

to the selected field and lock the current value.  If off, the <A> and <D> 

AccuDraw shortcuts lock the current value without affecting the focus. 

Default Origin Lets the user choose the default origin. When a tool starts AccuDraw and there 

is no origin currently defined, then this setting specifies the default location of 

the AccuDraw drawing plane origin. 
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DISPLAY TAB 

 

X Axis Changes, via an option menu, the color for the positive X axis indicator on 

the AccuDraw compass. 

Y Axis Changes, via an option menu, the color for the positive Y axis indicator on 

the AccuDraw compass. 

Hilite Changes, via an option menu, the color for the negative X and Y axis 

indicators on the AccuDraw compass. 

Frame Changes, via an option menu, the color for the AccuDraw compass frame. 

Fill Sets the fill color of the inside of the AccuDraw compass. 

Dialog Size Sets the width of the AccuDraw window. 

Small — 100 pixels 

Medium — 126 pixels 

Large — 152 pixels 

Delayed Update If on, X/Y coordinates are updated in the AccuDraw window when the 

cursor comes to a rest.  If off (the default), coordinates are updated in the 

AccuDraw window continuously, as the cursor is moved. 

Display Coordinates If on, a coordinate display at the pointer shows the increments in the x, y, 

and z (for 3D) directions from the previous data point. 

Show Negative 

Angles 

If on (the default), AccuDraw displays negative angles (that is, +/-180°).  

If off, AccuDraw displays angles as 0° to 360°. 

Pop-up 

Confirmations 

If on (the default), AccuDraw displays shortcut pop-ups. 

Shortcut Key-ins Opens the AccuDraw Shortcuts menu that lists the AccuDraw shortcut 

keys. 
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COORDINATES TAB 

 

Coordinate 

System 

Contains controls used to rotate an AccuDraw drawing plane and set an AccuDraw 

Coordinate System. 

Rotation Sets the rotation of the drawing plane axes, via an option menu. While the AccuDraw 

window has the focus, pressing the key combination indicated by the underlined letters 

has the same effect as choosing the specified Rotation,  i.e. Entering RV = Rotation: View. 

Type Sets the method used in the AccuDraw window to specify distances and angles relative to 

the drawing plane origin. 

Unit 

Roundoff 

Contains controls used to set the round-off value for distances and angles relative to the 

drawing plane origin. 

Distance Sets the round-off value for distances relative to the drawing plane origin. While the 

accompanying check box is on, the round-off value is effective, except if overridden by 

keyed in values or snapped tentative points. The check box turns on automatically when 

the Distance setting is entered. 

Angle Sets the round-off value, in degrees, for angles relative to the drawing plane origin when 

in Polar mode. While the accompanying check box is on, the round-off value is effective 

except if overridden by keyed in values or snapped tentative points. The check box turns 

on automatically when the Angle setting is entered. 

Indexing Contains controls that control AccuDraw indexing functionality. 

Axis If on, indexing is activated for AccuDraw drawing plane X and Y axes.  The distance 

required to move the pointer from the indexed axis is controlled by the Tolerance setting. 

Distance  If on, sets the minimum distance that the pointer must move from the AccuDraw origin 

in order to place a new data point. The minimum distance is controlled by the Tolerance 

setting. 

Tolerance  Sets the minimum distance, in screen pixels, used by the Axis and Distance settings.  

Allowable values are 1–99. 
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ACCUDRAW SHORTCUT KEY-INS 

AccuDraw affects the operation of most MicroStation tools, and even has the potential to work with third-party 

application software.  Although AccuDraw tries to anticipate the next move it cannot always predict intentions. 

AccuDraw therefore includes a wide variety of single and double character command directives known as the 

shortcut key-ins.  

By pressing the appropriate key, AccuDraw can be directed to perform a specific task. In operation, AccuDraw 

is the default input focus in most cases, thus allowing only the shortcut to be typed without having to consider where 

the input focus is. 

Pop-ups confirm single letter shortcuts below the focused input field. This function is not only useful to confirm the 

key-in, but also serves to communicate that the shortcut is received via AccuDraw input fields. 

 

Two letter shortcuts appear attached to the focused input field, and confirm the action through the temporary 

appearance of the AccuDraw Shortcuts window. The pop-down list adjacent to the input field illustrates where the 

shortcut comes from, thereby making it easy to “follow the action.” 

 

The following table lists each keyboard shortcut and its effect. 

Key Effect 

<Enter> Smart Lock 

• In Rectangular coordinates, locks the X field to 0 if the pointer is on the drawing plane y-axis 

or the Y field to 0 if the pointer is on the x-axis. 

• In Polar coordinates, locks Angle to 0°, 90°, -90°, or 180° if the pointer is on a drawing plane 

axis; otherwise, locks Distance to its last entered value. 

<Space Bar> Toggles between Rectangular and Polar coordinates. 

<?> Opens the AccuDraw Shortcuts window. 

<~> Bumps an item in the Tool Settings dialog (there is no need to press the [Shift] key).  It finds the 

first enabled toggle button or an option button in the Tool settings dialog and either toggles it or 

bumps it to the next valid value. 

<O> Moves the drawing plane origin to the current pointer position. This can also be used to explicitly 

activate AccuDraw before entering a data point. 

<V> Rotates the drawing plane to align with the view axes. Pressing this key a second time restores 

context-sensitive rotation. 
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<T> Rotates the drawing plane to align with the axes in a standard Top view (3D only).  Pressing this 

key a second time restores context-sensitive rotation. 

<F> Rotates the drawing plane to align with the axes in a standard Front view (3D only).  Pressing this 

key a second time restores context-sensitive rotation. 

<S> Rotates the drawing plane to align with the axes in a standard Side view (3D only).  Pressing this 

key a second time restores context-sensitive rotation. 

 

<B> Rotates the drawing plane to align with the active ACS, or if a rotation is set up in the dialog, it 

returns to that rotation.  In a new file (where ACS hasn't been used yet) it is the rotation of the view. 

<E> Rotates between three main planes: top, front, and side (3D only).  This also works when the 

original plane is an ACS or context rotation, so the user does not have to use [R] + [X], [R] + [Y] 

to rotate to a 90° plane. 

<X> Toggles the lock status for the X value. 

<Y> Toggles the lock status for the Y value. 

<Z> Toggles the lock status for the Z value (3D only). 

<D> Toggles the lock status for the Distance value. 

<A> Toggles the lock status for the Angle value. 

<L> + <I> Locks the current index state.  If an axis or distance is not indexed, indexing is disabled.  On the 

other hand, if an axis or distance is indexed, it is locked.  The effect is temporary, lasting until a 

data point is entered or the shortcut is run again.  This is useful if the user needs to index to one 

axis but not the other, or to enter a data point very close to an axis, but not on the axis. 

<L> + <P> Toggles ACS Grid Plane lock, which toggles the ACS Plane and ACS Plane Snap locks, and the 

Grid view attribute for all views. 

<L> + <A> Toggles ACS Plane lock. 

<L> + <S> Toggles ACS Plane snap lock. 

<L> + <Z> Toggles Sticky Z Lock, which is used in conjunction with ACS Plane Snap Lock to force a series 

of snap points to lie on the active ACS' XY plane (Z=0). 

<R> + <Q> Used to quickly and temporarily rotate the drawing plane. 

<R> + <A> Permanently rotate the drawing plane.  Because it rotates the current ACS, this rotation is still 

active after the tool in use is exited.  When active, the tool setting Use Current Origin causes the 

drawing plane origin to be used as the x-axis origin, thereby eliminating the need to enter an extra 

data point. 

<R> + <C> Rotates the drawing plane to the current ACS. 

<R> + <E> Rotates the drawing plane to match the orientation of a selected element. 

<R> + <V> Rotates the active view to match the current drawing plane. 

<R> + <X> Rotates the drawing plane 90° about its x-axis. 

<R> + <Y> Rotates the drawing plane 90° about its y-axis. 

<R> + <Z> Rotates the drawing plane 90° about its z-axis. 

<G> + <T> Moves focus to the Tool settings dialog. 

<G> + <K> Opens (or moves focus to) the Key-in window (equivalent to selecting Utilities > Key-in from the 

Menu Bar). 
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<G> +  <S> Opens (or moves focus to) the AccuDraw Settings dialog (equivalent to selecting Settings > 

AccuDraw from the Menu Bar). 

<G> + <A> Opens the Get ACS dialog, which saves an Auxiliary Coordinate System. 

<W> + <A> Opens the Write to ACS dialog, which saves the drawing plane alignment as an ACS. 

<P> Opens the Data Point Key-in dialog for entering a single data point. 

<M> Opens the Data Point Key-in dialog for entering multiple data points. 

<I> Activates Intersect snap mode. 

<N> Activates Nearest snap mode. 

<C> Activates Center snap mode. 

<K> Opens the Keypoint Snap Divisor dialog, which is used to set the Snap Divisor for keypoint 

snapping. 

<H> + <A> Suspends AccuDraw for the current tool operation. Selecting a new tool, or entering a Reset re-

enables AccuDraw. 

<H> + <S> Toggles AccuSnap on/off. 

<H> + <U> Suspends AccuSnap for the current tool operation.  Selecting a new tool or entering a Reset re-

enables AccuSnap. 

<Q> Deactivates AccuDraw. 
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Exercise 7.1  Placing Additional Topo Elements 

➢ Place A Missing Fire Hydrant  

According to the survey field notes, the fire hydrant should have been in the drawing at Station 206+68, 60 

feet left of centerline. Instead it is located approximately at Station 207+00, 70 feet left of centerline. This 

exercise will relocate the fire hydrant along the left side of the roadway.   

1. Open the MicroStation File c:\e\projects\12345678901\survey\topord01.dgn and zoom into the 
location of Stations 206+00 to 208+00 at the beginning of the project. 

2. From the Primary toolbar, ensure that the AccuDraw is toggle ON. 

 

3. Rotate the image as follows: 

Using the View Controls, select the Rotate View icon and set the Method to 2 Points. 

   

 

As per the Status Bar prompt, define the first point by placing a data point on Station 206 and then define X axis of 

view by placing a second data point on Station 207.  The image automatically rotates along that line. 

 

Note Do not worry about the element symbology.  AccuDraw and the Place SmartLine tool are only being used 
to help locate the fire hydrant station and offset.  The line will be deleted at the end of this exercise. 
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4. From the Drawing task, click the Place SmartLine icon. 

 

5. Place a Tentative Point at the intersection of the centerline and Station 206+00 tic mark and then place 

a Data point to accept the tentative location to start the Place SmartLine tool. 

 

6. Press the AccuDraw shortcut keys [R] + [Q] (Rotate Quick).  

7. Move the cursor to the right. A preview of the line that will be drawn is shown and the X Value in 

AccuDraw will highlight. Using the AccuDraw SmartLock feature as shown below, key-in a distance of 

68.00.  The length is locked in. 
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8. Move the cursor up and the Y Value in AccuDraw will highlight. Using the AccuDraw SmartLock 

feature as shown below, key-in a distance of 60.00.  The SmartLine extends automatically to the new 

location. 

 

9. Data point to accept the new location of the SmartLine.  Reset to exit the Place SmartLine command. 

10. From the FDOT Plans Development task, click on the Move icon to move the fire hydrant at 

Station 207+00 with a left offset of 70 feet to the new location at Station 206+68 with a left offset of 

60 feet.   
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11. Snap to the center of the fire hydrant located at Station 207+00 at a 70 foot offset left of centerline and 

then place a Data Point to accept. The fire hydrant attaches to the cursor. 

 

12. Snap to the new location at the end of the SmartLine previously drawn and data point to move the fire 

hydrant cell at the proper Station 206+68 and offset 60’ left. 
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13. From the Main Task bar, click on the Delete Element  icon and then select the SmartLine to be 

removed from the drawing.  

 

 

➢ Place A Missing Building  

1. Continuing in the MicroStation File c:\e\projects\12345678901\survey\topord01.dgn, change the active 

level to Building_ep from the Attributes toolbar located at the top of the application window. 
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2. Zoom / Pan into the location of Stations 207+00 to 208+00. A building not located on the original 

survey will be placed at this location.  According to new survey field notes, the northeast corner of the 

building is at X=855,489, Y=1,191,686 and has the dimensions shown below. 

 

3. Ensure that AccuDraw is active and undocked into a floating dialog. If needed, click the AccuDraw 

dialog and press the [Space Bar] to change the AccuDraw compass to Polar coordinates mode as shown 

below. 

               

4. Click the Place SmartLine   icon from the Linear Elements toolbox. 
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5. From the Primary tool bar, select the Key-in window and type in xy=855489,1191686, and then press 

the Enter.  The SmartLine tool now begins at the northeast corner of the building.   

 

6. Move the cursor to the left to start the SmartLine.  Notice the Distance highlights in the AccuDraw 

dialog. 

7. From the AccuDraw dialog: 

a.   Enter 44.00 for Distance, press the [Tab] key 

b.   Enter 180.00 for Angle 

8. Place a data point.  The AccuDraw Compass is now oriented to the first line segment which makes it 

very easy to create the building shape. 
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9. Complete the next side with the following: 

a.   Using the AccuDraw SmartLock feature, move the cursor down to make the building corner 

90°. 

b.   Enter a Distance of 27.00 in the AccuDraw dialog. 

10. Place a data point to accept the end of the line segment. 

 

11. Repeat step 8 for the next 3 sides of the building: 

a.   Move the cursor to the left and enter Distance of 27 feet and make the building corner 90° 

b.   Move the cursor down and enter Distance of 38 feet and make the building corner 90°.  

c.   Move the cursor to the right and enter Distance of 71 feet and make the building corner 90°.  
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12. Move the cursor close to the starting point of the building to automatically snap to the end of the first 

line segment. 

 

13. Place a data point to accept and then reset to end the Smartline tool. 

14. When finished, Exit MicroStation. 

  



Chapter 7 ________________________________________________ DRAWING WITH PRECISION - AccuDraw Shortcut Key-ins  

7-26 © 2018 FDOT FDOT Bentley CADD Essentials  

[PAGE INTENTIONALLY LEFT BLANK 

 



 

FDOT Bentley CADD Essentials © 2018 FDOT 8-1 

8 CHANGING ELEMENTS 

OBJECTIVES 

Refining designs usually requires manipulating elements after they’ve been created.  This chapter discusses the 

manipulation and modification tools provided in MicroStation. 

• Identifying Elements 

• Selecting Elements 

• Manipulate Elements  

• Modify Elements  

• Deleting Elements 

INTRODUCTION 

Many times MicroStation users are not called on to create new designs, but edit existing ones.  The user needs tools 

that allow manipulation and modification of existing geometry. MicroStation provides many tools dedicated to 

changing existing graphic elements. 

IDENTIFYING ELEMENTS 

Many of the operations performed in a design session rely on the ability to identify existing elements, or to pick 

specific points on those elements. MicroStation provides the tools to perform these tasks. Elements, or key points 

on elements, can be quickly and conveniently identified using tentative snap points and data points.  

➢ Manual Identification 

Many tools require the identification of one or more elements. This can be done manually by placing the 

pointer over the element and entering a data point to highlight the element. If previewing which element is 

being selected, tentative snap points can be entered first, until the correct element highlights, and then accept 

with a data point.  If more than one element exists in the same location, right clicking after accepting the 

element will scroll through the elements.  Left click to accept the correct one. 

➢ AccuSnap Identification 

AccuSnap automates the identification of elements and the 

placement of tentative snap points, so that all tentative snap points 

do not have to be entered manually. The Enable AccuSnap setting in 

the General tab of the AccuSnap Settings dialog can be turned on 

to automatically locate and snap a tentative point to elements. Simply 

move the cursor to the region of the element to be identified and 

AccuSnap snaps to it automatically.  
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➢ Automatic Identification 

Separately or in conjunction with AccuSnap, the capability to automatically identify elements for various 

tools can be enabled with the Identify Elements Automatically setting in the AccuSnap Settings dialog, 

General tab.  Like AccuSnap, this setting can greatly reduce the number of button presses required in a design 

session. Using this setting with the Delete Element tool, for example, only requires moving the cursor over 

an element in any view and it highlights with a single data point to delete the element. 

➢ Popup Identification 

As part of the automatic element identification functions, the Pop-up Info in the AccuSnap Settings dialog, 

General tab can be enabled. When hovering the cursor over a highlighted element, information about it 

appears in a pop-up window. 

SELECTING ELEMENTS 

For operations performed on existing elements within a design file, the user must have the ability to select those 

elements. This can be done manually, by placing the cursor over an element and entering a data point. Alternatively, 

the cursor can be placed over an element and enter a tentative point first, to check the selection prior to accepting 

with a data point. Entering a tentative point can be performed automatically with AccuSnap or by pressing the 

tentative button to enter it manually. 

With AccuSnap's Identify Elements Automatically setting, this process is streamlined, dramatically reducing the 

number of button presses required. Normally, to identify an element manually requires at least one button press, or 

two, if entering a tentative point first. With AccuSnap and the Identify Elements Automatically setting, the cursor 

only has to position over an element to identify and highlight it — without a button press. For example, to delete an 

element with the Delete Element tool, the cursor need only to be placed over the element so that it highlights and 

then accept with a data point to complete the deletion.  

Note The selection and grouping tools will be discussed in greater detail in Chapter 9 of this document. 

➢ Element Selection Tool 

The Element Selection tool allows for the selection of multiple elements to be worked on as a temporary 

group by a variety of means as shown below. Using this method, for example, move, copy, rotate, or scale 

multiple elements together. By default, selected elements are bracketed with squares called handles. If any 

elements are selected, an arrowhead icon is displayed in the status bar. The number to the right of the icon 

is the number of selected elements.  Chapter 9 will expand on the functionality of this tool. 
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➢ Selecting By Attributes 

The Select By Attributes dialog (Edit > Select By Attributes) provides additional attribute-based element 

selection options — selection by attached tag values and by properties. Properties include the area attribute 

(Solid or Hole), whether an element can be snapped to, whether it is locked, and whether it has been modified.  

Chapter 9 will expand on the functionality of this tool. 
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MANIPULATE ELEMENTS 

The Manipulate Classic toolbox, accessed from the FDOT Plans Development task, contains tools that are used 

to copy, move, resize, rotate, mirror, create arrays, align, and stretch elements.  These tools can be used in 

conjunction with the Element Selection tool, to manipulate groups of elements simultaneously.  Of course, they can 

also be used by themselves to manipulate single elements. 

      

Note Used with the Element Selection tool, an element needs only to be right-clicked on to open a menu with 
options to copy, move, scale, rotate, mirror, delete, or display the properties for the selected element. 

 
Copy Element Copy an element(s). 

 
Move Element Move an element(s). 

 
Move  Parallel Move or copy an element parallel to the original. 

 
Move to Contact Move an element(s) in a defined direction until it contacts an existing 

element in the model. 

 
Scale Element Resize an element(s) by the Active Scale factors. 

 
Rotate Element Rotates an element(s). 

 
Mirror Element Mirror an element(s). 

 
Array Elements Copy an element(s) multiple times to create a rectangular or a polar 

(circular) array. 

 
Align Element by 

Edge 

Aligns an element(s) to an edge of another element. 

 
Stretch Element Stretch an element(s). 
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COPY ELEMENT  

The Copy Element tool creates a duplicate of an existing element without affecting the original. It identifies 

the element to be copied with a data point and then enters a second data point at the location where the copy 

or copies should appear.  An element can be copied multiple times in one operation, similar to creating an 

array. 

 

Tool settings for Copy Element are listed below: 

Copies The number of copies created is defined by the entered value. 

Use Fence The fence contents are copied. This option is grayed out until an active fence is 

placed in the file. The fence option dropdown list sets the Fence (Selection) 

Mode. 

MOVE ELEMENT 

The Move Element tool relocates an element.  After identifying the element to be moved, enter a second 

data point to define its new location. Additional data points continue to move the element until the reset 

command is issued. 

 

The Tool settings for moving an element are described below. 

Use Fence If on, the fence contents are moved. This option is grayed out until an active fence is 

placed in the file. The fence option dropdown list sets the Fence (Selection) Mode. 
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MOVE/COPY PARALLEL 

The Move Parallel tool is used to move or copy an element (line, line string, multi-line, curve, arc, ellipse, 

shape, complex chain, or complex shape) parallel to the original. 

 

Mode Determines the method by which the gap created, by moving two connected 

elements to a parallel location, is filled. 

Miter Extends or shortens connecting segments while maintaining the angle of their 

connections. 

Round Fills the gap with a rounded arc between the two moved elements. 

Original Fills the gap in the same manner as the MicroStation implementation of this tool; 

the resulting element is the same type as the original element. 

Distance If on, the entered value sets the distance to move the existing element. 

  Define 

Distance Icon 

Defines the distance to move, graphically using two data points. When the 

distance is defined, the Distance setting is turned on automatically and the defined 

distance value is displayed in its field. 

Use Active 

Attributes 

If on, the moved or copied element takes on the active attributes.  If off, the moved 

or copied element retains the attributes of the existing element. 

Keep Original If on, the original elements are not manipulated. 

Note For some element types, such as ellipses, Original does not produce a true parallel offset. With an ellipse 
Miter or Round results in a B-spline, a true parallel offset, rather than an ellipse. 

MOVE TO CONTACT 

The Move To Contact tool is used in either 2D or 3D to move one or more elements in a defined direction 

until they make contact with another element. If no element is in the path, then the element is not moved. 
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SCALE ELEMENT 

The Scale Element tool is used to resize (scale) an element(s) 

individually, as a selected group, or within a fence. Scaling an 

element can be useful for changing the size of an element without 

having to redraw the element.  Elements can be scaled in any or 

all of the three axis directions (X, Y and Z). 

 

Note Elements may be selected individually, or multiple elements 
selected to scale in a selection set or by using the fence.   

 

 

 

Method Defines how the elements are scaled 

Active Scale Method by which an existing element is scaled by the active scale factors (X Scale, Y 

Scale and Z Scale).  If a scale factor is between 0 and 1 (for example, 0.25), the size in 

that direction is decreased; if a scale factor is greater than 1, the size in that direction is 

increased. 

3 points Method by which an existing element is scaled graphically, through the entry of three 

data points. The scale factors are computed by dividing the distance between the first 

and third points by the distance between the first and second points. 

X Scale Scale factor along view x-axis (horizontal), when method is Active Scale. 

Y Scale Scale factor along view y-axis (vertical), when method is Active Scale. 

Proportional If on, the element(s) proportions are maintained, when the 3 points method is used. 

About 

Element 

Center 

If on, in the Extended Information section of the Tool settings dialog, the selected 

element(s) is scaled about its center point instead of a selected point. Cells and text 

elements are scaled about their origins. 

Copies If on, the element(s) are copied and the copy(s) are scaled; the original(s) are not 

manipulated. The adjacent field sets the number of scaled copies to create. 

Use Fence If on, the fence contents are scaled. This option is grayed out until an active fence is 

placed in the file and the tool is selected. The fence option menu sets the Fence 

(Selection) Mode. 

Scale Multi-

line Offsets 

If on, multi-line offsets are scaled (i.e., scaling the wall thickness when resizing a 

room). 

Scale 

Dimensions 

If on, dimension values are modified to reflect the size of the scaled dimension.  If off, 

only the dimension elements are scaled, while the dimension value remains unchanged. 

Scale 

Annotations 

If on, annotations are scaled.  If off, size of annotations remains unchanged. 
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ROTATE ELEMENT 

The Rotate Element tool is used to rotate.  Elements can be rotated individually, as a selected group or 

within a fence. 

 

Method Defines how the elements are rotated. 

Active Angle Rotates elements by the Active Angle value, which can be keyed in. 

2 Points Rotates elements by an angle of rotation defined by entering two data points. 

3 Points Rotates elements by an angle of rotation defined by entering three data points. 

About 

Element 

Center 

If on, in the Extended Information section of the Tool settings dialog, the selected 

element(s) is rotated about its center point instead of a selected point. Cells and text 

elements are rotated about their origins. 

Copies If on, the element(s) are copied and the copy(s) are rotated; the original(s) are not 

manipulated.  The adjacent field sets the number of rotated copies to create. 

Use Fence If on, the fence contents are rotated. This option is grayed out until an active fence 

is placed in the file. The fence option menu sets the Fence (Selection) Mode. 

Note Elements may be selected individually, or multiple elements selected to rotate in a selection set or by using 
the fence.   
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MIRROR ELEMENT 

This tool mirrors an element about one of three axes. Rather than manipulating the original element, enabling 

the Make Copy toggle creates a second occurrence of the element. 

 

Mirror About Sets direction in which element(s) are mirrored: 

Horizontal Elements are mirrored about the horizontal, or X, axis. 

Vertical Elements are mirrored about the about vertical, or Y, axis. 

Line Elements are mirrored about a line defined by two data points. 

About Element 

Center 

If on, the selected element(s) is mirrored about its center point instead of a 

selected point. Cells and text elements are mirrored about their origins. 

Make Copy If on, the element(s) are copied and the copy(s) mirrored; the original(s) are not 

manipulated. 

Use Fence If on, the fence contents are mirrored. This option is grayed out until an active 

fence is placed in the file. The fence option menu sets the Fence (Selection) 

Mode. 

Mirror Multi-

line Offsets 

If on, multi-line profile offsets are mirrored. 

Mirror Text If on, text is mirrored. 
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CONSTRUCT ARRAY 

Construct Array copies an element as many times as desired to create an array of elements.  Polar arrays and 

rectangular arrays are supported by this tool. 

 

Method Sets the type of array that is constructed; different tool settings are available 

depending on these settings: 

Rectangular Constructs a Rectangular array. 

• Active Angle – Aligns the imaginary orthogonal grid on which the copies are 

placed. 

• Rows – Defines the number of rows in the array. 

• Columns – Defines the number of columns in the array. 

• Row Spacing – Defines the space between rows. 

• Column Spacing – Defines the space between columns. 

• Use Fence – If on, the fence contents are copied into an array. This option is 

grayed out until an active fence is placed in the file.  The fence option menu 

sets the Fence (Selection) Mode. 

Polar Constructs a Polar (circular) array. 

• Items – Sets the number of items or copies in the array, including the 

original. 

• Delta Angle – Sets the angle between items.  If positive, copies are placed 

counterclockwise.  If negative, copies are placed clockwise. 

• Rotate Items – If on, the element(s) are rotated about the center of the 

array. 

• Use Fence – If on, the fence contents are copied into an array. This option 

is grayed out until an active fence is placed in the file.  The fence option 

menu sets the Fence (Selection) Mode. 
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Along Path Constructs an array along a path element. 

• Mode – Sets the way that the array is 

created. 

o Number – Defines the number of 

items in the array, via the Copies 

setting. 

o Distance – Defines the distance 

between items in the array, via the 

Distance setting. 

o Both – Defines the number of 

items in the array and the distance between each item, via the Copies and 

Distance settings respectively. 

• Copies – If on, the element(s) are copied; the original(s) are not manipulated.  

The adjacent field sets the number of rotated copies to create. 

• Rotate Items – If on, the element(s) are rotated to maintain their relative 

orientation to the path element. 

• Use Fence – If on, the fence contents are copied into an array. This option is 

grayed out until an active fence is placed in the file.  The fence option menu 

sets the Fence (Selection) Mode. 

ALIGN ELEMENTS BY EDGE 

This tool is used to align an element or group of elements to the edge of a secondary element. 

 

Align Sets the manner by which to align. 

Make Copy If on, the element(s) are copied and the copy(s) are aligned to the identified base 

element; the original(s) are not manipulated. 

Use Fence If on, the fence contents are aligned. This option is grayed out until an active fence 

is placed in the file.  The option menu sets the Fence (Selection) Mode. 
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STRETCH ELEMENT 

The Stretch Element tool is used to manipulate breaks (such as breaks in multi-lines, which are often used 

to represent windows or doorways when the multi-line itself is the wall).  

The Stretch Element tool operates on elements as follows: 

• A vertex of a line, line string, multi-line, or shape is moved if it is inside the fence. A vertex 

outside the fence is not moved. 

• An endpoint of an arc is moved if it is inside the fence.  An arc endpoint outside the fence is 

not moved. 

• An ellipse, circle, or cell is moved if it is completely inside the fence. 

• One or more poles (control points) of a B-spline surface, that are located inside the fence, are 

moved. 

 

Use Fence (Fence present only) If on, the current active fence is used. 

Stretch 

Cells 

If on, cells that overlap the fence are stretched. 
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Exercise 8.1  Manipulate Tools 

➢ Copy Parallel 

Construct an edge of pavement line. 

1. Open the MicroStation file c:\e\projects\12345678901\survey\topord02.dgn. 

2. Pan and Zoom into the area of the 7-11 Convenience Store located on the East side of the CL Survey 

near Station 313+00. 

 

3. From the Manipulate toolbox, click the Move Parallel icon.   

  

 

 

4. In the Move/Copy Parallel Tool Settings, enter the values shown to 

construct an edge of pavement line 1.5 feet inside the field located at 

the back of curb line that’s shown around the northern edge of the 

parking area. 

 

 

Tip   Remember to watch the step-by-step reminder messages located in the 

lower left side of the Status Bar.  
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5. Select the topo miscellaneous line, as shown below.  

 

6. Move the cursor to the right. A copy will be automatically display 1.5 feet from the back of curb line. 

Place data point to accept as highlighted below.  

 

 

7. Right-click to reset and close the Copy Parallel tool. 
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➢ Rotate Element 

1. Continuing in c:\e\projects\12345678901\survey\topord02.dgn, 

zoom into the sign located on the north side of the 7-11 lot. 

2. From the Manipulate toolbox, click the Rotate icon. 

           

3. To rotate the sign to be parallel with the curb, enter the values shown 

in the Rotate Tool Settings.   

 

 

 

 

4. Select the sign element. The image automatically displays the rotation.   

 

5. Place a data point anywhere to accept the rotation. 
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➢ Align Edges 

1. Continuing on the 7-11 lot, using the View Controls, window-in on the area of the gas pumps as shown 

below. 

 

2. Click on the Align Edges icon located on the Manipulate toolbox. 

 

3. Match the Align Edges Tool Settings shown below. 

 

4. Click on the bottom of circle number 1 as the base element for alignment. 

 

5. Click on the bottom of circles number 2 and 3 to align with circle number 1.  

 

Tip   MicroStation provides next step reminders in the lower left status bar.   

  then   

6. Place a data point to accept selections and close the Align Edges tool. 
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MODIFY ELEMENTS TOOLBOX 

The Modify Element toolbox, accessed from the Main toolbox (or from the Task Navigator by selecting Main > 

Modify), contains tools that are used to modify the geometry of an element; usually by adding or deleting geometry 

or vertex points. 

 

 

Modify Element

  

One of the most useful tools as it can be used to modify many types of geometry.  

 

Partial Delete Delete part of an element. 

 

Break Element 

by Point 

Break a linear element at a defined point. 

 
Extend Line Extend or shorten a line. 

 
Trim to 

Intersection 

Extend or shorten two open elements to their intersection. 

 

Trim to Element Extend or shorten an open element to its intersection with another element. 

 
Trim Multiple Trim, extend, or trim and extend elements one at a time, or multiple elements 

simultaneously, to their intersection with one or more other elements. 

 

IntelliTrim Simultaneously trim or extend multiple elements at their intersection with one or more 

other elements. 

 

Insert Vertex Insert a vertex in a linear element. 

 
Delete Vertex Delete a vertex from a linear element. 

 

Construct 

Circular Fillet 

Construct a circular fillet between two elements. 

 

Construct 

Chamfer 

Construct a chamfer between two lines or adjacent segments of a line string or shape. 

MODIFY ELEMENT 

The Modify Element tool is used most often to adjust lines and line segments by moving or inserting vertices.  

It can also be used to change the geometry of blocks and complex shapes.  This tool is used to do the 

following:   

• Move a vertex or segment of a line, line string, multi-line, curve, B-spline control polygon, 

shape, complex chain, or complex shape. 

• Scale a block about the opposite vertex. 
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• Modify rounded segments of complex chains and complex shapes created with the Place 

SmartLine tool while preserving their tangency. 

• Change rounded segments of complex chains and complex shapes to sharp and vice-versa. 

• Scale a circular arc while maintaining its sweep angle. 

• Change a circle's radius or the length of one axis of an ellipse. 

• Move dimension text or modify the extension line length of a dimension element. 

Elements with multiple segments are line strings, shapes, and complex chains, including complex shapes 

placed with the Place SmartLine tool.  When used with AccuDraw, the Modify Element tool not only 

modifies vertices and segments, but also changes a vertex's type (Sharp, Rounded or Chamfered). 

    

SmartLine Modification 

Settings  

Displays the controls for defining how SmartLine elements are modified with the 

Modify Element tool. 

Turning off this setting disables the remaining settings as they apply only to 

SmartLine style modifications. 

Enable SmartLine 

modifications 

If on (the default), modifications to vertices and segments of SmartLines take into 

account the adjoining elements. For example, lines that are tangential to a rounded 

vertex, remain tangential. 

If off, vertices and segments of SmartLines are modified individually. 

Enable segment selection If on (the default), segments of SmartLines may be selected, as well as the vertices.  

If off, only vertices may be modified. 

Minimize number of 

linear elements 

If on, attempts to reduce the number of component elements in a complex chain or 

shape. For example, a number of individual lines that have been chained together 

may be converted to a line string. 

If off, does not attempt to reduce the number of component elements in a complex 

chain or shape. 

Convert selected round 

or chamfer to segment 

If on, when a rounded or chamfered vertex is selected, it is converted to a segment 

(arc or linear segment) so that it can be modified as such. This applies only to the 

selected round or chamfer, not to the whole chain or shape. After modification, the 

component will not be treated as a round or chamfer again. 

Vertex Settings Defines the type of vertex to use.   

• From Element — Uses the element's own settings. 

• Last Used — Uses the type of vertex that was last used when 

creating a SmartLine element. 
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PARTIAL DELETE 

The Partial Delete tool is used to delete parts of, but not the entire element.  The first data point defines the 

start point of the deletion and the second data point defines the direction and extent of the deletion. Two rules 

are followed when used: 

• A closed element is turned into an open element (i.e., an ellipse or circle becomes an arc, a 

shape becomes a line string, a closed B-spline curve becomes an open B-spline curve, etc.). 

• If an interior portion of an open element (line, line string, multi-line, curve, or arc) is partially 

deleted, the element is divided into two elements of the same type. 

BREAK ELEMENT 

The Break Element tool is used to break a linear element at a defined point by identifying the element at the 

point where the break is required with a data point and then accepting to place the break. 

 

Right: After placing break points, the two sections can be manipulated individually. 

 

EXTEND LINE 

The Extend Line tool is used to extend or shorten a line or an end segment 

of a line string or multi-line. 

  

Distance If on, the entered value specifies the distance to extend or shorten the line. 

• A negative distance shortens the line. 

• A positive distance extends the line 

From End (Applies for Distance off only)   If on, the extension, or shortening, of the line is relative 

to the nearest endpoint to the identification point. 

If off, the extension, or shortening, of the line is relative to the origin point of the line, 

no matter where it is identified. 
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TRIM TO INTERSECTION 

The Trim To Intersection tool is used to extend or shorten two elements of any type to their intersection. 

When an element is extended, the end nearest the point where it was selected is moved, and the other end 

remains unchanged. When an element is shortened, the part of the element that is selected is kept. 

 

TRIM TO ELEMENT 

The Trim to Element tool is used to extend or shorten one or more 

lines, line strings, or arcs to their intersection with another element. 

When an element is extended, the end nearest the point where it was 

identified is moved, and the other end remains unchanged. When an 

element is shortened, the part of the element that is identified is kept. 

Select cutting element first If on, the element selected first will be used as the cutting 

element and the element(s) selected second will be the element 

that is extended or shortened. The default is off. 

TRIM MULTIPLE 

The Trim Element tool is used to trim or cut an element or series of 

elements at their intersection with one or more cutting elements.  The 

cutting element and the element that is trimmed can be lines, line strings, 

arcs, curves, B-spline curves, shapes, ellipses, complex chains or 

complex shapes. 

Trim If selected, the elements that intersect with the cutting element(s) will be trimmed.  

Trim and 

Extend 
If selected, the elements that intersect with the cutting element(s) will be trimmed, and the 

selected elements that can be extended to intersect with the cutting element(s) will be extended.  

Extend If selected, the elements that can be extended to intersect with the cutting element(s) will be 

extended. 
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INTELLITRIM 

The IntilliTrim tool is used to simultaneously trim, extend or cut multiple elements.  The cutting elements or 

elements which can extend other elements are lines, line strings, ellipses, arcs, curves, shapes, complex 

strings, complex shapes, text nodes, and cell headers.  Elements that can be cut or trimmed are lines, line 

strings, curves, arcs, ellipses, shapes, B-spline curves, complex strings, and complex shapes.  The only 

elements that can be extended are lines, line strings, complex chains that end with a line or line string, and b-

spline curves. 

    

Quick Mode • Trim — If on, elements are trimmed.  

• Extend— If on, elements are extended. 

• Cut — If on, elements are cut. (Where the element was cut  will not be seen 

until it is selected.) 

Advanced Mode • Trim — If on, elements are trimmed.  

• Extend — If on, elements are extended. 

• Cut — Dimmed if Advanced is selected. 

Select Elements to Trim If selected, each element that is identified is designated as an element to 

trim (or extend) 

Select Cutting Elements If selected, each element that is identified is designated as a cutting 

element. 

INSERT VERTEX  

The Insert Vertex tool inserts additional vertices within a line, line 

string, multi-line, shape, or B-spline control polygon by identifying 

the element, then entering a data point to position the new vertex.  

This tool can be used to attach a line segment to the endpoint of a line or line string, add an extension line to 

a dimension element, and extend a point curve.  It can also be used to change a point element into a line or a 

line element into a line string 

Note A shape or line string can have 5000 vertices. 

DELETE VERTEX 

The Delete Vertex tool works very much like the Insert Vertex 

tool, except in reverse.  It is used to remove vertices from line 

strings, multi-line, shape, or B-spline control polygon by 

identifying the vertex or extension line and accepting the 

deletion.  It is also used to delete an extension line from a 

dimension element. 
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CONSTRUCT CIRCULAR FILLET 

The Construct Circular Fillet tool is used to construct a 

circular fillet (arc) between two elements (lines, line strings, 

circular arcs, circles, or shapes), two segments of a line 

string, or two sides of a shape. 

Radius Sets the fillet's radius. 

Truncate Sets which side(s) are truncated. 

None — Neither element or segment is truncated. 

Both — Both elements or segments are truncated at their point of tangency with the fillet. 

First — The first element or segment identified (step 2) is truncated at its point of 

tangency with the fillet. 

 

Construct Circular Fillet. From left: Truncate set to None, Both, and First 

CONSTRUCT CHAMFER 

The Construct Chamfer tool is used to construct a chamfer between either of the following: 

• Two lines — The original lines are trimmed and a third line element forms the chamfer. 

• Adjacent segments of a line string or shape — An additional vertex is inserted and the common 

vertex is adjusted to form the chamfer. 

 

Distance 1 Applies to the first element or segment identified. (Step 2) 

Distance 2 Applies to the second element or segment identified. (Step 3) 

  

Chamfer D1 denotes Distance 1. D2 denotes Distance 2  
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Exercise 8.2  Modify Tools 

➢ Extend Line 

1. Continuing in c:\e\projects\12345678901\survey\topord02.dgn, zoom into Stations 28+00 and 29+00, 

just across the street from the 7-11 Convenience. 

 

2. From the Primary toolbox located at the top of the application window, confirm that AccuDraw is active 

by toggling the  icon. There will be a floating dialog or it may be docked at the bottom of the 

application window. 
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3. From the Main task, under the Modify toolbox, click the Extend Line icon and leave the Extend Tool 

Settings as shown. 

    

   

Tip   Watch for the MicroStation reminder messages in the lower left side of the Status Bar. 

4. Using the tick mark at Station 28+00 as the limit for extension, extend all pavement, lane, curb and 

sidewalk lines to that limit: 

5. Move the cursor near one of the elements. There should be an automatic snap to the element. Place a 

data point to accept. 
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6. Enter 20 into the X value of AccuDraw, extending the line upwards.   Place a data point to accept. 

 

7. Repeat that process, striking ENTER to lock the X Axis in AccuDraw and snapping to the previous line 

until the drawing looks like the survey below. 
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DELETE ELEMENTS 

Up to this point, all of the tools covered have been geometry creation tools.  Deleting geometry is also very 

important.  The Delete Element tool is one of the most used tools in the Main toolbox. It is used to remove an 

element(s) from the design by either of the following: 

• Select an element or group of elements to delete with the Element Selection tool and then select 

Delete Element. 

• <OR> 

• Select Delete Element first and then enter a data point on each of the elements to be deleted. 

 

Tip   With the Element Selection tool method, the Delete key on the keyboard can be used instead of selecting Delete 

Element. 

AccuSnap, discussed in Chapter 7, is an intelligent element locating feature of MicroStation and can be used to 

identify elements automatically for deletion if the Identify Elements Automatically checkbox is populated on the 

AccuSnap Settings dialog. 

 

The Delete Fence Contents tool in the Fence toolbox, discussed in Chapter 9, can also be used to delete a group of 

elements. 
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9 SELECTING & GROUPING 

OBJECTIVES 

MicroStation has several tools that allow multiple elements to be selected and grouped together.  These include: 

• Element Selection Tool 

• Fences Tools 

• Select by Attributes 

• Grouping Elements 

INTRODUCTION 

To this point, any modifications and manipulations have been performed on single elements.  When working with 

actual drawings, this is often not practical. A more common task is to modify or manipulate a group of elements.  

For instance, all direction arrows may need to be erased, or an area of the drawing may need to be moved or copied 

to a new location. 

MicroStation has several tools that allow multiple elements to be selected. The next several topics cover various 

ways of selecting multiple objects in MicroStation. 

ELEMENT SELECTION TOOL 

For operations on existing elements in the DGN file, they must be selectable. This can be done manually, by placing 

the cursor over the element and entering a data point. Alternatively, place the cursor over the element and enter a 

tentative point first, to check the selection prior to accepting with a data point. Entering a tentative point can be 

performed automatically with AccuSnap or by pressing the tentative button to enter it manually. 

For operations on several elements, simultaneously, use the Element Selection tool. This tool allows selection of 

multiple elements to be worked on as a temporary group. Using this method, for example, move, copy, rotate, or 

scale multiple elements together. 

While the Element Selection tool is selected, the pointer becomes an arrowhead with an aperture encircling the tip. 

The aperture denotes the design plane area in which MicroStation searches for elements. The aperture size or Locate 

Tolerance is a user preference that is adjustable in the Preferences dialog (Input category). 

If any elements are selected, an arrowhead icon is displayed in the 

MicroStation Status Bar. The number to the right of the icon is the number of 

selected elements. 

The Element Selection tool is access from the Main task embedded at the top of the Task Dialog located by default 

on the left side of the MicroStation application window.  <OR> The Element Selection tool can be access from the 

Main Classic task as well. 

Note MicroStation sets the abbreviated Element Selection tool settings dialog as the default to display when 
a new session is opened.  
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Expanded, the Element Selection tool settings dialog offers a multitude of options for specific selections tasks in 

creating a set of selected elements called the selection set.   

  

Tip   If the desired element is visible, but cannot be selected, check the following: 

• To select a shape, the pointer must be close to one of the enclosing lines. To select a circle or an 

ellipse, the pointer must be close to the circumference or center. A filled element can be selected by 

its interior or surface, which is set in the Locate Interiors option menu of the Preferences dialog 

Input category. 

• If Level Lock is on, elements can only be selected on the active level. 

ELEMENT SELECTION SETTINGS 

The upper portion of the dialog contains two rows of icons that allow the user to choose the Method and 

Mode of creating or editing a selection set and to Disable or Select Handles.  

 

Tip   Dragging from Left-to-Right to select elements will use the (Inside) option. Dragging from Right-to-Left will 

use the (Overlap) option. 

 



SELECTING & GROUPING - Element Selection Tool ______________________________________________________ Chapter 9 

FDOT Bentley CADD Essentials © 2018 FDOT 9-3 

Method:  

  Individual 
Allows the user to select individual elements graphically. To select 

additional elements (when mode is set to New) hold the <Ctl> key, then click 

on elements. 

  Block  (Inside) 
All elements inside the defined block are selected. Click this icon to toggle 

between Inside and Overlap. 

  Block  (Overlap) 
All elements inside plus those overlapping the defined block are selected.  

Click this icon to toggle between Inside and Overlap. 

  Shape (Inside) 
All elements inside the defined shape are selected. Click this icon to toggle 

between Inside and Overlap. 

  Shape (Overlap) 
All elements inside plus those overlapping the defined shape are selected. 

Click this icon to toggle between Inside and Overlap. 

  Circle (Inside) All elements inside the defined circle are selected.  Click this icon to toggle 

between Inside and Overlap. 

  Circle (Overlap) 
All elements inside plus those overlapping the defined circle are selected.  

Click this icon to toggle between Inside and Overlap. 

  Line 
Elements are selected by defining a line that intersects them. 

Mode:  

  New 
Clears the current selection set and starts a new selection set. 

  Add 
Adds elements to the selection set. 

  Subtract 
Removes elements from the selection set. 

  Invert 
Toggles the selection status of an element (selects deselected elements and 

deselects selected elements). 

  Select All /        

Clear 

Deselects all selected elements, or selects all elements if no elements are 

currently selected. 

  Disable Handles 
If on, handles are not displayed for selected elements.   

  Select Handles 

If on, the Block / Shape / Circle / Line selection methods and the Add / 

Subtract / Invert / Clear selection modes apply to selecting handles rather 

than elements. (To use this icon, Disable Handles must be off.) 
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ELEMENT SELECTION EXTENDED SETTINGS  

Selecting the Show Extended Settings arrow expands the Element Selection window to reveal the Attribute 

tabs.  These tabs allow for selection of elements by one or more attributes by clicking on any given attribute 

in any tab.  Alternatively, when selecting elements graphically, the active set of attributes displays as a 

highlighted group in each tab's list box. 

If choosing an attribute that exists in a complex element such as a cell, the entire complex element is selected. 

If choosing a Color, Line Style, or Line Weight attribute, Element Selection finds all elements with this active 

symbology, including ByLevel attributes.  

Note All tabs are not visible by default.  Right-clicking on a tab will display a pop-up menu to 
customize the tabs displayed. 

 

 

   

  
Level Allows selection of the required levels from a list of levels in the 

model displayed in the window below the tab heading. 

  
Color Allows selection of the required colors from a list (0–254 plus 

ByLevel). 

  
Line Style Allows selection of the required line styles from a list (standard line 

styles plus custom line styles and ByLevel). 

  
Line Weight Allows selection of the required line weights from a list (0–31 plus 

ByLevel). 

  
Dimension 

Styles 

Allows selection of the required dimension style from a list. 

  
Multi-line 

Styles 

Allows selection of the required multi-line style from a list. 

   
Transparency Allows selection of the required transparency style from a list. 

  
Display 

Priority 

Allows selection of the required  display priority from a list. 

  
Element Type Allows selection of the required element types from a list. 

  
Element 

Class Allows selection of the required element classes from a list. 

   
Element 

Template Allows selection of the required element template from a list. 

 
Text Styles 

Allows selection of the required text style from a list. 
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SELECTION HANDLES 

By default, selected elements are bracketed with squares called Edit Handles (or handles). They are used to 

modify or manipulate elements. They are represented by on-screen interactive graphics that are associated 

with a particular user action. There are several types of handles that perform different functions. 

The above elements can be modified and manipulated by selecting them first with the Element Selection tool, 

which displays handles for the element, named fence, or reference boundary display.  When handles are 

displayed: 

• Drag a handle to modify the element, while maintaining geometric constraints, such as angles at vertices 

and radius ratios.  

• Press the <Alt> key while dragging a single handle, to modify the element without maintaining 

geometric constraints. 

• Drag any other part of the selected element to move or copy it. To copy it press and hold down the <Ctrl> 

key once dragging starts. 

• Use <ctrl-data point > to select multiple handles and modify them simultaneously. 

• Press the <Ctrl> key while dragging a selection set around a set of handles to select the handles. 

• Where multiple elements are selected, select handles on any of the highlighted elements. 

USING FENCES 

A fence is used to create a temporary grouping of objects that ends when the DGN file is closed, if not before.  The 

group is defined by placing a fence object in the design file, just as the pointer is dragged around elements to select 

them with the Element Selection tool.  A fence has two additional grouping capabilities: 

• As a void to exclude elements inside (or overlapping) the fence boundary. 

• To clip elements that cross the fence boundary, like a cookie cutter, so that only the parts inside the fence 

boundary (or outside in the case of a void) are subject to manipulation. 

Fences can be rectangular (fence block), polygonal (fence shape), or circular (fence circle). A fence shape can be 

derived from a previously placed shape element. Fences are persistent in both 3D and 2D DGN files. Place a fence 

or zoom in on the design and the fence will remain when zooming back out. 
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The Fence toolbox can be accessed from the Main Task bar or from the Main Classic Task bar. 

      

 

 
Place Fence Used to place the fence. 

 
Modify Fence Used to move the fence or modify one of its vertices. 

 
Manipulate Fence 

Contents 

Used to manipulate fence contents or extend/shorten elements that 

overlap the fence. 

 
Delete Fence Contents Used to delete fence contents. 

 
Drop Fence Contents

  

Used to break up the complex elements included in the fence contents 

into their components. 

 
Copy/Move Fence 

Contents to File 

Used to copy or move the fence contents to a new DGN file. 
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PLACE FENCE 

The Place Fence tool is used to place the fence.  On placement, the fence, whether a fence block, shape or 

circle, is displayed on screen as a closed shape with the color used to highlight identified elements.  While 

the fence is placed, a fence mode icon displays in the Status Bar. 

 

Note It is not necessary to place the fence in order to set the Fence Selection Mode. Conversely, once the fence 
is placed, the user can adjust the Fence Selection Mode to change the fence contents without moving or 
replacing the fence. 

Fence Type The Fence Type determines the general shape of the fence and how it is placed. 

Block, Shape, 

or Circle 

Used to set the geometric characteristics of a fence for graphical placement. 

Element Uses an existing element to create a fence.  The element selected must be a closed 

shape. 

From View Sets a fence to include the contents of the selected view. 

From File Sets a fence to include the contents of a DGN file. An option menu allow the 

choice of the following: 

o Active — elements in the active model from a selected view. 

o All — elements in the active model and its references, from a selected 

view. 

o Choose — elements from a selected reference (or the active model), 

which are identified by identifying an element from the required 

model/reference 

From Flood Sets a fence to include the (minimum) area enclosed by a set of elements. 
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Fence Mode Sets the Fence (Selection) Mode that, in conjunction with the fence placement, 

defines the fence contents for manipulation. 

Inside 
Only those elements completely inside the fence are processed. 

Overlap 
Only those elements inside or overlapping the fence are processed. 

Clip 
Only elements completely inside the fence and the parts of elements inside the 

fence are processed. 

Void 
Only elements completely outside the fence are processed. 

Void-Overlap 
Only elements outside or overlapping the fence are processed. 

Void-Clip 
Only elements completely outside the fence and parts of elements outside and 

overlapping the fence are processed. 

Named fence 

t

o

o

l

s 

Clicking the Expand arrow expands the tool settings to reveal the Named Fence 

tools.  Double-click in the Name or Description column to modify this 

information for a named fence. Use the Display column to toggle on and off the 

display of a named fence. 

o Activate Named Fence - Makes the named fence (selected in the 

named fence list) the active fence. 

o Delete Named Fence - Deletes the named fence selected in the named 

fence list. 

o Create Named Fence from Active Fence - Creates a named fence. 

o Named fence list - Lists all named fences in the model. 

Note Nearly all of the tools in the Manipulate toolbox have a Use Fence option in their Tool settings. If this 
option is selected, and a fence is present in the drawing, the Manipulate tool affects the fence contents. 

MODIFY FENCE  

The Modify Fence tool allows the user to move a fence or modify one of its vertices after it is placed.  There 

are two modes available to choose from, Vertex or Position. 

The Vertex mode allows the user to select a vertex along the fence perimeter and shift it to a new location.  

The Position mode allows the user to select and move the position of the entire fence. 
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MANIPULATE FENCE CONTENTS 

The Manipulate Fence Contents tool provides the means to change the contents of the fence based on the 

provided operations: copy, move, scale, rotate, mirror, array or stretch.  These are typical of the options 

available in the Manipulate toolbox. 

The method of manipulation is determined by the tool setting Operation. With the exception of Stretch, each 

Method works identically to a tool in the Manipulate toolbox with the tool setting Use Fence on. 

 

The Stretch operation causes the Manipulate Fence Contents to ignore the Fence (Selection) Mode and 

operates on elements as follows: 

• A vertex of a line, line string, multi-line, or shape is moved if it is inside the fence. A vertex 

outside the fence is not moved. 

• An endpoint of an arc is moved if it is inside the fence. An arc endpoint outside the fence is not 

moved. 

• An ellipse, circle, or cell is moved if it is completely inside the fence. 

DELETE FENCE CONTENTS 

The Delete Fence Contents tool can be used as an inclusive grouping of elements or an exclusive grouping 

with the use of the Inside mode and the Void mode. Elements may also be clipped if overlapping the fence. 

 

DROP FENCE CONTENTS 

Having the same modes for control as Delete Fence, the Drop Fence Contents tool allows the user to drop 

complex status of multiple elements. This breaks up the complex elements contained in a fence (cells, 

complex chains, complex shapes, text nodes, surfaces, and solids) into their components. The elements can 

then be manipulated individually. 
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COPY/MOVE FENCE CONTENTS TO FILE 

The Copy/Move Fence Content to File tool is used to copy or move the contents of the active fence to a 

new DGN or DWG file. 

 

Output File Displays the name of the file to which the fence contents will be copied/moved. 

By default, the file is given a name in the format filename_model. Select a 

different file name by clicking the Define Output File icon ( ). 

Define Output 

File (icon) 

Opens the Save Fence Contents As dialog, which allows for the selection 

of a destination folder and file name to which the contents will be 

copied/moved. 

If an existing file is chosen, its current contents will be deleted. An Alert box 

will warn of this before acceptance of the operation. 

Processing Mode Defines how the fence contents will be processed. 

Copy — Fence contents will be copied to the new file. The original elements 

will remain in the active model. 

Move — Fence contents will be deleted from the active model and moved to 

the new file. 

Fence Mode Determines which elements are included in the fence contents.  

Switch to 

generated file 

If on, after processing the fence, the current file is closed and the Output File 

is opened. 
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SELECT BY ATTRIBUTES 

The Element Selection tool allows the user to select information in the drawing by choosing it on the screen.  These 

tools are used to make most of the selections in a drawing.  There are times, however, when selections may need to 

be made from specified criteria instead of a simple graphic selection.   

The Select By Attributes tool provides additional attribute-based element selection option:  selection by attached 

tag values and by properties.  allows the user to define search criteria and then elements meeting that criteria are 

selected.  This tool also provides the capability to filter the display of elements based on their attributes. 

The Select By Attributes dialog is activated through the MicroStation menu option Edit > Select By Attributes.  

When executed, the entire drawing is searched with the criteria selected.  This proves to be very useful for selecting 

items scattered throughout a drawing. 
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MENU OPTIONS 

The Select By Attributes dialog has two pull-down menus in the upper left, Tools and Settings, which assist 

in controlling and saving the selection set criteria. 

➢ Tools 

 

 

• Set Select By from Element - The Set Select By from Element allows the 

user to set the search criteria to match an element's attributes. 

 

 

  

• Selector Save Sets  - The Select Save Sets allows the 

user to save and retrieve sets of search criteria settings. 

  

 

 

➢ Settings 

 

  

 

 

• Cell - Opens the Select By Cell dialog, which is used to 

specify a criterion based on the name of an unshared cell. 

 

• Shared Cell - Opens the Select By Shared Cell 
dialog, which is used to specify a criterion based on 

the name of a shared cell. 

 

• Text - Opens the Select By Text dialog, which is used to 

specify criteria based on element attributes specific to text 

elements. Text strings are case-sensitive. For example, 

inputting the string “North” would select “North”, but not 

“north”, nor “NORTH”. 

 

• Text Node - Opens the Select By Text Node dialog, 

which is used to specify criteria based on element 

attributes specific to text node elements. Text strings are 

case sensitive. For example, inputting the string “North” 

would select “North”, but not “north”, nor “NORTH”. 
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SETTING OPTIONS 

Levels The Levels Name list box will populate with the levels used within the design file.  These levels can 

be individually selected or by multiple groups. 

• To select a single level, click on the level name. 

• To select many levels at once, click and drag through the level list. 

• To select non-continuous levels, press <Ctl> and click required 

levels. 

• To deselect a level, press <Ctl> and click the highlighted levels. 

Types The Types list box is populated with all recognized MicroStation file types, which can be selected in 

the same manner as Level names. 

Symbology The Symbology section allow the use to specify criteria based on element color, line style (including 

custom line style), and line weight. 

Mode There are three unlabeled button options that control the following: 

• Top Button - Controls which elements are selected, displayed, or located 

when the Execute button is clicked. 

o Inclusive — All elements that match search criteria. 

o Exclusive — All elements that do not match search criteria. 

• Middle Button — Controls how criteria are used when the Execute button 

is clicked. 

o Selection — Elements are selected based on Select By criteria. 

o Location — Filters location of elements based on Select By criteria. Elements 

can then be selected by using the Select All command. 

o Display — Filters display of elements based on Select By criteria. 

• Bottom Button –  

o If set to On (the default), Select By criteria is effective.  

o If set to Off, Select By criteria is ignored. 

Properties The Properties button opens the Select By Properties dialog, which is used to specify criteria based 

on less prominent element attributes, such as area and class. 
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Tags The Tags button opens the Select By Tags dialog, which is used to specify criteria based on tag 

values. If selection criteria based on tag values are specified, elements that do not have attached tags 

with the specified tag name(s) will not be selected, located, or displayed. 

 

Execute The Execute button Selects, Locates, or Displays elements in accordance with the specified search 

criteria and Mode. 

EXITING 

When Select By Attributes is closed by selecting the  icon, an Alert message displays as shown below.  

The actions taken here determine whether or not selected items are still affected. 
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GROUPING ELEMENTS 

No matter what method is used to create a Selection Set, the selection is only temporary.  MicroStation provides 

permanent solutions to select a number of elements and grouped them for manipulation as a single element called a 

Group. A Group is a complex element whose component elements need not be connected.  

A Group is actually an unnamed cell. Unlike named cells, groups are not defined in cell libraries. For this reason 

groups are sometimes called “orphan cells.”  The user creates a Group by selecting the elements and then, from the 

MicroStation menu, selects Edit > Group. 

Permanent groupings include:  levels, complex chains and shapes, groups, graphic groups, and named groups.  

The tools in the Groups toolbox are used to create and manipulate complex chains, complex shapes, and graphic 

groups. The Groups toolbox can be accessed from the Task Dialog under the Main task. 

              

 

Drop Element Break up a complex element(s) or an element(s) of a special type into simpler 

components. 

 

Create Complex 

Chain 

Create a complex chain (open complex element). 

 
Create Complex 

Shape 

Create a complex shape (closed complex element) from individual open elements. 

 

Create Region Create a complex shape from the union, intersection, or difference between closed 

elements or by “flood fill.” 

 
Add to Graphic Group Create a graphic group.  <OR> 

Add elements to an existing graphic group. <OR> 

Combine two or more graphic groups into one graphic group. 

 
Drop from Graphic 

Group 

Remove (drop) an element(s) from a graphic group.  <OR> 

Break up a graphic group into individual elements.  

 
Group Hole Select a solid element and the hole or holes to be associated with the solid. 
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COMPLEX ELEMENTS 

Complex Elements are created when a series of primitive elements (lines, line strings, arcs, or curves) are 

joined together to form a single element. There are many advantages to using complex elements over 

primitive elements.   

For example, if a roadway centerline has been created using lines and arcs, each item would have to be copied 

parallel individually. This would result in many mouse clicks. If the centerline were made into a complex 

chain before being copied, a single parallel copy operation would copy the entire centerline with one mouse 

click. 

A complex object is always created on the Active Level.  The resulting complex chain takes on the active 

element attributes regardless of the attributes of the component elements.A complex object is an element like 

any other, and all of the standard manipulation and modification tools apply. 

Once a series of primitive objects have been converted to a complex object, they may be broken up in to 

single objects again with the Drop Element tool. 

CREATE COMPLEX CHAIN 

A Complex Chain (sometimes called a “complex string”) is a series of connected elements (lines, line strings, 

arcs, curves) in an open shape and grouped for manipulation as a single entity.  The resulting complex chain 

takes on the active element attributes regardless of the attributes of the component elements. 

A Complex Chain can be created from the Group toolbox by selecting the  icon. 

 

Method Sets how elements are added to the complex chain: 

• Manual — Each element is manually selected. 

• Automatic — After the first element is selected and accepted, if endpoints of 

additional open element(s) are within the Max. Gap distance of each other, 

they are included automatically. Where there is a choice of two or more 

elements (at the endpoint of an element) then the process allows for the 

choice to either Accept the highlighted element or Reset to see the 

alternative(s). 

Max(imum) Gap The greatest allowable distance between elements when the Method is Automatic.  

If zero, only elements that connect (have a common endpoint) can be added. 

Simplify geometry If on, connected lines are added as line strings. If selecting only connected lines, the tool 

produces a primitive line string element rather than a complex chain. 

Note When creating a complex chain, if a fork is found where more than one element is within the Max Gap 
distance, the message “FORK – Accept or Reset to See Alternate” displays in the Status Bar. 
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CREATE COMPLEX SHAPE 

A Complex Shape, like a complex chain, is a series of connected elements in a closed shape and grouped for 

manipulation as a single object. The difference between a complex chain and a complex shape is that the first 

and last element in a complex shape are connected, thereby creating a closed shape. 

Although using the Max Gap or the Manual option fills in gaps between elements when creating complex 

elements, it is recommended that elements be joined before creating complex elements. 

A Complex Shape can be created from the Group toolbox by selecting the  icon. 

 

Method Sets how elements are added to complex shape. 

• Manual — Each element is manually selected. 

• Automatic — After the first element is selected and accepted, if endpoints of 

additional open element(s) are within the Max. Gap distance of each other, they are 

included automatically until a closed shape is created. Where there is a choice of 

two or more elements (at the endpoint of an element) then the process allows for the 

choice to either Accept the highlighted element, or Reset to see the alternative(s). 

Max(imum) 

Gap 

The largest distance allowed between consecutive elements, if Method is Automatic.  

If zero, only elements that connect (have a common endpoint) can be added. 

Simplify 

geometry 

If on, connected lines are added to the boundary as line strings. If selecting only connected lines, the 

tool produces a primitive shape element rather than a complex shape. 

Area Sets the type of shape created. 

• Solid — The shape created is solid (can be hatched/patterned). 

• Hole — The shape created is a hole (cannot be hatched/patterned). 

Fill Type • Sets the active Fill Type. 

• None — No fill 

• Opaque — Filled with Active Color 

• Outlined — Filled with Fill Color (outline of shape takes the Active Color) 

Fill Color Complex shape is filled with this color and optional gradient if the Fill Type is Outlined; otherwise 

disabled (dimmed). 

Note I If no element is found within the Max Gap, a line element is created between the open endpoints of the 
first and last elements and the complex shape is closed. 
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CREATE REGION 

The Create Region tool has many options and is a more complex tool than the Create Complex Chain or 

Create Complex Shape.  The concepts behind some of its settings have to be understood before this tool can 

be used. 

 

Using the  icon from the Group toolbox, Regions can be formed from: 

o The union, intersection, or difference between two or more closed elements. 

o A region bounded by elements that have endpoints that are closer together than the Max(imum) Gap. 

Note Create Region also uses a Flood option which is the most common way to create regions and is also the 
easiest to use. 

  Flood 

Region edges bound the area enclosed by elements that either 

touch one another or whose endpoints fall within the maximum 

gap value.   

  Union 
Region edges bound the union of two or more closed, planar 

elements. 

  Intersection 
Region edges bound the intersection of two or more closed, 

planar elements. 

  Difference 
Region edges bound the difference of two or more closed, planar 

elements. 

Fill Type Sets the Active Fill Type. 

None – The complex shape is not filled. 

Opaque – The complex shape is filled with the Active Color. 

Outlined – The complex shape is filled with the Fill Color. 

Fill Color (Fill Type: Opaque or Outlined only) When Fill Type is 

Outlined, Complex shape is filled with this color. When Fill 

Type is Opaque, Fill Color displays the Active Color. When Fill 

Type is set to None, this option is disabled (dimmed). 

Keep Original If on, the original elements remain in the design. 
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Associative  

Region Boundary 

If on, the region boundary retains association with the elements 

used to create it. If an original element is modified, then the 

boundary element updates to reflect the modification. 
F
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  Ignore Interior 

Shapes 

If selected, interior shapes are ignored when the region boundary 

is calculated. 

  Locate Interior 

Shapes 

If selected, closed elements inside the selected area are included 

as part of the new complex shape. 

  Identify Alternating 

Interior Shapes 

If selected, alternating areas are flooded where shapes are nested 

inside one another. 

  Locate Interior Text  
If toggled on, any text or dimension text inside or overlapping 

the selected area is avoided. 

  Dynamic Area 

Locate  

If toggled on, the area to be included in the region displays 

dynamically as the user moves the cursor over the view. 

Max Gap Sets the largest distance allowed between consecutive elements.  

If set to zero, only elements that connect can be added. 

Text Margin Sets the margin to be left around any text or dimensional text 

included in the selected area. 
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DROP ELEMENT 

The Drop Element tool  facilitates dropping and reverting a complex element back to its original 

primitive elements. It is useful when a complex element is no longer desired or cells and other elements need 

to be broken. 

Only the selected elements of the specified type(s) in the Tool settings dialog are dropped.  The tool has no 

effect on selected elements of other types.  If none of the selected elements is of the specified type(s), the 

message “Nothing to drop” displays in the status bar. 

 

Complex If on, complex elements (cell, complex chain, complex shape, text node, surface, or solid) are 

dropped into their components. 

Dimensions If on, dimension element(s) are dropped into lines, line strings, ellipses, arcs, and text. 

• To Geometry — Drops down lines, line strings, ellipses, arcs, and text. 

• To Segment — Drops down individual dimension segments. 

Line 

Strings/Shapes 

If on, line strings and shapes are converted to series of individual line elements. 

Multi-lines If on, multi-line elements are converted to sets of line strings, lines, and/or arcs. 

Shared Cells If on, the associated option menu allows for the dropping of  shared cells: 

• To Geometry — shared cells are dropped into their components. 

• To Normal Cell — shared cells are converted to unshared cells. 

Solids (3D only) If on, the associated option menu allows for the dropping of SmartSurfaces or 

SmartSolids: 

• To Surfaces — SmartSurfaces or SmartSolids are dropped to simple surfaces. 

• To Wireframe — SmartSurfaces or SmartSolids are dropped to wireframe 

elements. 

Text If on, text characters in text elements are converted to the individual elements that are used to 

draw the characters — lines, line strings, arcs, ellipses, and shapes. 

Application 

Elements 

If on, used to drop light weight geometry. 

Note Drop Element cannot be used to drop elements more than one level at a time.  For example, if Complex 
and Line Strings/Shapes are enabled and complex shape is selected that contains two line strings, the 
complex shape is dropped but the component line strings are not.  That is, the operation results in two line 
strings. 
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Exercise 9.1  Complex Elements 

➢ Drop Complex Element 

1. Open the MicroStation file c:\e\projects\12345678901\utils\utexrd01.dgn. 

2. Zoom into the cable TV line east of Station 232+00 and select, as shown highlighted below. 

Tip   The MicroStation menu option: Edit > Find/Replace Text can be used to find the station just by entering 232 

in the Find field and then click the Find button. 

  

3. Leave the Active Element Attributes as they are. 

4. From the Main Task, select the Drop Element tool from the Groups toolbox. 

5.  

 

Tip   If needed, remember to follow the reminder messages in the Status Bar located in the lower left side of the 

application window. 
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6. Set the Drop Element Tool Settings as shown. 

 

 

 

 

 

 

 

 

 

7. Place a data point anywhere on the cable TV line as shown below. 

  

8. Move the cursor over the cable TV line and notice that it is now comprised of individual lines and arcs. 
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➢ To Manually Create a Complex Chain 

1. Continuing in the same file and location from the previous exercise, set the Active Level to 

CATVBurB_ep from the Attributes toolbox at the top of the application window.  

Note  Remember: when a Complex Chain is created, it automatically sets to the Active Element Attribute settings 
regardless of the individual settings of each element selected. 

 

2. From the Main task, select the Create Complex Chain tool from the Groups toolbox. 

 

3. Match the Create Complex Chain Tool Settings as shown.  
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4. Place a data point on each cable TV line elements to select and include in the complex chain, as shown 

highlighted below.   

Tip   In a complex chain, all elements must be connected. If they are not already connected, the elements are 

connected as they are selected. 

  

5. When all cable TV line segments are selected, place a data point outside the selection set and then click 

Reset (right click) on the mouse to complete the complex chain.  

6. Using the Element Selection tool, select an element from the Complex Chain created.  Notice now that 

the complex element can be manipulated as a whole instead of individual elements. 

7. Close the Create Complex Chain Tool Settings and, if open, close the Groups toolbox. 
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➢ To Manually Create a Complex Shape 

The goal is to create a driveway shape similar to the example displayed. 

 

1. Open the MicroStation file c:\e\projects\12345678901\roadway\dsgnrd01.dgn. 

2. Zoom in the driveway locations near Stations 286+00 – 287+00. 

Tip   The MicroStation menu option:          

Edit > Find/Replace Text can be used 

to find the station just by entering 286 

in the Find field and then click the Find 

button. 

 

 

 

 

 

 

3. To improve the accuracy of selection, turn off surrounding levels that make it difficult to access the 

driveway elements. 

Note This is for display purpose only and in no way effects the elements within the design file. 

Right-click on any element and select “Turn Level Off By Element” in the pop-up context menu. 
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4. From the Attributes toolbox located at the top of the application window, set the Active Level to 

Driveway. 

 

5. Select the Create Complex Shape tool from the Groups toolbox. 

  

6. From the Create Complex Shape Tool Settings, set options as shown. 

  

7. Select each of the Driveway elements shown below, that make up the boundary of the shape to be 

created. 

Tip   Select Driveway elements in succession to achieve the shape required. The Complex Shape tool will 

automatically connect as they are selected. These connections appear as “lines” that connect the endpoints of 

the elements. They are part of the complex chain but are not elements. They disappear when complex status is 

dropped. It is recommended that elements be connected before being included in a complex chain. 
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8. When all selected elements are highlighted as shown below, place a data point outside the selection set. 

 

9. Reset (right click) on the mouse to complete the complex shape.  The shape will automatically fill. 

 

10. Perform the same steps on a few of the other driveways. 

11. Exit MicroStation. 
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GRAPHIC GROUPS 

A Graphic Group is a quick method for grouping elements in MicroStation.  A design file can contain an 

unlimited number of graphic groups. The groups only exist within their host design file and cannot be 

exported to other design files.  An element can be a member of only one graphic group at a time. The Groups 

toolbox has tools for creating a graphic group and adding and removing elements to or from a graphic group. 

Without “breaking up” the grouping, individual member elements can be added, removed or manipulated. 

Whether certain actions change the whole Graphic Group or only part of it depends upon whether Graphic 

Group Lock is turned “on”, all elements in the graphic group are manipulated, or “off”, only the selected 

element is manipulated. 

An element can be added to a Graphic from the Group toolbox by selecting the  icon. 

 

Named Group (Existing named groups present in model only) If on, selection can be made 

from the drop-down list of existing named groups present in the model. 

Create New Named Group icon Opens the Create Named Group dialog, which allows for the  creation of  a 

new named group. 

Open Named Group Dialog icon Opens the Named Groups dialog, which allows for the creation and 

modification of  Named Groups and their hierarchies. 

 

Member Type Defines the way that other members of a named group are affected when a 

member of the named group is manipulated or selected.  

An element can be added to a Graphic from the Group toolbox by selecting the  icon. 

 

Drop From Named Groups If on, drops elements from named groups. If off, elements can be dropped from 

graphic groups only. 
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NAMED GROUPS 

For greater flexibility still, Named Groups can be created, which allow a name to be given to each grouping 

of elements.  Named groups can include elements from the active file and those from directly attached 

references. 

A new Named Group can be created from the Groups toolbox using the Add to Graphic Group tool <OR> 

from the MicroStation menu option Utilities > Named Groups. 

           

 

New Named Group Creates a named group in the dialog.  The new group has a default name 

that the user may change. 

 

Show Named 

Group 

Displays the Element Properties for all elements in the selected graphic 

group. 

 

Add Elements Allows the user to add elements to the selected graphic group. 

 

Remove Elements Allows the user to remove elements from the selected graphic. 

 

Add Named Group 

to Parent 

Forces the selected graphic group to become a child of another graphic 

group. 

 

Remove Group 

from Parent 

Removes the graphic group from being a child of another graphic 

group. 

 

Delete Group Delete the graphic group name from the Named Groups dialog.  This 

does not delete the elements in the graphic group. 

 

Select Elements in 

Named Group 

Selects all elements in the graphic group. 

 

Put Elements into 

Display Set 

Sets the contents of the selected graphic group as the Display Set. 

 

Show Hierarchy Shows the hierarchy window. 
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GROUP HOLES 

The Group Holes tool is used to select a solid element and the hole elements to be associated with the solid.  

The solid and its associated hole(s) can be shapes, ellipses, and/or complex shapes that are in the same plane. 

Holes are not patterned and appear “transparent” in rendered views. 

• A Group Hole can be created from the Group toolbox by selecting the  icon. 

ASSOCIATE ELEMENTS 

Under most circumstances elements are static, and when an element is placed in a design, its position is 

defined simply by the design plane coordinates on which it lies. It retains that position in the design plane 

until moved with an element manipulation tool. 

One exception to this rule is association, in which an element's position in the design plane is defined in 

relation to another element. When that other element is moved, the associated element moves with it. For 

example, dimension elements can be associated with the elements whose dimensions they display. These 

dimensions update when the dimensions of the elements, with which they are associated, change. 

The types of elements that can be associated with other elements are dimensions, multi-lines, normal cells, 

shared cells, and tags. The association is made when the dimension, multi-line, cell, or tag is placed. 

 

Exercise 9.2  Creating Groups 

➢ To Create a (UnNamed) Group 

1. Open MicroStation file: c:\e\projects\12345678901\utils\utexrd01.dgn. 

2. Use the MicroStation menu option: Edit > Find/Replace Text to move to the intersection at Station 

257+00 by entering 257 into the Find field and then clicking the Find button. Close Find/Replace text 
dialog. 
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3. From the Main task, select the Element Selection tool and open the Level tab. Scroll down to select the 

Level TeleBur_ep and notice that all elements on this level are highlighted. 

 

4. From the MicroStation menu, select Edit > Group.  

5. Hover the cursor over one of the elements from the selection set and notice that all elements in the group 

highlight at the same time.   

6. Select one of the elements of the group and drag to the right.  The group will move as one element. 

7. From the MicroStation menu, select Edit > Undo Drag Selection to set the group back to previous 

position. 

 

➢ To Break Up a Group 

1. Select the newly created Group from the previous exercise. 

2. From the MicroStation menu, select Edit > Ungroup. 

3. Move the cursor over the elements and notice they are no longer working as one element. 

 

  



Chapter 9 _________________________________________________________ SELECTING & GROUPING - Grouping Elements  

9-32 © 2018 FDOT FDOT Bentley CADD Essentials  

➢ To Create  a Named Group with the Add to Graphic Group tool 

1. Continuing with the MicroStation file: c:\e\Projects\12345678901\utils\utexrd01.dgn. 

2. Leave the Active Element Attributes as set. 

3. From the Group toolbox and select the Add to Graphic Group tool. 

 

4. From Add to Graphic Group Tool Settings, click the Create New Named Group  icon and key in 

Underground for the new Name. 

(Optional) Key in a Description for the new Named Group. 

(Optional) Select the check box to Select all members when any member selected.  This turns on Selectable for the 

Named Group. 

 

5. Click OK. The Add to Graphic Group Tool Settings populates with the newly created Named Group. 

 

6. Close Add to Graphic Group Tool Settings and the Groups toolbox. 
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➢ To Create a Named Group with the Named Groups dialog 

1. Continuing with the MicroStation file: c:\e\Projects\12345678901\utils\utexrd01.dgn. 

2. From the Primary Tool toolbox located at the top of the application window, select the Key-in tool. 

 

3. Key-in REFERENCE DISPLAY OFF ALL and press <Enter> to accept. Close the Key-in dialog. 
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4. Select the elements to be grouped:  from the Main task, open the Element 

Selection tool and extend to the Level tab. Select Level CATV_ep. All 

elements on this level automatically highlight.  

   

Note Notice that the OTV line left of the intersection is highlighted.  Also notice 
in the lower right on the Status Bar an arrow head appears with the number 
9, indicating elements were selected. 

 

 

 

 

 

5. Make NO changes to the Active Element 

Attributes. 

6. From the MicroStation menu bar, select 

Utilities > Named Groups.  The Named 

Groups dialog opens. Note the previously 

created Named Group Underground is 

displayed. 

  

 

 

7. From the Named Groups dialog, select the 

New Named Group  icon.  A new entry 

is inserted in the list box, with a default name 

highlighted ready to edit. 

  

 

 

 

8. Key in Television to replace the default name 

and press <Enter> to accept. 
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9. Select the Add Elements  icon.  The Add to Graphic Group tool is activated, with Named Group 

turned on, the new named group selected, and Member Type set to Active. 

  

Note MicroStation message in the lower left status bar:    

 

10. Using the Element Selection tool, accept the selection set by placing a data point on the highlighted OTV 

line left of the intersection. Notice the Named Groups dialog updates Television with 9 elements 

matching the count indicated in the Status Bar. 

 

11. Repeat steps 8 and 9 to create the new Named Groups as shown below and leave open. 

  

12. Minimize the extended portion of the Element Selection tool settings. 

13. Exit MicroStation 
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10 DRAWING ANNOTATION 

OBJECTIVES 

This chapter covers MicroStation annotation and placing text in design files. Special focus is given to: 

• Placing Text 

• Using Data Fields 

• Find and Replace Text 

• FDOT Menu – Text Options 

INTRODUCTION 

To this point, all tools covered placed, manipulated or modified geometry in a design file.  Although most of a 

drawing consists of elements such as lines, arcs and circles; that alone does not fully describe the drawing. The text 

tools provide the missing link by placing non-geometric information in the drawing in the form of descriptive text. 

PLACING TEXT 

Text elements are useful for including labels other than dimensions in a model.  As an element type, text differs in 

several ways from other types of elements. The following attributes apply exclusively to text and text node elements: 

✓ Fonts  Text is placed in the Active Font. 

✓ Justification  Text is aligned in a specific way with respect to the data point that 

positions its origin. 

✓ Text size Text characters have height and width. However, when creating a sheet model for 

drawing production, if Annotation Scale Lock is on (Settings > Locks > Annotation Scale), 

text is automatically scaled by the Annotation Scale factor, which is set in the Model 
Properties dialog. 

The maximum number of characters in a single-line text element is 65,535.  Text that exceeds the Active Line 

Length, such that it is more than one line long, is automatically converted to a Text Node. Text Nodes have a line 

spacing attribute, which is the space between each line of text. Text Nodes have numbers and cross hair symbols 

that mark their position in the design. 

The attributes of text can be controlled by a Text Style. For example, a Text Style can be used to control the font, 

justification and size of text in models.  

Fonts MicroStation provides support for three types of fonts:  True Type, RSC (MicroStation Resource Font), 

and SHX (AutoCAD Fonts).  MicroStation will read multiple font resource files according to the paths set by the 

MS_FONTPATH configuration variable in the selected workspace, and True Types Fonts registered with the 

Windows operating system. Within a MicroStation design file, font resources are compiled into a list of fonts from 

all the resource files that are found. 

FDOT CADD Software delivers a customized set of True Type Font .ttf files to ensure text uniformity between 

applications supporting TTF fonts and legibility of FDOT CADD drawings.  A single True Type Font file may 

contain thousands of characters.  

The FDOT TTF files contain special character used by designers not normally found in standard publishing fonts.  

These special characters can be accessed from the Text Editor – Word Processor as described later in the chapter. 
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TEXT  

The tools in the Text – Task are used to place text, modify existing text elements, and fill in enter data fields.  

The Text - Task  is accessed and can be opened into a separate floating Text - Task toolbox through the 

Drawing task bar. 

             

 

The Text Toolbox, an extended version of the Text Classic Toolbox, can be access from the MicroStation 

menu option Tool > Toolboxes and is one of the largest toolboxes available in MicroStation. It contains the 

most commonly used tools for creating and editing text as in the Text Classic Toolbox with the inclusion of 

the Tags Toolbox.  
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Place Text Places text in the design file or fills in empty text 

nodes. 

 

Place Note Places a note. 

 

Edit Text Edits a text or text node element to add, replace or 

delete characters. 

 

Spell Checker Reviews text or text node elements for spelling 

errors. This tool can be used for individual elements 

or elements defined with a Fence.  

 

Change Case Change the case of text or text node elements. 

 

Display Text 

Attributes 
Displays the attributes of a text or text node 

element. 

 

Match Text 

Attributes 
Sets the active text settings the same as the 

attributes of an existing text element. 

 

Change Text 

Attributes 
Changes selected text-specific element attributes of 

text or tag elements. This tool can be used for 

individual elements or elements defined with a 

Fence. 

 

Place Text Node Places empty text nodes so that text may be placed at later 

time. 

 

Copy/Increment 

Text 
Copies and increments a text element containing 

numbers. 

 

Copy Enter 

Data Field 
Copies the contents of one data field to another. 

 

Copy/Increment 

Enter Data 

Fields 

Copies and increments the contents of a enter data 

field that contains numbers into another enter data 

field.  

 

Fill In Single 

Enter-Data 

Fields 

Fills in or changes an enter data field. 

 

Auto Fill In 

Enter Data 

Fields 

Fills in all enter data fields in a view. 
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Update All 

Fields 

Update all fields in text in the active model. 

 

Drop Text Convert the text characters in a text element to the individual 

elements that are used to draw the characters. 

 

TEXT SETTINGS 

The Place Text tool settings box appears when a text placement tool is activated. It contains most of the 

basic settings for text placement.  The text attributes Height, Width, Font, Line Spacing and Inter-character 

Spacing can be set here or are automatically set by applying a Text Style. A discussion of the text placement 

attributes follows. 
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➢ Method 

 

Sets how the position, scaling, and rotation of text are determined. 

By Origin Dynamically places text with a data point at the Active Angle and the active text 

settings. The active text settings are set in the Text Styles dialog (Element > 

Text Styles). The most commonly changed active text settings are also tool 

settings for Place Text. 

o Fitted  Dynamically places a single line of text to fit between two data points. The 

vertical alignment of the text is determined by the active Justification.  

o View Independent Similar to the By Origin method, except the text does not rotate with a view 

rotation. Once placed, text stays at the same orientation regardless of the view 

rotation. 

o Fitted VI (View 

Independent) 

Combines Fitted and View Independent Views.  

o Above Element  Places text above a line element or segment of a line string, shape, or multi-line 

at the active text settings at the same angle as the line segment at a distance equal 

to the Active Line Spacing.  

o Below Element  Places text below a line segment or segment of a line string, shape, or multi-line 

at the active text settings at the same angle as the line segment at a distance equal 

to the Active Line Spacing.  

o On Element  Places text on a line or segment of a line string, shape, B-spline curve, or multi-

line at the active text settings.  

o Along Element  Places text above or below an element (curve, B-spline curve, arc, ellipse, line, 

line string, or shape). Each character is placed as a single text element that is a 

component of a graphic group.  The characters are placed at the active text 

settings at a distance equal to the Active Line Spacing.  

o Word Wrap  Allows containment of text within a box, once a box is identified. If a word is 

entered that exceeds the limit of the box, that word drops to the next line. 

(Available only if Word Processor is selected in the Preferences dialog > Text 

category > Text Editor Style option menu.) 
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➢ Text Styles 

 

Sets the Active Text Style from a dropdown list of available Text Styles defining groups of text attributes, 

such as font, width, height and color.  Text Styles enable text to be placed in a model in a consistent and 

automated manner.  FDOT provides Text Styles which are loaded with the FDOT workspace and should be 

used to produce FDOT drawings.   

The Text Styles dialog contains a list of all the text styles that exist in the design file, and the settings for 

each text style.  When a design file is opened in the FDOT Workspace, all the Text Styles are automatically 

loaded.  No changes should be made to the settings in the Text Styles dialog. 

To create a new Text Style, click the magnifying glass icon (  ) next to the Text Style option on the 

Place Text tool settings to open the Text Styles dialog or select the MicroStation menu option Element > 

Text Styles. 

 

➢ Active Angle 

 

Affects many tools as it specifies the angle, in degrees at which elements are placed in the design file, when 

Method is By Origin or View Independent.  Text placed in a drawing is aligned with this active angle.  This 

allows text placement at any angle.  When the value of the Active Angle is set to 0, text appears horizontal 

across the screen.  
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➢ Text Height and Width 

 

The Text Height and Width determines the overall size of the text in working units.  The big question is 

“what should these values be?” For most users, these values are dictated by client or company standards.   

➢ The Annotation Scale Lock icon  

The Annotation Scale Lock icon sets the Annotation Scale Lock. When this lock is on, the annotation scale 

is applied to any text that is placed in the model.  The annotation scale is set in the Model Properties dialog. 

It defines the scale for text and dimensioning in the model. 

➢ Apply Changes to All Text 

 

If on, style changes are applied to all text in the Text Editor window. For example, if text is keyed in the Text 

Editor, then click the Bold icon, all text becomes bold. 

If off, style changes are applied to selected text in the Text Editor window, or to new text. For example, if 

text is keyed in the Text Editor, then click the Bold icon, only selected text becomes bold. Any new text will 

also be bold. 

➢ Font 

Font is a set of alphanumeric characters that have a similar style.  Available fonts include:  

MicroStation Standard Fonts; SHX fonts; True Type fonts  

Fonts are stored in external files and are only referenced by MicroStation for display information.  This helps 

keep design files a reasonable file size.  

➢ Justification 

A data point is used to place text in a design file.  Consider 

the data point to be the origin, or insertion point, of the text.  The text displays around this point based on the 

Justification settings:  Left Top, Left Center, Left Bottom, Left Margin Top, Left Margin Center, Left 

Margin Bottom, Center Top, Center Center, Center Bottom, Right Margin Top, Right Margin Center, Right 

Margin Bottom, Right Top, Right Center or Right Bottom. 
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➢ Line Spacing 

MicroStation text placement tools allow placement of multi-line 

text at a data point, referred to as a Text Node, and can also place text above and below elements.  Line 

Spacing becomes important when using these methods and the value set determines:  

o The distance between lines in multi-line text.  

o The distance text goes above or below an element when using these placement 

methods.  

o The distance text goes above or below an element when placing text along an element.  

 When requirements do not establish a value for this attribute, set the line spacing equal to one 
half the text height. This produces a look of single line spacing.  

➢ Inter-character Spacing 

All characters have an inherent spacing to provide a gap 

between them.   This setting can increase or decrease in this distance to create special effects. Most users do 

not adjust this value very often, but the ability to make the adjustment may become valuable when placing 

text along elements.  

➢ Text Node Lock 

When the Text Node Lock is on, the setting forces subsequently entered 

text to be attached to empty text nodes. If an empty node is not available, no text is placed. 

FREQUENTLY USED TEXT ATTRIBUTES  

All the attribute settings discussed effect text placement in some way.  The following figure defines many of 

the frequently used text attributes previously described. 
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TEXT EDITOR – WORD PROCESSOR 

The Text Editor – Word Processor dialog opens when the Place Text, Place Note, Geometric Tolerance, 

and Edit Text tools are activated. This dialog also opens when a text element is selected along with the Edit 

Text tool or a text element is double-clicked upon with the Element Selection tool pointer. This dialog is used 

to compose and format single line or paragraph text before it is placed on the drawing.  

 

• Icon Bar 

Controls that modify the text formatting in the editor to set the active font or affect the appearance of text 

with options for:   

 Bolding    Italicizing   Underlining the Text  

 Spell Checker    Stacked Fraction Setting the Color  

 Adding Symbols    Superscripting   Subscripting 

 Favorite Symbols (Dropdown Arrow) 

• Tab Ruler 

Defines tab stops in text and allows placement of text with tabs, first line and paragraph indents.  Right-

clicking on the Tab Ruler allows for saving, retrieving and deleting an indent or tab scheme.  
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• Editing Box 

An Editing box is where text editing takes place.  Right-clicking on the Editing Box allows for the following 

functions, which also shows the supported common keyboard shortcuts. 

Item Shortcut Action 

Cut <ctrl-X> Cuts the selected text. 

Copy <ctrl-C> Copies the selected text. 

Paste <ctrl-V> Pastes the text on the Clipboard to the location of the insertion point 

in the editor. 

Delete <Del> Deletes the selected text. 

Select All <ctrl-A> Selects all text. 

Clear n/a Clears the selected text. 

Find <ctrl-F> Opens the Find dialog. 

Change Case n/a Upper Case — converts text to all upper case. 

Lower Case — converts text to all lower case. 

Insert Enter 

Data Field 

n/a Opens the Edit Enter Data Field dialog for creating an enter data 

field when in either placement or edit mode. 

Insert Field n/a Element Properties — prompts to identify the element whose property 

to insert in a field. Once identified, the Fields Editor dialog opens. 

Model Properties — opens the Fields Editor dialog for inserting a 

property of the active model in a field. 

File Properties — opens the Fields Editor dialog for inserting a 

property of the open DGN file in a field. 
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USING ENTER DATA FIELDS 

As text is placed or edited, Enter Data Fields can be inserted, 

whose content is a one-or-more-character placeholder for 

future input by users.  Enter Data Field is created in the word 

processor Text Editor window by typing the enter data field 

character “_” once for each character in the enter data field.   

Enter Data Field underscore symbols are controlled by the 

View Attributes dialog by toggling on or off the Data Fields 

option. Enter Data Fields are particularly useful for variable text such as part numbers or detail numbers. 

  

The word processor Text Editor window is the 

only style of text editor in which text elements can be inserted, with the Place Text tool, or edit an existing text 

element, with the Edit Text tool.  To ensure this type of text editor is always available, select the MicroStation menu 

option: Workspace > Preferences.  Under the Text category, set the Text Editor Style to Word Processor.  

Note The View Attributes option Data Field must be selected for the Enter Data Field to display. 

USING FIELDS 

As text is placed you can insert Fields whose content is derived from object properties. Properties of the following 

types of objects can be used as sources for field content: 

✓ elements 

✓ models 

✓ files 

For example, you can place text contains a Field that refers to the area of a shape or the length of a line. If that shape 

or line is modified the Field would show the new value. 

A field can appear anywhere within a piece of text and can span multiple words or lines within multiple-line text. 

In addition to inserting fields in text, you can also insert placeholder fields in a cell or cell model. A placeholder 

field is a field that is waiting for a target. When the target is provided, it can re-evaluate and display its property 

value. In the absence of the target, the field simply displays its field name. The target may be provided by means of 

a link.  

For example, you might create a monument cell that contains a Place Holder Cell Properties field (origin). In the 

cell model the field displays the field name origin. When the cell is placed in another model and the fields are 

updated, the field displays the origin of the cell. 

  

Place holder field in the cell model (left). Place holder field in the target model (right). 

Placeholder fields are primarily of three types. 

✓ Fields pointing to the properties of a parent cell 

✓ Fields pointing to the properties of a parent Digital Signature cell 

✓ Fields pointing to the properties of a link target attached to a parent cell 
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FIND AND REPLACE TEXT 

MicroStation contains a find and replace utility that can search all the text in a design file for any sequence of letters 

and numbers and replace some or all instances of the text with other text or append text while retaining an original 

string.  The Find Text function works in the active model and all references, while the Replace function works only 

in the active model. The Find/Replace Text functionality supports dimensions, tags, text, text nodes, notes and 

symbols. 

When using the Find/Replace Text functionality with Enter Data Fields, text can be replaced within a single Enter 

Data Field.  However, text that spans multiple Enter Data Fields or text that is partially inside and outside an Enter 

Data Field cannot be replaced. 

The Find/Replace Text tool is activated by selecting the MicroStation menu option Edit > Find/Replace Text.  

The search options are described below: 

 

• Find - Specify the search string to be located. It searches for an exact match but is not case-sensitive, 

unless overridden by the selection of other options on the dialog. The search runs left to right, top to 

bottom across the screen, beginning in the top left corner. If there is a cluster of text in one section of the 

design and the find is started inside that cluster, the search is completed in that cluster before moving on 

to the rest of the design. 

• > - Only available when Use Regular Expressions is on, provides a list of the escape sequences that 

are supported. 

• Replace - Specify the replacement string that replaces the search string in the Find field. This field is 

case-sensitive and replaces the string exactly as entered. 

• Find Options 

o Match Case If on, performs a case-sensitive search of search string; that is, finds only 

text with the same capitalization as the text in the Find field. 

o Whole Words If on, specifies a search for only complete words that match the text 

element in the Find field. For example, when Whole Words is on, a search 

for “fill” will not find “filled” or “fillet.” Each instance of the search string 

must be surrounded by a blank space on each side. 

o Use Regular 

Expressions 

Consist of patterns that can be used to search for variable forms of text.  If 

on, treats the search string as a regular expression for special characters 

and advanced search patterns. 

✓ Common Expressions for all operations: 
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Character Meaning 

^ beginning of line 

$ end of line 

. any single character 

:a any alphabetical character [a-z;|A-Z] 

:d any digit [0-9] 

:n any alphanumeric character [a-z|A-Z|0-9] 

✓ Regular Expressions for searching text: 

Character Meaning 

[ ] 
Characters within these brackets describe a character class, or a custom 

wildcard. 

* The preceding character (or character class) is allowed to repeat zero. 

+ The preceding character (or character class) must repeat at least once. 

- When used within a character class, represents a character range. 

✓ Regular Expressions for selecting multiple items: 

Character Meaning 

c any non-special character c matches itself 

\c turn off special meaning of character c 

[…] any one of the characters in …; ranges such as a-z are legal 

[^…] any single character not in …; ranges are legal 

s* zero or more occurrences of string s (the preceding character). 

s+ one or more occurrences of string s (the preceding character). 

st string s followed by string t 

o In Cells If on, specifies a search for text in cells, as well as standalone text. 

o Use Fence If on, specifies a search for text in a fence. The option menu sets the Fence 

(Selection) Mode. 
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• View Options 

o Animate If on, shows the transition from the current view to the destination. There is an automatic 

panning and zooming to the text so that it can be seen in context. 

o Rotate If on, shows the transition from the current view to the destination. There is an automatic 

panning and zooming to the text so that it can be seen in context. 

o Zoom If on, view zooms to the specified text (and activates the slider). When the slider is set to 

the right end (smaller zoom factor), the result is greater zooming (text appears larger). 

• Find – Locate the next instance of the text. 

• Replace – Replace the found text in the currently highlighted element with the replacement 

string. 

• Replace All – Replace all the specified text elements in the design file. 

• Pick – Launch a tool that allows individual elements to be picked and to do the replace operation 

immediately upon picking. 

FDOT MENU – TEXT OPTIONS 

FDOT CADD software delivery includes a customized FDOT Menu with many Text related options which are 

located under each Discipline menu option.  The specific options vary according to the needs of the particular 

Discipline.  The following are highlights to those common in most. 

TOOL BOXES 

Each Discipline under the FDOT Menus may offer one or more of these options that contain Text tools. 

• FDOT Text 

    

o   Label Line 
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o   Text Editor 

  

o   Place Std Notes 

  

o   Import Summaries from Excel 

  

o   Add Columns of Numbers  
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o   Measures an Area and Labels  

  

Measure Area,    Place Area with Text, 

Calculate Area,    Parameter Settings. 

o   Scale Text  

o   Shows a Text File  

 

• Signal Text and Lighting Text 
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  Sets the Text Scale for Plot Scale   Places a Bid Item Box / Bid Item Number    

  Elevation and Pole Text     Station Text 

   Elevation Text  
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Exercise 10.1  Placing Text 

➢ Selecting the Text Settings 

1. From the FDOT Desktop folder, open c:\e\projects\12345678901\roadway\textrd01.dgn.   
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2. From the View Attributes arrow dropdown menu located on the View Controls tool bar, select the Saved 

Views: Using Text Tools.  

     

3. The Using Text Tools saved view displays as shown below.  
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4. Select the Main Classic task bar to put the focus at Home , and type “G 1” to open the 

Place Text tool.  The Text Editor appears along with the Place Text tool settings to enter text for 

placement, editing and spell checking. 

 

5. - OR – Select and hold the Text Classic task icon from the Main Classic Task, select Open ‘Text 

Classic’ as Toolbox from the dropdown menu to open a separate toolbox, and then select the Place 
Text tool.  
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6. - OR - From the Task Navigation dropdown tool, Select Task > Main Classic > Text Classic, and 

then type “Q”. 

Note To return back to the Tasks tab, double-click on the Tasks option from the Task Navigation dropdown. 
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7. From the Place Text took settings, set all settings to match the figure above.  

 The Height and Width lock  may need to be selected to unlock . 

8. If the tool settings are not expanded, click the downward arrow in the lower right corner. 

    

9. Open the Font option list by clicking the arrow next to the displayed font name and select FDOT Bold 

from the list of fonts. 
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10. Click on the arrow next to the Justification display and select Left Top from the dropdown options. 

      

11.  Set Line Spacing, Interchar Spacing and Text Node Lock as shown below. 

    

 

➢ Placing the Text 

1. Click inside of the Text Editor – Word Processor dialog to give it the focus.  A flashing cursor displays 

inside the editor when it has focus. 

2. Type “State of Florida”, press [Enter] to start the second line of text, and then type “Department of 

Transportation”.  
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3. Move the pointer away from the Text Editor – Word Processor dialog, and notice the entered text 

string is attached to the pointer.  

 

 

4. Place the text in the center of the MicroStation Block displayed within the Using Text Tools saved view 

using the assistance of the following Lock Mode: 

5. Move cursor to the MicroStation status bar, click the Lock Mode icon and 

change the lock to Center.  Note that the text remains attached to the cursor 

during this action. 

 

 

 

 

 

 

 

 

6. Move the cursor over the border of the Block displayed in the Using Text Tools 

saved view.  The text attached to the cursor automatically jumps to the center. 

 

7. Enter a Data Point to place the text and then click Reset to cancel further text placement. 

8. Close Text Editor and Place Text Tool Settings. 
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Exercise 10.2  Change Line Spacing 

1. Using the same textrd01.dgn design file and Saved View, Using Text Tools, select the Change Text 

Attributes tool from the Text Classic task or toolbox.  

  

2. The Change Text Attributes tool settings appears.  If the tool settings are not expanded, click the 

downward arrow in the lower right corner. 

   

 This tool is used to change one or more text attributes. A check mark denotes which attributes 
change.    

3. Disable all by un-checking the attribute boxes. 

4. Enable the Line Spacing attribute and enter 1 into the Line Spacing field as shown below.  

    

5. The MicroStation Status Bar prompts the user to identify the element to be changed. 
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6. Select the “State of Florida Department of Transportation” text string placed previously.  

 

Note The spacing between the text lines is now 1 and the text node reflects the new line spacing.  

➢ Changing the Inter-character Spacing 

1. In the Change Text Attributes tool settings window, disable Line Spacing. 

2. Enable the Inter-character Spacing attribute and set the value to .25.  The Status Bar prompts the user 

to Identify element to be changed.  

3. Select the same text string to edit, and then reset. The text node reflects the new Inter-character Spacing 

and Font. 

 

4. Set the Inter-character Spacing value back to 0. 

5. Select the same text string to edit, and then reset. The text node restores to the previous Inter-character 

Spacing. 

6. Close the Change Text Attributes dialog. 

➢ Find and Replace Text  

A previous conversion of font within this design file has caused a conflict with the Baseline symbol. The 

Find/Replace text tool is used in this exercise to correct this issue. 

1. Select the MicroStation menu option: Edit > Find/Replace Text.  Find/Replace text dialog displays. 
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2. Select the View Options, Fit View , and then Zoom into the second group of text from the left on 

the design plane. 

 

3. From the Find/Replace text dialog, enter the symbol “}” in the Find field. 

4. From the Find/Replace text dialog, enter the symbol “ ” in the Replace field.  This symbol can be 

found from the Text Editor using the following steps: 

5. Select the Place Text tool  to open the Text Editor – Word Processor dialog, and then select the 

Favorite Symbol named BaseLine using the Insert Symbol (dropdown arrow). 

 

6. Copy the BaseLine symbol by highlighting then right-clicking on it, and then selecting Copy from the 

popup menu. 
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7. From the Find/Replace text dialog, paste into the Replace field, by right-clicking in the field, and then 

select Paste from the popup menu.  Reset to release symbol. 

 Symbol pasted will display differently. 

 

8. From the Find/Replace text dialog, under Find Options, select the In Cells check box. Under View 

Options, select the Animate and Zoom check boxes. 

 

9. Click Find and the tool will automatically move to each symbol found, at which time select Replace to 

make each correction.  The Find/Replace text tool will automatically move to each occurrence until 

all are addressed. 

 Selecting Replace All is NOT recommended as there may be legitimate occurrences for this 
symbol. 

10. Close Find/Replace text dialog. 
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Exercise 10.3  Using Data Fields 

➢ Place Data Fields 

1. Using the same textrd01.dgn design file, from View 

Attributes ensure that the Data Fields option is 

highlighted (activated) and re-select the Saved 

View, Using Text Tools. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Close the View Attributes dialog. 

3. From the Main Classic Task under the Text task or toolbox, select the Place Text tool. 

 

4. Enter the settings as shown in the Place Text tool settings.  
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5. In the Text Editor – Word Processor, type “Project No.”<space> , right click and then select Insert 

Enter Data Field.   

 

6. From the Edit Enter Data Field dialog, enter settings as shown below and select OK.  The Text Editor 
– Word Processor displays with a data field with three scores. 

 

 

7. Enter a data point in the design file and reset. 

8. Close the Text Editor. 
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➢ Fill In Data Fields 

 

1. Select the Fill In Single Enter-Data Field tool. The Text Editor dialog appears.  

  

Note The MicroStation status bar message  reminds of the 
step to follow. 

2. Select the text “Project No. ____” and notice the text and underscores highlight. 

  

Note The MicroStation status bar message, , 
reminds of the step to follow. 

3. In the Text Editor dialog, key-in 123, press [Enter] or data point on the design file to accept, and then 

right-click to reset. 

             

Note If key-in information does not display, open the View Attributes dialog and confirm that the Fill option is 
selected for this information to display. 

4. Close the Text Editor dialog. 
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➢ Copy and Increment Data Fields 

 

1. Select the Copy/Increment Text tool. The Copy and Increment Text dialog displays. 

 

2. Type 1 in the Tag Increment text field. 

3. Select the source “Project No. 123” Enter Data Field to copy.  

 

4. Move the cursor to another destination and place copy with a data point.   

 

5. Notice the Enter Data Field increments by 1 upon placement. Repeat placement and notice the increment 

continues until right-clicking to reset. 
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➢ Edit Data Fields 

1. Using the Element Selection tool, double click on the text “Project No. 123”. The Text Editor – Word 
Processor displays with selected text.  

 

2. Highlight “123”, right-click, and then select Insert Enter Data Field from the popup menu. The Edit 
Enter Data Field dialog displays. 

 

 

3. Remove 123 from the Enter data field and click OK. The Text Editor – Word Processor displays with 

the Enter Data Field cleared. 

 

4. Place a data point in the view to accept and another to reset. 
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➢ Copy Enter Data Field 

1. Select the Copy Enter Data Field tool.   

 

2. Select the source “Project No. ___” Enter Data Field to copy.  A rectangle displays around the Enter 

Data Field.   

  

3. Select the destination “Project No. 124” Enter Data Field to with a data point and repeat with “Project 

No. 125” Enter Data Field. 

  

4. Reset to stop copying. 
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➢ Auto Fill In Data Fields 

  

1. Select the Auto Fill In Enter Data Fields tool. The Text Editor dialog appears. 

 

2. Pan down to a view with an empty “PROJECT NO.___”  Enter Data Field and place a data point in 

the view window. Notice the first Enter Data Field is highlighted. 

 

3. Key-in 321 in the Text Editor dialog and select <Enter>. The selected Enter Data Field updates and 

moves to the next open Enter Data Field ready for a new entry. 

 

4. Key-in entries for the next two Enter Data Fields and right-click to reset.  

5. Close the Text Editor and exit MicroStation. 
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11 CELLS AND POINTS  

OBJECTIVES 

This chapter reviews MicroStation Cells and Points.  Topics include: 

• Cells  

• Cell Libraries 

• FDOT Menu Cells Options  

• Dropping Cells 

• Points 

INTRODUCTION 

As project designs are created, users often have to place points to construct elements from or place multiple instances 

of the same symbol in the design file. MicroStation stores such points and symbols efficiently.  The symbols are 

referred to as Cells.  MicroStation stores cells in cell libraries so that they may be recalled as needed. Florida 

Department of Transportation (FDOT) has utilized this function and developed many Standard Cell libraries for 

specific use by each FDOT Discipline in the production of FDOT Projects. These Standard Cell Libraries are 

delivered within the FDOT CADD Software package and will be discussed in more detail later in this chapter. 

CELLS 

Typically, a Cell is a small 2D drawing, or a 3D object.  Cells can represent complex elements that are used regularly 

in designs. Rather than redraw them each time, they can be saved in a cell library to recall for repeated use. Cell 

libraries are really DGN files that contain one or more models, one for each cell. The cells are simply design models 

that have the option ‘Can be placed as a cell’ enabled. Cells created in this fashion have the model´s origin as their 

origin. 

FDOT has created many cells as a part of the CADD Software delivery to assist the user in the production of FDOT 

projects and adhering to the CADD Standards. 

 

Sample Cells 
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CREATING CELLS  

This chapter, thus far, has discussed utilizing existing cell libraries containing pre-defined cells. In actual 

working environments, users will likely have to create cells and then use those cells in their drawings.  

If a cell is needed, but one cannot be added to a cell library (because, for example, a system administrator is 

in charge of the cell libraries in the company), consider using a Group to place the same elements repeatedly 

in a design. A Group is complex element whose component elements need not be connected (an unnamed 

cell that is not defined in a cell library). A number of elements can be selected and grouped for manipulation 

as a single element. 

When a cell is created, define the cell origin (the location around which the cell is placed) and the cell type. 

There are three types of cells: graphic, point, and menu.  

• Graphic Cells  

A Graphic Cell is a type of cell in which the symbology (color, line style, and line weight) is 

determined when it is created.  They are stored with symbology settings and are always placed 

with their original attributes. A graphic cell rotates when a view is rotated.  A graphic cell is 

level-independent. That is, it can be placed on levels relative to the Active Level or on the same 

levels as when created, depending on whether Relative is on. 

• Point Cells  

A Point Cell is a cell with a single, snappable point. Point cells are commonly used for symbols 

and to establish monument points. The snappable point in a point cell is the cell origin. Point 

cells are view-independent and do not rotate with the view. They are always placed relative to 

the active level with the active symbology.  

For example, if color 6 is the active color when the cell is placed, the cell takes on color 6, as 

well as the currently active level, line style and line weight.   

The term “point cell” as discussed here refers to the cell type, which is assigned when the cell 

is created. This should not be confused with the “Active Point Cell,” which refers to a cell in a 

cell library that is designated for placement using the tools in the Points task. It is possible for 

a cell of either type — graphic or point — to be the Active Point Cell. 

• Menu Cells  

Tablet menus contain menu blocks of varying shapes and sizes. Tablet menus are sometimes 

referred to as “paper menus” because they exist in printed form or “command menus” to make 

a distinction that no longer applies. To use a digitizing tablet menu it must first be printed and 

attach the printed output to the surface of the digitizing tablet. A maximum of four tablet menus 

can be simultaneously attached. 

CELL LIBRARIES 

Cell libraries are commonly stored as DGN Libraries .dgnlib and can be opened as a DGN file. Each model in a 

DGN file becomes a separate cell.  When a cell library is created, a blank default model is created. This blank model 

displays when first opening the cell library as a DGN file. Change to different models with the Models dialog (File 

> Models).  

With MicroStation there is no limit for the size of a cell library or individual cells.  This means that the requirements 

of the operating system set the limit, including the maximum number of characters allowed in a cell name.  Both 

3D cells and 2D cells can be stored in the same library. 

Pre-V8 files and cell libraries are not supported as cells. A pre-V8 cell library cannot be opened and upgraded to a 

V8 DGN file. It must be attached as a cell library. 

The FDOT CADD Software delivers an extensive array of cell libraries containing standard FDOT cells associated 

with all Discipline functionality, that are required to produce FDOT design files.  The FDOT Menu includes the 

CellApps option as well as many links within each Discipline option to assist easy access to these cell libraries and 

cell utilities to utilize these cells in the design process.  A more detailed discussion is found in the sections to follow. 
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CELL LIBRARY DIALOG 

To utilize any cell within a design the associated Cell Library containing the cell must be attached to the 

active design file. The Cell Library dialog is used to attach Cell Libraries and activate different types of 

cells, and to create, delete, and rename cells in the attached cell library, if one is attached. The name and path 

of the attached cell library, if one is attached, are displayed in the title bar.   

The Cell Library dialog is accessed from the MicroStation menu option Element > Cells or from the 

Primary toolbox. 

 

 

File Menu Option 

o New Opens the Create Cell Library dialog, which is used to create a cell library and 

attach it to the open DGN file. 

o Attach File Opens the Attach Cell Library dialog, which is used to attach an existing cell 

library to the open DGN file. 

o Attach 

Folder 

Opens the Browse For Folder dialog, which is used to attach a folder containing 

cell libraries to the open DGN file. 

o Detach Detaches the attached cell library.  Attaching a different cell library automatically 

detaches the currently attached cell library, if one is attached. 

o Compress Compresses the open cell library. Compression reorganizes the cell DGN file to 

occupy the minimum disk space. 

o Update 

Files to 

V8… 

Opens the Upgrade Files to V8 Format dialog, used for selecting cell libraries 

to be upgraded from pre-V8 format to V8 format. 
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Use Shared Cells - If the Use Shared Cells box is checked on, cells are placed as shared cells. The 

list box shows the name of each shared cell in the design as well as the names of cells in the 

attached cell library.  

If the Use Shared Cells box is checked off, cells are placed as normal cells. The list box shows 

only the cells in the attached cell library, if one is attached. Tags attached to component 

elements of a shared cell do not remain attached when the cell is placed if the cell library was 

converted from the previous version of MicroStation. 

Note FDOT does NOT recommend the use of shared cells. 

Display All Cells In Path - If the Display All Cells In Path is checked on (and Use Shared Cells is 

off), cells are displayed in the following order: first, normal cells from the cell libraries specified 

by the MS_CELLLIST configuration variable, then normal cells listed in the directory specified 

by the MS_BLOCKLIST configuration variable.  

If Display All Cells In Path is checked on (and Use Shared Cells is on), cells are displayed in 

the following order: shared cells in the open DGN file, shared cells in the attached cell library, 

cells in the cell libraries listed in MS_CELLLIST, and cells in the directory listed in 

MS_BLOCKLIST. 

List Box Headings - The List Box Headings set the order in which the cell list is sorted. All columns 

are sorted alphabetically. Clicking a column's heading sorts the list in ascending or descending order 

by that column. 

o Name Cell Name 

o Description Cell Description 

o Type Cell type: Graphic (Grph), Point (Pnt), or Menu 

o Annotation The annotation icon appears if the cell is an annotation cell. 

o Where Cell location: cells in AutoCAD DWG block file (BLCK), cells in an attached cell 

library (Lbry), shared cells in the attached cell library (LbSh), or shared cells in the 

active DGN file (Shrd). 

List Box - The List Box lists the name, description, type, annotation, and location of cells that are 

available for placement from the attached Cell Library. They are listed in the order specified by 

the selected list box heading.  To work with a cell, select its list item. When selecting a cell, it 

is displayed to the right of the list box with its name, type, and size. For a 3D cell, the isometric, 

top, front, and right views are shown. 

Active Cells - The Active Cells group contains buttons that are used to designate how the selected 

cell will be used. 

o Placement Makes the selected cell the Active Cell, which is placed in the design with the Place 

Active Cell tool in the Cells tack or toolbox. 

o Point Makes the selected cell the Active Point, which is placed with any of the tools in the 

Points task or toolbox. 

o Terminator Makes the selected cell the Active Line Terminator, which is placed in the design with 

the Place Active Line Terminator tool in the Cells task or toolbox. 

o Pattern Makes the selected cell the Active Pattern Cell, which is tiled to pattern an area with 

the Pattern Area tool. 
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Display - The Display dropdown controls how the selected cell is displayed in the box on the right 

side of the Cell Library dialog: 

o Wireframe  Displays the standard wireframe view 

o Smooth Shading  Render > Smooth 

o Phong Shading  Render > Phong 

Edit - The Edit button opens the Edit Cell Information dialog, which is used to modify the name 

or description of the selected cell in the cell library. This button is dimmed if a cell is not 

selected or the selected cell is a shared cell. 

Delete - The Delete button deletes the selected cell from the cell library, if the selected cell is in a 

cell library, as indicated in the Where column and the cell library is writable. The Delete button 

deletes a shared cell definition from the open DGN file, if the selected cell is a shared cell, as 

indicated in the Where column and the shared cell is unused. A shared cell definition cannot be 

deleted until first deleting all of its instances using the Delete Element tool. 

Create - The Create button opens the Create New Cell dialog, which is used to add a cell to the 

attached cell library.  This button is dimmed unless the following conditions are met: 

✓ A cell library is attached (File > Attach) with write access. 

✓ The elements to be included in the cell are selected or fenced. 

✓ A cell origin is defined with the Define Cell Origin tool. 

Share - The Share button defines the selected cell as a shared cell in the DGN file. An instance of 

the cell is not placed in the design. Defining a shared cell without placing an instance is helpful 

when customizing a seed file. 

PLACING CELLS  

Users insert cells in a drawing in much the same way as other MicroStation elements. The size (scale) and 

rotation angle are specified at the time of insertion.  To place a cell into a drawing: 

1. Attach a Cell Library 

2. Select a Cell 

3. Make the Cell Active 

4. Select a Cell Placement Tool 

5. Adjust the Scale and Rotation of the Cell as needed 

6. Identify a Location for the Cell 

  

mk:@MSITStore:C:/Program%20Files/BentleyXM/Documentation/MicroStation.chm::/ustnhelp1720.html#J35206
mk:@MSITStore:C:/Program%20Files/BentleyXM/Documentation/MicroStation.chm::/ustnhelp1721.html#J12220
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METHOD OF PLACEMENT 

Before placing a cell, it must be activated for the desired method of placement: 

• General Placement - Activate with the Place Active Cell tool or the Place Active Cell Matrix 

tool in the Cells task or toolbox. This cell is called the Active Cell. 

• Line Terminator -   Activate with the Place Active Line Terminator tool in the Cells task or 

toolbox. This cell is called the Active Line Terminator. 

• Point Cell - Activate for placement with the tools in the Points task or toolbox. This cell is 

called the Active Point Cell. 

• Patterning - Activate with the Pattern Area tool in the Patterns task or toolbox. This cell is 

called the Active Pattern Cell. 

CONTROLLING THE LEVEL  

When placing a graphic cell with the Place Active Cell tool or Select and Place Cell tool, the level(s) on 

which the graphic cell are placed in the open DGN file are determined by first evaluating the level(s) on 

which the elements in the graphic cell resided when the graphic cell was created and then applying the 

Relative tool setting. 

If Relative is off, the Name of the level(s) on which elements in the graphic cell resided when the cell was 

created determine the level(s) on which the graphic cell is placed, as follows: 

• Level Existing - If the graphic cell has elements on a level with the same name as an existing 

one in the DGN file, the elements in the graphic cell on that level are placed on the 

corresponding level in the DGN file, even if the level settings are not the same. 

• Level Non-existing - If a level with the same name does not exist in the DGN file, the level is 

copied from the cell library into the DGN file. However, any elements in the graphic cell on the 

Default level in the cell library are placed on the Active Level. 

If Relative is on, the Number of the level(s) on which elements in the graphic cell resided when the cell was 

created determine the level(s) on which the graphic cell is placed, as follows: 

• Level Existing - The graphic cell is placed on a level(s) relative to the Active Level's number. 

For example, consider a graphic cell that was created with elements on levels with the numbers 

5, 7, and 8. If the Active Level's number is 1, the cell is placed on levels with the numbers 1, 3, 

and 4. If the Active Level's number is 45, the cell is placed on levels with the numbers 45, 47, 

and 48. 

• Level Non-existing - However, if the graphic cell has elements on any level whose number is 

not an attribute of a level in the DGN file, the placement operation fails. 
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CELLS 

Cells are placed primarily using the Place Active Cell tool. This tool is on the Cells task or toolbox, where 

other cell tools reside. The Cells - Task toolbox can be accessed from the Main Classic task or toolbox.  To 

select and place cells by clicking a thumbnail representation, use the Cell Selector dialog.  To convert an 

instance of a shared cell to an unshared cell, use the Drop Element tool in the Groups task or toolbox. 

   

 

•  Place Active Cell   
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Active Cell Can be keyed-in here or set in the Cell Library dialog (Element > Cells). 

Browse Cells Opens the Cell Library dialog to allow for selection of an active cell. 

Active Angle Set the angle by which the cell is rotated, if Interactive is off, or if Interactive is on and 

Scale Only is selected. 

X ,Y, Z Scale X - Horizontal scale factor (along x-axis).  Y - Vertical scale factor (along y-axis).  Z - 

Depth scale factor (along z-axis). 

   If scale lock is on, then all scales will hold the same value.  

  If scale lock is off, then each value is independent of the other. 

Annotation Scale 

Lock 

(Applies only to cells that have Can be placed as an annotation cell enabled in their Model 

Properties.) 

 If display highlight is on, the current annotation scale is applied to the cell. Later, 

if the annotation scale is modified, the option is given of having the new scale applied to 

previously placed annotation cells. 

True Scale If on, cells that were created in a model with different units from those of the active model 

are scaled to adjust them to the units of the active model 

Relative If the active cell is a graphic cell and Relative is ON, the Number of the level(s) on which 

elements in the graphic cell resided when the cell was created determine the level(s) on 

which the graphic cell is placed.  The graphic cell is placed on a level(s) relative to the 

Active Level's number. 

If the active cell is a graphic cell and Relative is OFF, the Name of the level(s) on which 

elements in the graphic cell resided when the cell was created determine the level(s) on 

which the graphic cell is placed.   

Mirror If on, when placing a cell it can mirrored about the horizontal axis, about the vertical axis, 

or about both the horizontal and vertical axes by selecting one of these options from the 

list box. 

Interactive If on, the cell's scale, rotation angle, or both scale and rotation are defined graphically by 

data points. 

Rotate and Scale — If on, both the scale and rotation angle are defined graphically by 

data points. 

Rotate Only — If on, the rotation angle is defined by placing a data point. The scale is 

defined in the X Scale, Y Scale, and Z Scale text boxes. 

Scale Only — If on, the scale is defined by placing a data point. The rotation angle is 

defined in the Active Angle text box. 

Flatten If on, 3D cells can be flattened, or projected, on to one of the standard view projections 

— Top, Front, Right, Isometric, Bottom, Back, Left, Right Isometric — which is selected 

from the option menu. Allows for placement of a view of a 3D cell into a 2D model. 

Scale Multi-line 

Offsets, Dimension 

Values and 

Annotations 

If on, applies the active scale to multi-line offsets, dimension values and annotations.  

If off, the active scale is not applied. This setting does not affect multi-line offsets, 

dimension values and annotations in shared cells; elements in shared cells always scale. 

This setting is also available in the Scale tool. 

Association If on, allows for association of cells to elements in the model. 
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•  Place Active Cell Matrix 

The Place Active Cell Matrix tool is used to place a 

matrix of the Active Cell. The cells are placed at the 

Active Angle and Active Scale on the same level(s) as in 

the cell definition, unless it is a point cell. Point cell 

components are placed on the Active Level. 

The Active Angle and Active Scale can be set in the DGN 

File Settings dialog (Settings > Design File…). The 

Active Level is set in the Attributes toolbox. 

•  Select and Place Cells 

The Select and Place Cells tool is used to identify a cell in 

the DGN file and place an additional instance(s) of that cell.   

 

 

 

•  Define Cell Origin 

The Define Cell Origin tool is used to define the cell origin (the point 

about which the cell is placed). When creating a cell, the cell origin 

and cell type is defined.  Notice the MicroStation message in the lower 

left status bar. 

•  Identify Cell 

The Identify Cell tool is used to display the name and level of a cell in 

the design. Notice the MicroStation message in the lower left status bar. 

   

•  Place Active Line Terminator 

The Place Active Line Terminator tool is used to 

place the Active Line Terminator cell on a line, line 

string, arc, or complex chain, primarily to place 

arrowheads.  
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•  Replace Cells 

The Replace Cells tool is used to replace single or multiple cells in a model, or to update cells in a model, 

with cells of the same name from the active cell library. 

 

•  Place Cell Index 

The Place Cell Index tool is used to create and place a cell index. A cell index contains all of the models in 

the active DGN file that are marked as “Can be placed as cell.” The cell index is stored in the active model 

and each cell is attached as a reference. After a cell has been placed, it can be edited. 

If models are added or deleted from the DGN file after a cell index has been created, the cell index is not 

updated automatically to include the additions and deletions. the cell index must be recreated to include those 

changes. If a model's scale changes significantly, the cell index may need to be recreated so that the model 

scales properly within the grid. 
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FDOT MENU CELL OPTIONS 

The FDOT CADD Software delivery includes a customized FDOT Menu with the standard menu options that 

incorporate the use of the multitude of cells developed by FDOT to assist the user in the design of FDOT projects.  

The FDOT Menu provides many options to allow the user to gain access to those FDOT Cells by way of: 

• CellApps Menu – providing cell utility applications, Cell Selector and FDOT Cell Web Pages 

• Discipline Menus – each providing automated options that incorporate the use of FDOT Cells 

and access to Discipline specific cell libraries. 

CELLAPPS MENU  

The CellApps menu does not attach specific cell libraries as an active cell library to a design file; instead, it 

uses a MicroStation configuration variable call MS_CELLLIST that points to a list of standard FDOT cell 

libraries appropriate to the current workspace.  Each of these cell libraries has a cell index file. 

 

CELL SEARCH 

This utility searches selected cell libraries for a text string and returns the matching cells in a second dialog 

from which the cells can be placed. It searches the cell name and\or description of each cell in the selected 

cell library. 
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• Cell Name & Cell Description - These check boxes indicate to the application which fields to search. 

• Ignore Case - This check box determines if it will be a case sensitive search or not. 

• Standard Cell Libraries - This tab lists the cell libraries currently defined in the MS_CELLLIST 

configuration variable. This list of cell libraries will be different depending on which workspace 

(Roadway, Structures, or Right of Way) is active. 

o Clear - Deselects all of the cell libraries in the list. 

o Reload - Selects all the cell libraries in the list. 

• Selected Cell Libraries - Cell libraries not in the MS_CELLLIST configuration variable can be 

manually added to the search on this tab. 

o Add – Allows users to browse to other cell libraries and add them to the list. 

o Remove – Removes selected cell libraries for the list. 

o Remove All – Removes all added cell libraries from the list. 

• Search >> - Initiates the specified search after entering a text string in the Search field and then clicking 

this button. The results will return in a separate dialog as shown below. 
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CELL COUNTER 

The Cell Counter utility searches the active design file and records the names of the cells in the file and the 

number of times they appear in the file.  The results of the search are saved in the current working directory 

in an ASCII text file, which has the same name as the design file with a .ccp extension.  When the utility is 

finished, an Information box displays the name and path of the saved file. 

 

CELL LIBRARIES 

The Cell Libraries option opens the MicroStation Cell Library dialog.  See Cells and Cell Libraries section 

for detail information. 
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CELL UTILITY 

The Cell Utility allows the user to globally manage an entire cell library instead of individual cells.  It uses a 

‘tag’ to select which cells are to be manipulated by the tool command chosen.  The user can Tag All of the 

cells at once, or select cells individually by double clicking on the cell name.  All of the cells that are ‘tagged’ 

will be manipulated by the tool command chosen, while all others ignored. 

 

     Creates and prints into the active design file, sheets of the ‘tagged’ cells formatted for 

printing on 8.5 X 11 inch paper.  The name of the cell, its description, and cell scale on the sheet is given for 

each cell. There are three options:  Two rows of one column on each sheet; Four rows of two columns on 

each sheet; or Eight rows of four columns on each sheet.  The sheets are numbered and the name of the cell 

library, including full path, is placed at the top of each sheet. 

 

  Creates an ASCII text file of the ‘tagged’ cells in the library and prompts the user for the filename 

and directory. 

 

  Deletes ‘tagged’ cells. 

Export Shared Cells/DWG Blocks to Cell Lib 

The EXPORT CELL SHARED key-in can be used to export blocks (or shared cells) from an open DWG file 

to a new MicroStation cell library:   

Key-in:  EXPORT CELL SHARED [destinationCellLibraryName] 

The EXPORT CELL SHARED key-in can also be used with the Batch Process utility to export blocks (or 

shared cells) from a group of files. 
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MIRROR CELLS/FLIP CUSTOM LS 

The Mirror Cells/Flip Custom LS utility allows users to reverse the direction of a cell or custom line style.  

Mirror Cell about Active Angle will “flip” the selected cell about the active angle.  Flip Custom Line Style 

changes to the direction of the line, which “flips” the custom line style symbols. 

 

RANDOMLY SPLATTER CELLS 

The Randomly Splatter Cells option places cells randomly in an area defined by the user specified in the 

Splatter Cells dialog, utilizing the Place Fence tool to identify the area of execution.  Upon execution, the 

Splatter Cells dialog will disappear and the user prompted in the status bar to place a fence block.  Once 

placed the cells will be randomly placed inside the fence and then the Splatter Cells dialog will reappear 

upon completion. 

 

DELETE SHARED CELL DEFINITIONS 

The Delete Shared Cell Definitions option deletes shared cell definitions in a model after the cells have been 

changed to normal cells. 
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CELL SELECTOR 

The Cell Selector dialog is used to find and place cells and to create cell selector .csf files.  Cell selector files 

can contain cells from different cell libraries. Each cell in a cell selector file is displayed on a button in the 

Cell Selector dialog. The dialog is resizable and each cell's button can be customized. 

The Cell Selector is a utility that reads the current cell library and opens a palette of buttons associated with 

each cell stored in that cell library. The Cell Selector dialog displays a graphical view of the cells which 

makes it easier to identify and place cells in a drawing.  This dialog's default button configuration, clicking 

a button has the effect of activating the associated cell and selecting the Place Active Cell tool. 

  

                 

The Cell Selector menu option File > Load Cell Library allows the user to attach one or more cell libraries, 

if none are loaded.  The Cell Selector can also be accessed through the MicroStation menu option Utilities 

> Cell Selector. 

The Cell Selector menu option Edit offers editing and insertion of buttons. Once the Cell Selector 
information has been set up, the settings may be saved through the Cell Selector menu option File > Save.  

These settings can be loaded later when needed. 

Note The Cell Selector application can be used to create a customized Cell Selector file (.csf) of cells frequently 
used by individual user, but must be stored locally as any updates of the FDOT CADD Software may 
overwrite or remove these files. 
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CREATE CELL SELECTOR FILE  

This option creates a new cell selector file (.csf) from any cell library available to enable the Cell Selector 

application to offer display buttons for accessing each cell within the chosen cell library. 

OPEN EXISTING CELL SELECTOR FILE 

This option opens an existing cell selector file (.csf) for the user to access any cell within the chosen cell 

library. 

FDOT CELL WEB PAGES 

The FDOT Cell Web Pages option opens a web browser to a page containing a list of all of the available cell 

web pages containing all the standard FDOT Cell Libraries categorized by discipline and function for easy 

access by the users.   

The FDOT Cell Web Page provides easy access to the any cell library by way of clicking on the displayed 

open outline options <OR> from the dropdown menu at the top of the web page. Once selected, the Cell 

Library will open in a separate window displaying sample icons of each cell available. 
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The cell web pages are graphical based interfaces for selecting cells for placement.  Simply click on the image 

of the cell and the cell is made active, the web page closes, and the Place Active Cell tool is started for 

placement.  

Upon placement of the cell, the user needs only to click on the FDOT Menu command key: Open Browser 

to return to the FDOT Cell Webpage. 
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DISCIPLINE MENUS 

Each Discipline menu of the FDOT Menu provides many automated options that incorporate the use of the 

FDOT Standard Cells by way of direct menu task selection, toolbox options or accessing the many discipline 

specific FDOT Cell Libraries through the FDOT Web Pages.  The options vary within each of the Discipline 

menus according to the needs of the users.  

This course will not be covering all of these options, but the FDOT Menu provides Help Icons  to further 

assist the user in the use and understanding of each option.  

The following are examples of those menu options, but the users should review all options that are applicable 

to their individual needs.   

• Roadway 

 

• Drainage 
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• Traffic Control 

 

• Traffic Plans – Signing and Marking 

 

DROPPING CELLS  

There are times when the user may need to modify a single occurrence of a cell.  Normally, this cannot be done 

unless the cell is exploded and reduced into its geometric components from which it was created.   

This is the purpose of the Drop Element tool (  ) in the Drop task or toolbox accessed from the Group task or 

toolbox, through the Main Classic task bar or toolbox. This tool setting also allows a shared cell to be dropped first 

to a normal cell, then to its original geometric components.  
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• Complex - If on, complex elements (cell, complex chain, complex shape, text node, surface, or solid) 

are dropped into their components. 

• Dimensions - If on, dimension element(s) are dropped into lines, line strings ellipses, arcs, and text. 

o To Geometry — Drops the dimensions down to lines, line strings, ellipses, arcs, and text.  

o To Segment — Drops the dimensions down to individual dimension segments. 

• Line Strings/Shapes - If on, line strings and shapes are converted to series of individual line elements. 

• Multi-lines – If on, multi-line elements are converted to sets of line strings, lines, and/or arcs. 

• Shared Cells - If on, the associated option menu allows for the dropping of shared cells: 

o To Geometry — They are dropped into their components. 

o To Normal Cell — They are converted to unshared cells. 

• Solids – (3D only) If on, the associated option menu allows for the dropping of SmartSurfaces or 

SmartSolids: 

o To Surfaces — They are dropped to simple surfaces. 

o To Wireframe — They are dropped to wireframe elements. 

• Text – If on, text characters in text elements are converted to the individual elements that are used to 

draw the characters — lines, line strings, arcs, ellipses, and shapes. 

• Application Elements - If on, used to drop light weight geometry. 

POINTS 

Points are very simple geometric elements. An Active Point is used as a reference or monument point in the design 

plane. It can consist of a cell from the attached cell library, a text character, a symbol, or a line with no (zero) length 

(a “point” element). 

The Active Angle for placement is set in the Design File Settings dialog (Settings > Design File…). The Active 

Scale for cell placement is also set in the Design File Settings dialog. The Active Font, Text Height, and Text 

Width for character placement are set in the Text Styles dialog (Element > Text Styles). 

The Points task is accessed and can be opened as a floating Points - Task toolbox from the Main Classic task bar 

or toolbox. 
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Place Active Point Place the Active Point. 

 

Construct Points Between 

Data Points 

Construct equally spaced Active Points between two data points. 

 

Project Active Point Onto 

Element 

Place the Active Point on an element at the point closest to the 

data point. 

 

Construct Active Point at 

Intersection 

Construct a point at an intersection. 

 

Construct Points Along 

Element 

Construct a specified number of Active Points along an element 

between two data points. 

 

Construct Active Point at 

Distance Along Element 

Construct the Active Point on an element at a keyed in distance. 
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Exercise 11.1  Attach a Cell Library 

1. From the FDOT Desktop folder open c:\e\projects\12345678901\roadway\dsgnrd01.dgn within the 

FDOT Workspace.Select the MicroStation menu option Element > Cell.<OR>  

Select the FDOT Menu option CellApps > Cell Libraries. The Cell Library dialog displays. 

  

2. Select the Cell Library menu option File > Attach File.  

 

3. <OR> When working in the MicroStation FDOT Workspace, the File dropdown will populate with the 

set of FDOT Cell Libraries available for selection. In this case select the listing: 

F:\FDOTSS4\RESOURCES\cell\drplan.cel.  

4. If using this option, skip the step 4. 

         

5. Navigate to \FDOT2010\RESOURCES\Cell\ directory and select the cell library named drplan.cel and 

click Open.  <OR> Double-clicking on the drplan.cel file will also initiate the attachment. 
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6. The Cell Library dialog populates with the selection for review. 

  

Note Double-clicking on the any column Title within the List window will sort the list  (ascending / descending) 
by that column 
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Exercise 11.2  Creating a Cell Library 

1. Continuing c:\e\projects\12345678901\roadway\dsgnrd01.dgn, open the Cell Library dialog, if it is not 

already open. 

2. From the Cell Library dialog, select the menu option File > New.  The 

Create Cell Library dialog appears. 

   

 

 

3. From the Create Cell Library dialog, select the File name field and enter highway.  Ensure that the 

Save as Type option is set to MicroStation Cell Libraries (*.cel). The file extension is automatically 

added to the filename by default. 

   

4. Click Open.  The new cell library is created and attached to the Cell Library dialog, ready for cells to 

be created / added.  
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Exercise 11.3  Creating a Cell  

1. Continuing in the c:\e\projects\12345678901\roadway\dsgnrd01.dgn, locate the structure CR 11 near 

Station 230+00 using the Find/Replace text tool from the MicroStation menu option Edit > 

Find/Replace Text. 

 

2. From the Find/Replace text dialog, enter CR 11 for the Find field, and then check the box In Cells 

under Find Options and the boxes Animate and Zoom under View Options as shown above.   

3. Click Find and close the Find/Replace text dialog.  The application will automatically zoom into the 

Structure CR 11 near Station 230+00. 

 

4. Use the Element Selection tool to select the components that make up the curb cut near structure CR 11 

near Station 230+00.  
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5. Select the Define Cell Origin tool from the Cells task or toolbox, located in the Main Classic task bar. 

  

6. Snap to the location shown below and enter a data point to define the origin.  A symbol (like a “+”) 

appears at the point chosen as the origin. 

    

7. From the Cell Library dialog opened with the newly create Cell Library: highway.cel, select the Create 

button.  The Create Cell dialog appears. 

8. From the Create Cell dialog, enter the following and then click the Create button. 

  

9. The new CURBCUT cell is created and placed into the highway.cel Cell Library. The dialog populates 

with the cell information and thumbnail image displays as shown below.  

Note Any available cell library could have been attached prior to the new cell creation. 
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10. Select the CURBCUT cell and then click the Placement button <OR> double-click the new 

CURBCUT cell.  The displayed text next to the Placement button updates from NONE to CURBCUT.  

The Place Active Cell tool displays. 

 

Note Notice that the cell is attached to the cursor at the point of origin previously set on the cell. 

11. From the Place Active Cell tool settings, select the down arrow to expand the window and set the tool 

settings as shown below.   

 

Note Notice the Scale Lock  and Annotation Scale Lock  settings. 

12. Place the cell a few times changing the settings before each placement to see how they affect the way 

cells are placed. 

13. Right-click to reset and end Place Active Cell command. 

Note Cells can also be created by directly opening any cell library, just like opening a design file. Then the 
Models dialog can be used to create models within the file that can be placed as cells.   
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Exercise 11.4  Editing a Cell Library 

1. Continuing in the c:\e\projects\12345678901\roadway\dsgnrd01.dgn and using the newly created 

highway.cel cell library with the new CURBCUT cell, right click in the cell list and then select Open 

for Editing.  

   

2. This opens the highway.cel cell library design file.  The active model displays in the view window. 

Notice the file is no different than any other design file; therefore the cells can be edited using 

MicroStation. 
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3. Select the MicroStation menu option File > Models <OR> select the Models icon from the Primary 

task bar.  Each drawing (Cell) is a separate model in the design file that can be placed as a cell.  

  

Note New cells can be added to this Cell Library by creating a new model, checking the Cell properties so the 
model ‘Can be placed as a cell’ and then designing a new image within that model. 

4. From the MicroStation menu, select File > Open and then select any other .cel cell library to view.  

5. Double-clicking any other model available will change the display to the model selected. 

6. Close the Models window. 

Exercise 11.5  Placing Cells from a Cell Library 

1. Open the design file:  c:\e\projects\12345678901\roadway\dsgnrd01.dgn, and then open View 2 using 

the View Group toolbox located at the bottom of the application window. 

 

Note It may be necessary to navigate back to the projects directory.  Remember to Set the Files of Type field in 
the Open dialog to CAD Files *.dgn;*dwg;*dxf to be able to ‘see’ the design file. 

2. From View 2, using the MicroStation menu option Edit > Find/Replace Text, zoom into Station 

233+00.  Close the Find/Replace Text dialog. 
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3. Using the Rotate View  icon from the View Controls at the top of View 2, rotate the view with the 

2 Point Method and defining the points along the Center Line as shown below.  Place the first point at 

Station 232+00 and then the X axis at Station 234. 

 

4. Re-center Station 233 location as shown below. 

 

5. From the FDOT Menu, open the Cell Library dialog by selecting the option CellApps > Cell Libraries. 

 

6. From the Cell Library dialog, attach the drplan.cel cell library using the menu option File > Attach 

File and navigating to the FDOTSS4\RESOURCES\Cell\ directory. 
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7. Scroll down the Cell List window and select the cell named PBottom40x40.  A thumbnail image displays 

in the right-hand window as shown below. 

 

8. Click the Placement button.  The cell PBottom40x40 is now the active cell.  [Alternatively, double-

clicking the cell listing will also initiate that cell as the active cell.] 

 Notice PBottom40X40 displays next to the Placement button. 

9. Select the Place Active Cell tool from the Cells task bar/toolbox, located in the Main Classic Task and 

set the following tool settings:  

    

10. Enter a data point at Sta. 233+00 on the centerline, and then right-click to reset and end command.  

11. Close the Cell Library dialog. 



CELLS AND POINTS - Points _______________________________________________________________________ Chapter 11 

FDOT Bentley CADD Essentials © 2018 FDOT 11-33 

Exercise 11.6  Using the FDOT Cell Web Pages 

1. Continuing with the design file:  c:\e\projects\12345678901\roadway\dsgnrd01.dgn, View 2, perform 

the same task using the FDOT Cell Web Pages. 

2. From the FDOT Menu, select CellApps > FDOT Cell Web Pages.  The FDOT Cell Web Pages browser 

window will display. 

 

 

Note If the browser window does not display contents fully, use the cursor to click and drag one of the corners 
to expand the window.  Notice the Cell Web Page Instructions at the bottom under the diagram of 
selections. 
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3. Select Landscape Library from the menu option: Roadway > Landscape>> >Landscape Library 

<OR> from the diagram outline.  The Landscape Library browser window displays. 

 

 

Note All browser screens provide the same menu bar at the top to move from one library to another by way of 
menu selection. 
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4. From the Landscape Library, scroll down to the Luminaire Pole 4 

Round Light cell.  Notice that the cells are sorted alphabetically by 

name. Notice when the cursor hovers over the image or the name it 

changes from an arrow to a pointing hand indicating a selection 

opportunity. 

 

    

5. Select the Luminaire Pole 4 Round Light cell.  The Landscape Library disappears and the Place 
Active Cell tool settings displays.  Notice that the LmPole1RLit cell is attached to the cursor.  

6. Move the cursor from View 1 to View 2 and notice that the cell automatically rescales to the view. 

7. Complete the Place Active Cell tool settings as shown 

below.  Notice that the cell is still attached to the cursor.  

 

 

 

 

 

8. Place the LmPole1RLit cell in each of the corners around WASHINGTON MUTUAL as shown below.  

Experiment with other cells and adjustments to the Place Active Cell tool settings. 

 

9. From the FDOT Menu, select the Open Browser command button. The Landscape Library re-opens to 

the previous location ready for more selections. Experiment navigating to other libraries and placement 

of cells. 

 

10. Close the FDOT Cell Web Page browser. 
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Exercise 11.7  Dropping a Cell 

1. Continuing with the design file:  c:\e\projects\12345678901\roadway\dsgnrd01.dgn, View 2, select one 

of the newly placed cells from the previous exercise. 

 

2. Select the Drop Element tool from the 

Groups task located on the Main task 

bar. The Drop Element tool settings box 

displays. 

 

 

 

 

 

 

 

 

 

Note Notice that  the MicroStation Status bar at the bottom left-hand corner displays a reminder:  

 

3. From the Drop Element dialog, turn on the appropriate tool settings to specify the element type(s) on 

which to operate. 
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4. Place Data Point in View 2 to accept the settings and initiate the drop.  Only the selected elements of the 

specified type(s) are dropped. The tool has no effect on selected elements of other types. If none of the 

selected elements is of the specified type(s), the message “Nothing to drop” displays in the status bar.  

5. Zoom into the selected cell and select the cell.  Notice that all components are now separate elements. 

 

 

6. From the MicroStation menu, select Edit > Undo Drop 

Element and then re-select the cell.   

 

 

 

 

 

7. Using the Element Selection tool   <OR> just hover over the cell with the cursor, notice that the 

cell is re-united as one element. 

 

 

8. Close View 2 from the View Groups toolbox at the bottom of the application window. Leave 

MicroStation open. 
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Exercise 11.8  Using Points 

➢ Place Active Point  

1. Continuing in the c:\e\projects\12345678901\roadway\dsgnrd01.dgn, several points will be placed to 

represent property line control and right-of-way.   

2. Using the MicroStation Find/Replace text tool from the menu option Edit > Find/Replace text; zoom 

into the location near station 207+00 as shown below. Close the Find/Replace text tool. 
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3. Click the Place Active Point icon  on the Points task, located on the Main Classic task bar.  The 

Place Active Point tool settings displays. 

    

4. From the Place Active Point tool settings, click the Browse icon   to open the Cell Library dialog. 

5. From the Cell Library dialog, select the menu option File > Attach File and navigate to the directory: 

\FDOTSS4\RESOURCES\Cell\. 

6. Select the syeng.cel cell library, and then click Open. The Cell Library dialog populates with the 

syeng.cel information. 
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7. Click on the Name title heading in the List Box to sort listing alphabetically by name.  Scroll down and 

select the cell name NL, and then click the Point button located in the lower portion of the dialog. 

  

 Note that the cell name appears beside the Point button. 

  



CELLS AND POINTS - Points _______________________________________________________________________ Chapter 11 

FDOT Bentley CADD Essentials © 2018 FDOT 11-41 

8. Close the Cell Library dialog by selecting the ( ) in the upper right corner of the dialog. The Place 

Active Point tool settings should now display the cell. 

 

Note The  MicroStation status bar  displays the reminder message:   

  

9. Data point on the screen in 6 locations at property corners on the right side of the roadway as indicated 

by points 1- 6 in the figure below. 

  

10. Change the Active Level to RWLine_ep. 
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11. Connect the monument points by using the Place SmartLine tool from the Linear Elements task, 

located in the Main Classic task bar. 

  

 

12. Right-click to reset. 
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➢ Place Additional Trees 

1. Continuing in the same area, scroll over to station 209 as shown below. 

 

2. Click the Point(s) Between tool from the Points task, located in the Main Classic task bar. The 

Construct Pnts Between Data Points tool settings box displays. 

   

  

3. From the Construct Pnts Between Data Points tool settings box, select the  icon. The Cell Library 

dialog displays. 

4. From the Cell Library dialog, select TREE from the cell list box, and then click Point. The Cell Library 

updates along with the Construct Pnts Between Data Points tool settings as shown below. Close the 

Cell Library dialog. 
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5. From the Construct Pnts Between Data Points tool settings box, enter 5 for Points as shown below. 

  

6. Data point at points 7 and 8 as shown in the figure below.  The Point(s) Between tool places five TREE 

cells evenly spaced between points 7 and 8. 

  

Note This tool draws as many points as desired in between two data points. The first point is placed at the 
location of the first data point and the last point at the location of the second data point.  All points are 
placed at equal distances from each other along the line defined by the two data points. 

7. Take a few moments to experiment with the Point(s) Between and other tools available in the Points 

toolbox. 

8. Exit MicroStation. 
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12 PATTERNING & HATCHING 

OBJECTIVES 

This chapter reviews the Hatching and Patterning tools, with special consideration given to: 

• Controlling the Display 

• Patterning 

• Methods of Patterning 

• Linear Patterning 

INTRODUCTION 

Patterning adds texture and material identity to design elements and helps express role and function. Whatever the 

discipline, pattering plays an important role in clarifying drawings. For example, architectural wall sections must 

show insulation batten and concrete material and maps must define marsh lands and wooded areas.  Some designs 

must identify the construction materials of mechanical machine parts, such as brass or steel, constructions zones, 

concrete sidewalks, etc. Patterning tools accomplish these goals and more. 

Patterning is the repeated placement of a hatch line or cell through a closed area at a specified interval (spacing), 

scale, and angle. Patterns are placed on any designated level. When using a hatching or patterning tool with the tool 

setting Method set to Flood, Union, Intersection, or Difference, turning on Dynamic Area along with Associative 

Pattern allows for patterns to regenerate themselves when their bounding elements are modified. 

CONTROLLING THE DISPLAY 

Elements — either lines or cells — in a pattern are designated as pattern 

elements. The display of these patterns are controlled within each View 

through the View Attributes dialog which can be accessed from the 

MicroStation menu option Settings > View Attributes.  
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<OR> from the view control bar within a View window by selecting the View Attributes icon or selecting the down 

arrow of this icon.   
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PATTERNING 

Patterning is the repeated placement of a hatch line or cell through a closed area at a specified interval (spacing), 

scale, and angle. Patterns can be placed on any designated level. The tools in the Patterning task or toolbox are used 

to pattern areas and along linear elements. Elements used to create the patterned area can be in the active file, one 

or more references, or a combination of both. 

When using a hatching or patterning tool with the tool setting Method set to Flood, Union, Intersection, or 

Difference, turning on Dynamic Area along with Associative Pattern allows the creation of regenerating patterns 

when the bounding elements are modified.  

In DWG work mode, by default, area patterning is replaced by AutoCAD pre-defined hatching. The Pattern field in 

the Pattern Area tool settings is a combo box which, by default, lists the patterns in the DWG pattern file 

"areapat.pat". This file contains a DWG pattern definition for each pattern cell in the supplied cell library, 

"areapat.cel". 

The Patterning toolbox is accessed through the Main Classic task bar. 

  

 

 

Hatch Area Places hatch lines at a specified spacing and angle. 
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Crosshatch Area Places crossed hatch lines which run in two directions. 

   

 

Pattern Area Patterns an area by tiling the Active Pattern Cell and repeating at defined 

intervals. The values entered in the Scale, Row Spacing and Column 

Spacing fields determine the number of times the cell placement is 

repeated in the designated area. 

 

 

Linear Pattern Draws a pattern along a linear element.  This tool maintains compatibility 

with existing applications and designs with linear patterns. In most cases, 

however, defining a Custom Line Style and using linear element 

placement tools is more efficient for new drawings. 

 

Show Pattern 

Attributes 

Identifies the angle and scale attributes of an existing pattern element and 

displays this information in the Status Bar. 

 

Match Pattern 

Attributes 

Sets the active patterning attributes to match those of an existing patterned 

element. 

 

Change Pattern Modifies existing patterns. 

 

Drop Associative 

Pattern 

Convert any associative pattern (or hatch) into an identically appearing 

group of primitive elements. 

 

Delete Pattern Deletes patterning while restoring the original element components used 

to create the pattern. 
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METHODS OF PATTERNING  

          

METHODS OF PATTERNING ICONS 

To control the patterning process, one of seven pattern methods is selected by choosing the appropriate icon 

from the Method option menu. 

 

 
Element Patterns the interior of a shape, ellipse, closed B-Spine curve or between multi-

line components. This icon expands the tool settings with further controls. 

 

  Search For Holes – (Element icon selected only) When creating a non-

associative pattern, options are given for how hole elements are treated. Hole 

elements can be ignored or search for hole elements on the same level as the 

element to pattern, or on all levels displayed in the view. 

o No — Ignores hole elements. 

o Element Level — Searches for hole elements on the same level as 

the element to hatch. 

o View Levels — Searches for hole elements on all levels displayed 

in the view. 

  Use Element Symbology – If on, hatching is created using the active color, line 

weight, and line style of the element being patterned. 
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Flood Patterns the (minimum) area enclosed by a set of elements. This icon expands 

the tool settings with further controls:  Ignore Interior Shapes, Locate Interior 

Shapes, Identify Alternating Interior Shapes, Locate Interior Text and Dynamic 

Area Locate. 

 

 

Union   Patterns the total interior area occupied by two or more selected closed planar 

elements. 

 

Intersection Patterns the common interior of two or more selected closed planar elements. 

 

Difference Patterns the interior area of the first selected closed planar element minus the 

common area of the additional selected closed planar elements. 

 
Points Patterns the area defined by a series of data points representing the vertices of 

a temporary shape. This icon expands the tool settings with further controls. 

 

 
Fence Patterns the interior of the current fence. 
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Pattern Definition Pattern Area only – Allows for the selection of the active cell 

pattern or the active pattern from an AutoCAD file. 

o From Cell — Allows for the typing of the name 

of the cell that is tiled to create the pattern. 

Optionally, the Browse Cells button to the right 

of the input field can be selected, which opens the 

Cell Library dialog to browse the cells in the 

attached library. A cell library can also be 

attached. The active Pattern Cell also can be set 

with the Pattern button in the Cell Library dialog. 

o From File — Allows for the selection of a pattern 

from an AutoCAD pattern file. To select the 

pattern file, click the Browse button. 

Browse Pattern Area only– When Pattern Definition is set to From Cell, 

opens the Cell Library dialog, which allows a cell to be chosen 

for the pattern.  When Pattern Definition is set to From File, 

opens the Select AutoCAD Pattern File dialog. 

Scale Pattern Area only – Sets the factor by which the active pattern 

cell or active pattern is scaled. 

 

Spacing Hatch Area – Sets the distance interval between hatching lines. 

Crosshatch Area – Sets the interval between the rows and the 

columns of the cross-hatching. 

Pattern Area - Row – (Pattern Definition set to From Cell only) 

Sets the interval between rows for the tiling of the pattern. 

Pattern Area - Column – (Pattern Definition set to From Cell 

only) Sets the interval between columns for the tiling of the 

pattern. 

Angle Hatch Area – Sets the angle at which hatching lines are drawn. 

By default, the angle is relative to the view being used. When 

AccuDraw is active, however, the angle is relative to the 

AccuDraw drawing plane. 

Crosshatch Area – The angle at which instances of the crosshatch 

are placed. By default, the angle is relative to the view being 

used. Where AccuDraw is active, however, the angle is relative to 

the AccuDraw drawing plane. 

Pattern Area – The angle at which instances of the active pattern 

cell or pattern are placed. By default, the angle is relative to the 

view being used. Where AccuDraw is active, however, the angle 

is relative to the AccuDraw drawing plane. 
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Tolerance Maximum distance between curved element and approximating 

line segments.  

Associative 

Pattern 
If on, association is made with geometry.  

If Method is set to Element, the area is associated with the 

element and is automatically updated when the element is 

manipulated or modified. 

If Method is set to Intersection, Union, or Difference, a complex 

shape that bounds the area is created, and is associated with the 

complex shape. The area and complex shape are automatically 

updated when the original element(s), used to create the complex 

shape, are modified or manipulated, only if Associative Region 

Boundary is also on. 

Associative Region 

Boundary 
(Available only when Associative Pattern is set) If on, association 

is made with the region boundary.  

If Method is set to Element, the area is associated with the region 

boundary, which is the boundary of the element, is automatically 

updated when the element is manipulated or modified.  

If Method is set to Flood, Intersection, Union, or Difference, an 

associative region that bounds the area is created, and is 

associated with the associative region. The area and the 

associative region are automatically updated when the original 

element(s), used to create the associative region, are modified or 

manipulated. 

Snappable Pattern If on, lines/cells can be snapped to. If off, lines/cells do not 

interfere with snapping to other elements. 

True Scale Pattern Area only – (Pattern Definition set to From Cell only) If 

on, the active pattern cell is scaled to adjust it to the units of the 

active model. The scaling occurs only if the cell is shared and the 

units of the model in which the cell was created differ from those 

of the active model. 
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LINEAR PATTERNING 

Linear Patterning is used to draw or “tile” a pattern along an existing linear element. That is, to replace the linear 

element with repetitions of the pattern cell. After applying linear patterning to an element, Patterns can be turned 

off in the View Attributes dialog (Settings > View Attributes), to display the original linear element.  

                      

 

Cycle Sets the manner in which the active Pattern Cell is placed. 

 Truncated – Places the linear pattern along the element at the Active Pattern Scale. If necessary, the 

last instance is truncated. 

 Complete – Places the linear pattern along the element at an adjusted scale from the Active Pattern 

Scale, if necessary, so that only complete instances are placed. 

 Single – Places the linear pattern with one instance on each segment. If a segment’s length is less than 

80% of the cycle length, the segment is patterned with the first horizontal line in the pattern cell. 

 Multiple – Places a complete linear pattern along an element at an adjusted scale from the Active 

Pattern Scale. If a segment’s length is less than 80% of the cycle length, the segment is patterned with 

the first horizontal line in the pattern cell. 

Pattern The cell that is tiled to create the pattern. Can also be set with the Pattern button in the Cell Library 

dialog (Element > Cells). 

 Browse 
Opens the Cell Library dialog for the placement of a different active cell.  

Scale The active Pattern Cell is scaled by this factor. 

Tolerance Maximum distance between a curved element and the approximating line segments. 

True Scale If on, the active pattern is scaled to adjust it to the units of the active model. The scaling occurs only 

if the cell is shared and the units of the model in which the cell was created differ from those of the 

active model. 
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Exercise 12.1  Hatch Area 

➢ Creating an Area Hatch Pattern 

1. Open the file c:\e\projects\12345678901\roadway\dsgnrd01.dgn. 

2. Recall the Saved View named Hatch: 

3. Click on the View 1  icon and select View Save/Recall option from the popup menu.  The Saved 
Views dialog displays. 

 

4. Right-click on Hatch and select Apply from the popup menu.  Apply Saved View window displays. 
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5. Accept the default settings in the Apply Saved View window and place a data point in View 1 to accept.  

 

6. Close Saved Views dialog and Attach Saved View window. 

7. Select the Hatch Area tool   from the Patterns task, located in the Main Classic task bar and 

match the tool settings shown below.   

  

8. Notice the reminder in the MicroStation Status Bar in the lower left corner of the application window:  
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9. Enter a Data Point on each of the shape vertexes as shown below. 

  

Note Notice that, when hovering near each of the vertexes, the auto snap locates the precise vertex point.  A 
Data Point needs only to be placed to accept. 

10. Right click to reset.  The area is now hatched as shown below. 

  

11. Select the View Attributes icon  and toggle the Patterns option on and off to see 

the effect on the display.  Toggle on and close the View Attributes dialog. 

12. Select the Delete Pattern  tool from the Patterns task, located in the Main Classic task bar and 

identify the hatching element just placed by hovering over the pattern until the element highlights. 

 

13. Place a Data Point to accept and notice the hatching deletes from the display. 
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Exercise 12.2  Creating a Crosshatch Pattern Area 

1. Continuing in c:\e\projects\12345678901\roadway\dsgnrd01.dgn and the same Saved View: Hatch. 

2. Select the Crosshatch Area tool  from the 

Patterns task, located in the Main Classic task bar and 

match the tool settings shown below: 

 

 

 

 

   

3. Notice the reminder in the MicroStation Status Bar in 

the lower left corner of the application window:  

 

4. Hover over element as shown below and select to identify element.  Element highlights and the 

MicroStation Status Bar displays the reminder to “Accept @ pattern intersection point. 

 

 

 

 

5. Place a data point at an intersection to accept. Right click to reset.  The area is now crosshatched as 

shown below. 
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6. Select the Show Pattern Attributes tool  from the Patterns task, located in the Main Classic 
task bar and identify hatching element just placed by hovering over one of the lines until the element 

highlights. 

 

 

7. Place a Data Point to select Crosshatching.  The element highlights, and its type and level display in the 

status bar. 

 

 

8. Place another Data Point to Accept the element and notice the pattern angle and scale are displayed in 

the status bar. 

 

9. Right-click to reset. 
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Exercise 12.3  Pattern Area 

This exercise it to pattern an area inside a closed element using a cell. 

1. Continuing in c:\e\projects\12345678901\roadway\dsgnrd01.dgn. 

2. From the MicroStation menu, select File > References, and uncheck the display  option for 

Utexrd01.dgn and TOPORD01.DGN. Close the References dialog. 

 

3. Recall the Saved View named: First Intersection. 
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4. Select the Pattern Area tool  from the Patterns task, located in the Main Classic task bar. The 

Pattern Area dialog displays. 

5. From the Pattern Area dialog, set the Patterning Method by selecting the Flood icon . 

 

6. Select From Cell from the Pattern Definition dropdown. 

7. Click the Browse  icon to open the Cell Library dialog.  Select the menu option File and scroll down 

to select the Landscape.cel cell library.   

8. From the Cell Library dialog, scroll down the selection window and select the PatConc1 cell and then 

click the Pattern button to make this the Active Pattern Cell.  The Cell Library and the Pattern Area 

dialogs update with the selection. 
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9. From the Pattern Area dialog, set the Scale to 50. 

10. Select the Ignore Interior Shapes icon at the bottom of the dialog. 

11. Accept all other settings as shown below. 

Note Notice the reminder in the Status Bar:  

12. Place a Data Point inside the area to be flooded as indicated below. The element highlights. 

Note Notice the reminder in the Status Bar.  
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13. Place another Data Point to accept. The area floods with the chosen Active Pattern Cell. 

 

14. Experiment with the tool settings and Active Pattern Cell selection. Utilize the Delete Pattern  

option to remove selection and then start over from Step 4. 

15. Delete the final selection to return image to the original view. 

16. From the MicroStation menu, select File > References, and re-check the display  option for 

Utexrd01.dgn and TOPORD01.DGN. Close the References dialog. 

 

17. Exit MicroStation. 
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13 PLACING DIMENSIONS 

OBJECTIVES 

This chapter reviews Dimensioning tools within MicroStation. Topics include: 

• Dimension Element Defined 

• Controlling the Display of Dimensions 

• Dimensioning 

• Dimension Styles 

• Modifying a Dimension Element 

• Other Dimension Tools 

INTRODUCTION 

Dimensioning is a crucial step in the design process.  A designer must clearly convey their intentions for their design 

by dimensioning the elements contained in the construction documents.  Dimensions are critical when it comes to 

actually building work depicted in a design. Correct dimensioning can help avoid costly job site mistakes. Proper 

use of MicroStation dimensioning capabilities helps avoid errors. 

DIMENSION ELEMENT DEFINED 

Once drawing objects have been established at the proper size, scale, and orientation, annotation generally begins. 

Adding dimensions, symbols, and notes to a drawing (sometimes referred to as detailing) conveys intent when it is 

time for the drawing to become something real. A dimension is a label in a design showing a linear, angular, or 

radial measurement. 

A dimension can be placed with the dimensioning tools as separate lines, line strings, and text or as one dimension 

element. A dimension can have the following components:  dimension lines, dimension text, extension lines 

(optional), dimension line terminators (optional) and prefixes or suffixes (center, diameter, radius, etc) (optional). 

 

Dimension element components:  

1 — Extension Line, 2 — Dimension Line, 3 — Dimension Text, 4 — Terminator 
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Dimension elements have the following advantages:   

• A dimension element can be modified easily.   

• A dimension element can be associated with the element or elements it dimensions. Such an associated 

dimension updates automatically when any of the dimensioned elements are modified.   

• Using dimension elements can significantly reduce the size of a design file that has many dimensions, since 

a dimension element is usually smaller than the corresponding individual elements.  

• When the Use Working Units (Units tab of the Dimension Styles dialog) option is on, if the working units 

in a design file are changed, dimension elements will display dimensions based on the new working units. 

CONTROLLING THE DISPLAY OF DIMENSIONS 

The display of dimensions is controlled within each View through the View Attributes dialog which can be accessed 

from the MicroStation menu option Settings > View Attributes <OR> from the view control bar within a View 

window by selecting the View Attributes icon or selecting the down arrow of this icon. 
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DIMENSIONS 

The Dimensions task or toolbox provides methods for placing and managing dimension settings.  With the focus 

on the Drawing Task bar, the Dimensions toolbox can be accessed by typing “V” (– OR – by selecting the 

Dimensions icon from the Drawing Task bar), then selecting Open as ToolBox. 

  

 

 

Dimension Element Dimensions an element and creates all associations 

automatically, if Association is toggled on. 

 

Dimension Linear Dimensions a linear size (distance). Each dimension is 

computed from the endpoint of the previous one and placed in 

line (chained). 

 

Dimension Angular Dimensions an angle. 

 

Dimension Ordinates Label distances along an axis from a common point of origin. 

 

Change Dimension  Changes a dimension to the active dimensioning attributes. 

 

Match Dimension 

Attributes 

Sets the active dimension settings to the dimension attributes of 

a selected dimension element. 

 

Reassociate Dimensions Recreates a linear or radial dimension's association to an 

element. 
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DIMENSION ELEMENT 

The Element Dimensioning tool is used to dimension an element (line, line string, multi-line, shape, circular 

arc, or circle). Associations can be made to these elements, as well as to components of complex elements 

and elements that are part of a shared or unshared cell. The tool options change depending on the element 

type selected as shown below. The default is to linear tools. 

              

Style Displays the active dimension style, which is set on the Dimension Styles 

dialog. The option menu allows for the selection of other available dimension 

styles. 

If changing a tool setting from the default, the setting is highlighted in blue, and 

an asterisk appears next to the Style name. 

Dimension 

Styles dialog 
 Opens the Dimension Styles dialog, which is used to control settings for 

dimensioning. 

Reset Style 
 Restores the tool settings to the defaults set for this style on the Dimension 

Styles dialog. 

Alignment Determines the axis along which the dimension is aligned. 

View – Parallel to the view x or y-axis; useful when dimensioning 3D references 

with dimensions parallel to the viewing plane (“Xv” denotes the view x-axis). 

Drawing – Parallel to the design plane x or y- axis.  The design's rotation 

determines the alignment axis for a particular dimension (“Xd” denotes the design 

plane x-axis). 

True – Parallel to the element being dimensioned.  The extension lines are at right 

angles to the dimension line. 

Arbitrary – Parallel to the element being dimensioned.  The extension lines are 

not constrained to be at right angles to the dimension line.  This is useful when 

dimensioning elements in 2D isometric drawings (Iso Lock must be on to 

accomplish this). 
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Location Controls the location of dimension text. 

Automatic — Dimension text is automatically placed according to the 

Justification setting (in the Dimension Styles dialog, Text tab). 

Manual — Dimension text can be positioned in response to a prompt. 

Semi-Automatic — Dimension text is automatically placed according to the 

Justification setting if the text fits between the extension lines. If the text does not 

fit, the text can be positioned in response to a prompt. 

Dimension 

Element  If the selected element is a linear (non-circular) shape, clicking this icon 

sets the tool's mode to Dimension Element. 

Label Line 

 If the selected element is a linear (non-circular) shape, clicking this icon 

sets the tool's mode to Label Line. This mode is used to place a dimension 

showing the length and/or angle of a line. 

Dimension Size 

Perp – Line  If the selected element is a linear (non-circular) shape, clicking this icon 

sets the tool's mode to Dimension Size Perpendicular to Points. This mode is used 

to dimension the linear distance between two points. 

Dimension 

Radius 
 If the selected element is a circle, ellipse, or b-spline, clicking this icon 

sets the tool's mode to Dimension Radius. 

Dimension 

Diameter  
 If the selected element is a circle, ellipse, or b-spline, clicking this icon 

sets the tool's mode to Dimension Diameter (Extended Leader). 

Dimension 

Diameter 

Parallel 
 If the selected element is a circle, ellipse, or b-spline, clicking this icon 

sets the tool's mode to Dimension Diameter Parallel. This mode is used to place 

a dimension parallel to the circle or arc, and with tangent extension lines 

extending to the circle or arc. 

Annotation 

Scale Lock  Sets the Annotation Scale Lock. When this lock is toggled on, the 

annotation scale is applied to any text that is placed in the model.  The annotation 

scale is set in the Model Properties dialog. It defines the scale for text and 

dimensioning in the model. 
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Label Line If the mode is Label Line, sets what information (angle, length or both) and where 

(above/below) the information must be placed for a line label. 

Center Mark If the mode is relevant to a circle or arc, turning this on places a cross mark at the 

center of the element. 

Start / End 

Extension 

If the mode is Dimension Element, Dimension Size Perpendicular to Points or 

Dimension Diameter Parallel, sets the optional terminator for the beginning / end 

of dimension lines. 

Text 

Alignment 

If the mode is Dimension Element or Dimension Size Perpendicular to Points, 

sets the orientation of dimension text:  Standard, Vertical or Mixed. 

Text Frame If the mode is Dimension Element or Dimension Size Perpendicular to Points, 

controls the framing of dimension text:  Box or Capsule. 

Prefix / Suffix 

Text 

If the mode is Dimension Element or Dimension Size Perpendicular to Points, 

sets the optional symbol for placement before / after dimension text. 

Association If on, all possible associations are created automatically without the need to snap 

a tentative point.  If off, no associations are created. 

Note The Association checkbox should be toggled ON for FDOT plans production. 

  



PLACING DIMENSIONS - Dimensions ________________________________________________________________ Chapter 13 

FDOT Bentley CADD Essentials © 2018 FDOT 13-7 

DIMENSION LINEAR 

The Linear Dimensioning tool is used to dimension the linear distance between two points (length).  The 

dialog offers all the options along with the additional options shown below. 

  

Additional Dimension Linear options: 

Dim Offset This sets a standard offset for the placement of a dimension 

Select Multiple 

Elements 
 If on, multiple elements can be selected for dimensioning by drawing a line 

through the elements. Enter data points for the start and end of the line. To continue 

dimensioning, hold the <Ctrl> key, and enter data points for the start and end of the next 

segment of the line. The <Ctrl> key allows continuance of dimensioning without 

selecting intermediate elements. 

Linear Size 
 Clicking this icon sets the tool's mode to Linear Size, which is used to dimension 

the linear distance between two points (length). Each dimension (except the first) is 

computed from the endpoint of the previous dimension. Dimensions are placed in line 

(chained). 

Linear Stacked 
 Clicking this icon sets the tool's mode to Linear Stacked, which is used to 

dimension the linear distance from an origin. The dimensions are stacked. 

Linear Single 
 Clicking this icon sets the tool's mode to Linear Single, which is used to 

dimension the linear distance from an origin. The dimensions are placed in line 

(chained). 

First Terminator If on, sets the optional terminator for the beginning of the first dimension line. 

Joint Terminator If on,  mode is Linear Size or Linear Single, sets optional terminator at intersection of 

left & right terminators (at internal extension lines), or intersection of extension line & 

a dimension line. 
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DIMENSION ANGULAR  

The Angular Dimensioning tool is used to dimension angles.  The dialog offers all the options along with the 

additional options shown below. 

  

Angle Size 

 Clicking this icon sets the tool's mode to Angle Size. In this mode, each 

dimension (except the first) is computed from the endpoint of the previous dimension. 

Angle Location 

 Clicking this icon sets the tool's mode to Angle Location. In this mode, each 

dimension is computed from the dimension origin. 

Angle Between 

Lines  Clicking this icon sets the tool's mode to Angle Between Lines, which is used 

to dimension the angle between two lines, two segments of a line string, or two sides 

of a shape. 

Arc Size 

 Clicking this icon sets the tool's mode to Arc Size, which is used to dimension 

a circle or circular arc. Each dimension (except the first) is computed from the endpoint 

of the previous dimension. 

Arc Stacked 

 Clicking this icon sets the tool's mode to Arc Stacked, which is used to 

dimension a circle or circular arc. Each dimension is computed from the dimension 

origin. The dimensions are stacked. 

Arc Symbol If on, arc dimension text is placed with an arc length accent above the text. 
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DIMENSION ORDINATE  

The Ordinate Dimensioning tool is used to label distances along an axis from an origin (datum) along the 

ordinate axis (the line along which the distances are measured).  The dialog offers all the options, except the 

Extension options, along with the additional options shown below. 

  

Additional Dimension Ordinate options: 

Datum Value This sets a base value of the origin when labeling distances along an axis. 

Ordinate 

Unstacked Clicking this icon sets the tool's mode to Ordinate Unstacked, which is used to label 

distances along an axis from an origin (datum) along the ordinate axis (the line along 

which distances are measured). 

Ordinate Stacked 
 Clicking this icon sets the tool's mode to Ordinate Stacked, which is used to label 

distances along an axis from an origin (datum) along the ordinate axis (the line along 

which distances are measured). The dimensions are stacked. 

To use this mode effectively, the Stacked Dimensions setting (Dimension Styles dialog, 

Advanced tab > Tool Specific > Ordinate) must be on. 

Ordinate Free 

Location  Sets the tool's mode to Ordinate Free Location, which is used to label distances 

along an axis from an origin (datum) along the ordinate axis (the line along which 

distances are measured). When Location is set to Manual, this tool gives maximum 

flexibility in placing the dimensions. 

To use this mode effectively, the Stacked Dimensions setting (Dimension Styles dialog, 

Advanced tab > Tool Specific > Ordinate) must be on. 

Decrement in 

Reverse Direction 

If on, the value opposite to the direction of the ordinate will be in a decreasing value 

(including negative numbers). 
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DIMENSION STYLES  

Dimension Styles are saved sets of dimensioning settings.  They are defined and applied to dimension elements 

during placement. Dimension styles can be created, customized, and saved for easy recall. Changes made to a 

Dimension Style propagate to all dimensions previously set with the Dimension Style in the DGN file. The active 

Dimension Style is used by the Dimensioning tools. 

Dimension Styles can be stored in DGN library and used in a DGN file. Changes made to the dimension style (from 

a dimension style library) within a DGN file are called overrides, if the style is not saved. Dimensions placed with 

overrides do not change, if the style is changed and saved. To remove the override, the Change Dimension tool can 

be used to match the Dimension Style 

The Dimension Styles dialog provides tools for creating and managing Dimension Styles.  The options are 

organized under dimension settings tabs: Geometry, Units, Text, Symbology and Advanced, with a preview area that 

allows for a quick view of style modifications. This dialog also sets the active Dimension Style (or, if a style is not 

active, the active dimension settings).  

The Dimension Styles dialog is accessed through the MicroStation menu option Element > Dimension Styles. 

The title bar identifies the active dimension style. 
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GEOMETRY TAB 

The Geometry tab contains controls that affect the appearance of the dimension's geometry. 

Dimension Lines Controls that affect the general appearance of dimension lines. 

• Stack Offset – Sets the space in the working units between dimension lines if 

the dimensions are stacked. 

• Relative Dimension Line - If off and the geometry moves, the dimension line 

location stays constant and the length of the extension changes. 

Extension Lines Controls that affect the placement of extension lines (also called witness lines or projection 

lines). 

• Enable – If on, extension lines are placed. If off, extension lines are not 

placed. 

• Offset – The distance, in text height units, between the start of the extension 

line and the element. 

• Extension – Sets the distance, in text height units, that the extension line 

extends beyond the dimension line. 

Terminators Controls that set the appearance and geometry of the default dimension terminators. 

Fit Options Controls that affect the general appearance or placement of text and terminators.  The Fit 

Options only apply to angular and linear dimensions. 

• Text/Terminator – Selects the minimum fit dependant on the text, terminator 

or combination. 

• Min. Leader – Sets the space, in text width units, between extension lines and 

dimension text. 

Tolerance Controls that affect the generation of tolerance dimensions. 

• Enable – If on, displays tolerances. If off, does not display tolerances. 

• Type – Sets the format for the tolerance.  

• Upper – Sets the upper tolerance limit, in working units. 

• Lower – Sets the lower tolerance limit, in working units. 

• Text Size – Sets the tolerance text size, specified as a multiple of the 

dimension text Height and Width. 

• Left Margin – Sets the horizontal space, in text height units, between 

tolerance text and dimension text. 

• Sep. Margin – Sets the vertical space, in text height units, between tolerance 

values.  
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Dimension with 

Leader 

Controls that affect the general appearance of dimension leaders. The location of a 

dimension value can be modified to something other than horizontal along the dimension 

line. How the dimension text visually identifies the dimension with which it is associated 

can also be modified. 

• Mode – None (default) displays dimension with no leader. On allows display 

of a leader with dimensions. Automatic places a leader with at line dependent 

on the Fit Option. 

• Type – Sets the type of leader line to display: None, Line, Arc, or Bspline.  

• Terminator – Sets the type of terminator to display: None, Arrow, Line, 

Circle, or Filled Circle.  

• Alignment – Sets the alignment of the dimension text:  Auto, Left, or Right.  

•  In-line Leader – If on, adds a horizontal line in front of the dimension text. 

Center Mark Sets the size of the center mark in radial dimensions. If set to 0, the center mark size is the 

active text height. If set to a number other than 0, the center mark size uses the working 

units. 

 

UNITS TAB 

The Units tab contains controls that affect the display format for units in dimension text. 
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TEXT TAB 

The Text tab contains controls that affect the placement and appearance of dimension text. 

 

SYMBOLOGY TAB 

The Symbology tab contains controls for color, style, and weight settings of dimension lines, extension lines, 

text, and terminator symbology. 
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ADVANCED TAB 

The Advanced tab contains all controls for dimension styles. Many of these controls are also found on other 

Dimension Styles tabs.  The Mode controls how advanced dimension styles settings are displayed. Edit lists 

all dimensions styles properties and values. Comparison compares the values of two dimension styles. 

Differences compare the values for two dimension styles and displays only properties with different values. 
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MODIFYING A DIMENSION ELEMENT 

Placing dimensions in design files is a simple procedure. Select the appropriate dimension tool and then identify the 

elements to dimension. After placing dimensions, they can be modified using various modification tools from the 

Dimensions, Groups Classic, Drop and Misc Dimensions toolboxes. The modifications covered here can be 

performed only on dimension elements; they do not work on dimensions that are placed as primitive elements. 

The symbology of a dimension element can be changed to the active settings or matched to an existing dimension 

element by using the  Change Dimension or  Match Dimension Attributes tools in the Dimensions 

toolbox located in the Drawing task.  The  Reassociate Dimensions tool, also found in the in the Dimensions 

toolbox located under the Drawing Task, can be used to drop the dimension elements into their individual 

components and vice versa. 

     

Dimension elements can also be converted into individual primitive elements by using the Drop Element  tool 

found in Drop task bar or toolbox accessed from the Groups task or toolbox accessed from the Main task bar.   

    

WORKING WITH DIMENSION TEXT 

Dimension Text can also be moved with the Modify Element  tool.  The Edit Text   tool in the 

toolbox, accessed from the Drawing task, is used to edit text in a dimension element. 

  

Dimension Text generated from the geometry of the element(s) dimensioned is represented by an asterisk (*) when 

in the Text Editor window.  Text placed before the asterisk precedes (and text placed after the asterisk follows) the 

text that is generated from the geometry of the element(s) dimensioned.  The asterisk can be deleted when editing 

dimension text. To restore the text that is automatically generated from the geometry of the dimensioned element, 

edit the dimension's text again and insert an asterisk. 

Note Text entered in the Text Editor window is not associative — it does not change when the dimension element 
is modified. 
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Exercise 13.1  Dimensioning an Element 

1. Open c:\e\projects\12345678901\roadway\dim1.dgn.  

2. Using the Window Area tool  from the View toolbar at the top of View 1, zoom into the first image 

to the left as shown below. 

 

3. From the Drawing task, right-click the Dimension task bar and select Open ‘Dimensions’ as Toolbox 

from the popup menu.  

 

4. Select the Dimension Element tool in the Dimensions toolbox. 
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5. From the Element Dimensioning tool settings, select FDOT_Dim dimension style from the dropdown 

and set all other settings as shown below. 

   

6. Enter a data point on the line that passes through location 1 enter a second data point at location 2 as 

shown in the figure below. A dimension is created which shows the length of the line. 

 

 Make sure that the line is highlighted as the selected element to dimension and not the location 
marker circle. Use the reset button during these exercises to make sure the correct element is being 
dimensioned.  

7. Enter a data point on the circle that passes through location 3, and then enter a second data point at 

location 4 as shown in the figure below.  

 

 Notice that the same tool that places a dimension for linear elements also dimensions the circle’s 
diameter.  
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8. Enter a data point on the arc that passes through location 5, and then enter a second data point at location 

6 as shown in the figure below.  This dimension indicates the radius of the fillet arc between the two 

lines.  

 

9. Enter a data point on the line that passes through location 7, and then enter a second data point at location 

8 as shown in the figure below.  

 

10. Leave MicroStation open. 
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Exercise 13.2  Dimension Options 

1. Continuing in c:\e\projects\12345678901\roadway\dim1.dgn. 

2. Enter a data point on the line at location 7 (do not reset or accept).  Note the message in the MicroStation 

status bar in the lower left hand corner:  

  

3. Without resetting or accepting, select the Label Line icon from the Element Dimensioning tool 

settings window.  Hover the cursor over the selected line 7 and note how the line’s distance and angle 

are now being labeled. 

                 

4. Change Angle and Distance to display Distance and Bearing. Select the MicroStation menu option 

Settings > Design File and select the Angle Readout category. 

5. From the Design File Settings dialog, set the Format to DD MM SS, the Accuracy to 0 and the 

Direction Mode to Bearing as shown below. Select OK to accept and close dialog. 
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6. Select the MicroStation menu option Element > Dimension Styles and select the Units tab of the 

Dimension Styles – FDOT_Dim dialog. 

7. In the Angles Format section, set the Display to DD^MM’SS” and the Accuracy to 0.  Note the changes 

turn to blue.  Select Style > Exit to close dialog. 

    

8. Hover over selected line 7 and note how the line’s Distance and Angle are now being labeled and how 

the dimensioning slides along the line for easy placement. 

 

9. Without resetting or accepting, select the Dimension Size Perp - Line icon from the Element 
Dimensioning tool settings window. Hover the cursor over the selected line 7 and note the line is being 

dimensioned perpendicular to itself. Select the line again and note how the dimensioning slides up/down 

and side to side for easy placement.  
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10. Reset to exit the selected command. 

11. Select the large circle at location 3 and note the icons shown in the Element Dimensioning tool settings 

showing the different ways to label a circle.  

  

12. Finally, note the Show Basic Options button (  ).  Clicking this displays the various options to place 

a dimension.  These options vary depending on the selected dimension tool. 

   

13.  Select ( ) to close the Element Dimensioning tools settings window. 
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Exercise 13.3  Placing Dimensions with Different Alignments 

1. Continuing in c:\e\projects\12345678901\roadway\dim1.dgn, open View 2. 

 

 

Note Use Zoom Out if all elements are not visible in the view. 

2. From the Dimensions - Task toolbox, select the Dimension Element tool.  If the Element 

Dimensioning tool setting is set for labeling circles, select one of the line segments and reset.  Note the 

change in the Element Dimensioning tool settings and select the Hide Basic Options arrow to 

minimize dialog. 

   

3. From the Element Dimensioning tool settings, select View from the Alignment drop-down menu. 
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4. Enter a data point on the line that passes through location 1, then enter a second data point at location 2.   

Note Even though the line is rotated at an angle, the dimension is not.  It continues to be aligned with the view’s 
y-axis.  

5. Select Drawing from the Alignment drop-down menu.  Enter a data point on the line that passes through 

location 3, then a second at location 4.  

            

Note Even though this dimension looks like the first dimension that was placed, its alignment is different.  If there 
was a rotated view, the dimension would have appeared rotated, instead of being aligned with the view.  

6. Select True from the Alignment drop-down menu. Enter a data point on the line that passes through 

location 5, then a second at location 6. This dimension is aligned with the element that is being 

dimensioned.  

 

7. Select Arbitrary from the Alignment drop-down menu.  Enter a data point on the line that passes through 

location 7, then a second at location 8.  Note how the dimension now follows the pointer, with the 

extension lines rotating to follow.  
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➢ Placing Associated Dimensions 

1. Open View 3 in c:\e\projects\12345678901\roadway\dim1.dgn.  

 

2. To create an un-associated dimension, click on the Active Locks icon in the MicroStation Status Bar 

and uncheck Association to disable. .  Select the Dimension Element tool and notice that the 

Association option in the tool settings is not available for selection.  

      

3. Enter a data point on the line that passes through location 1, and then a second at location 2.  
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4. To create an associated dimension, click on the Active Locks icon in the MicroStation Status Bar and 

select Association from the pop-up menu.  Select the Dimension Element tool and set the Alignment to 

View and check the checkbox to enable Association in the tool settings. 

       

5. Enter a data point on the line that passes through location 3, and then a second at location 4. Now the 

dimensioned lines will be used to demonstrate association. 

 

6. From the Main Tasks bar, select the Modify Element tool.   

 

7. Enter a data point near location 1, on the first line that was dimensioned. Move the pointer to the right, 

and place the end of the line approximately where the center of the line used to be. 

Note The unassociated dimension does not respond when the new end point is placed.  

8. Modify the length of the second line at location 3 the same way.  Note that the associated dimension 

updates to reflect the length change.  

  

Note It is recommended to place all the dimensions in a drawing using the same association lock setting to avoid 
having to make individual manual changes when needed. 
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➢ Placing a string of Dimensions  

1. Open View 4 in c:\e\projects\12345678901\roadway\dim1.dgn.  Use the pan function if elements are 

not centered. 

2. Select the Dimension Linear tool from the Dimensioning Task accessed from the Drawing Task  
Refer to the MicroStation Status Bar, which prompts for the action required next.  

   

3. To select the start of the dimension move the pointer over the corner at location 1. Enter a data point 

when the AccuSnap cursor appears. 

       

Refer to the MicroStation Status Bar, which prompts for the action required next. 

 

4. To select the dimension endpoint, use AccuSnap to enter a data point at location 3.  Refer to the 

MicroStation Status Bar, which prompts for the action required next. 
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5. To define the length of the extension line, enter a data point at location 2.  

6. For the next endpoint, use AccuSnap to enter a data point at location 4. 

7. For the next endpoint, use AccuSnap to enter a data point at location 5. 

  

8. Right-click to Reset and end command.  

Note MicroStation offers many options for placing dimensions. It can adapt the dimension itself on the fly so 
that it appears the way the user wants it.  

➢ Dimension Placement  

1. Continuing in View 4, select the Dimension Linear tool. 

2. Using AccuSnap, enter a data point at the intersection at location 6. 

3. For the dimension endpoint, use AccuSnap to enter a data point at the corner at location 5. 

4. To define the length of the extension line, enter a data point at location 7.  

5. Use AccuSnap and enter a data point at the intersection at location 5.   

6. Enter a data point at location 4. Notice that the dimension changes as the pointer moves away from 

location 5, towards the top of the screen.   

Note If the dimension text does not fit between the respective extension lines, MicroStation relocates it outside 
of the extension lines.  

7. Use AccuSnap and enter a data point at the corner at location 4.  Notice where MicroStation placed the 

dimension text. Because it would not fit inside the extension lines, it is positioned outside the area that 

was dimensioned. 

 

8. Right-click to Reset and end command.  
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➢ Dimensioning a Typical Section 

1. Open the file c:\e\projects\12345687901\roadway\Typsrd01.dgn and select the View Control to Fit View

. 

2. From the View Controls, select the Window Area  icon and window around the image at the top of 

the view as shown below. 

 

3. Select the Dimension Element tool from the Dimensioning task toolbox.  

4. Set Dimension Style to FDOT_Dim in the Element Dimension tool settings. 

 

5. Zoom In on the right side of the drawing and select the arc at the top of the curb then move over and 

place a data point at location 1. 

  

6. Zoom Out to see the entire drawing. 

7. Zoom In on the left side of the drawing. 
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8. Reset to return to the Dimension Element command. 

9. Select the small circle, and then a data point at location 2. 

  

10. Zoom Out to see the entire drawing.  

11. Select the Dimension Linear tool from the Dimensions toolbox. 

      

 

12. Place a data point at location 3 and then one at location 4 and then move the cursor upward. 

13. Define the length of extension line by placing a data point at location 5 and reset. 

14. Click the Select Multiple Elements icon in the Linear Dimensioning tool settings. 
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15. Draw a line from location 6 to location 7 and move the cursor downward. Notice that MicroStation has 

drawn all the dimensions.   

16. Now place a data point at location 8 to place the dimensions. 

 

17. Exit MicroStation. 
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14 INFORMATION & MEASURING 
TOOLS 

OBJECTIVES 

This chapter reviews the MicroStation information tool and measuring tools, including the: 

• Element Information Tool 

• Measure Tools 

• Message Center 

INTRODUCTION 

Placing elements at precise sizes and locations requires a way to measure and analyze the results.  This becomes 

more important as the user learns construction techniques that involve the interaction of different elements and tools. 

This chapter discusses the information and measuring tools, along with their settings. 

ELEMENT INFORMATION TOOL 

The Element Information tool ( ) allows the user to review and modify the attributes and properties of elements 

in design files.  The Element Information tool can be accessed from: 

➢ MicroStation menu option:  Element > Information 
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➢ Reset pop-up menu 

The Reset pop-up menu pops up when the Reset button is pressed and 

held.  If the Element Selection tool is active, some of the items in the menu 

are context-sensitive — that is, they operate on the element at the pointer 

location and/or on the selected element(s).  The options in this menu may 

change depending on the element selected. 

 

 

 

 

 

 

 

 

 

 

➢ Primary Tools toolbox  

 

In using the Element Information tool, when an element is selected, the Element Information dialog appears, 

displaying the attributes and properties of the selected element.  The selected element(s) are listed in the top 

frame. This dialog can be docked to the left or right edge of the application window.  
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With the Element Information active, the Key-in window can be used to sort the elements listed in the top 

frame: 

Key-in:  INFO ORGANIZEBY <NONE | NAME | LEVEL | COLOR | STYLE | WEIGHT> 

 

Depending on the selected type of element, the associated Group tabs:  General, Geometry, Material, 

Extended, Raw Data, Text Formatting, Text Contents, Symbol Properties, Links, Image, Color, Display Print, 

Pattern Parameters, Groups, and/or Attachment appear in the bottom frame. These Group tabs can be 

expanded or collapsed as needed.  The information displayed on each of these tabs pertains to the element 

whose list entry is selected in the top frame. 
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The Group tabs can be individually customized by right-clicking on the tab title and toggling on/off the 

display of any available field as shown below. 

  

While the Element Selection tool is active, a Quick Info dialog can be accessed in lieu of the Element 

Information dialog by holding the ALT key down and right-clicking on the selected element. The Quick Info 

dialog can be customized by right-clicking on the bottom edge of the Quick Info box and toggling on/off 

selections as shown below. 
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Many of the Element Information options (in bold) found under each tab can be used to change the properties 

of the selected element. Clicking in the fields will reveal an arrow that can be selected to open a dropdown 

of menu options.  If the field and its setting display in gray text, the value is read-only and cannot be modified. 

 

The Group tabs can be customized by right-clicking on the tab title toggling on/off the display of any 

available field as shown below <OR> by right-clicking on the bottom of edge of any Group dialog and 

toggling on/off the display of any field 
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MEASURE TOOLS  

The Measurement tools let users make real world measurements based on drawing elements. The measurements 

made with these tools are displayed in the Status Bar in the units and format set in the Design File Settings dialog 

under the Working Units category.  

  

The MicroStation steps for measuring are similar to the steps for placing elements. First, choose the tool to be used 

and then follow the prompts to choose the necessary elements or locations involved in the measurement.  The 

MicroStation Measure toolbox can be accessed from the Main task bar <OR> with the focus on Home type “9” for 

the dropdown Measure task menu. 

    

  

Measure 

Distance 

Measure the distance(s) along an element, cumulative distance from a data point, 

perpendicular distance between an element and a data point or minimum 

distance between two elements.  The tool settings reports the last distance 

measured. 

 

 

Measure 

Radius   

Measures radius elements of a circle, circular arc, cone, cylinder or the axes of 

an ellipse or elliptical arc. The tool settings reports the last measured primary 

radius and diameter. 
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Measure 

Angle  

Measures the angle between two lines. The tool settings reports last angle 

measured. 

 

 

Measure 

Length 

Measures the overall length of a selected element. The tool settings reports the 

last length measured and the angle of the last line measured. 

 

 

Measure 

Area 

Measure the area and perimeter of a shape, ellipse, or complex shape and to 

analyze mass properties. 

 

 

Measure 

Volume 

(3d Files 

Only) 

Measures the volume enclosed by an element or a set of elements and analyzes 

mass properties.  
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MESSAGE CENTER 

MicroStation supports and stores a running log of system messages. The open field located next to the Selected tool 

> prompt box on the Status Bar is the Message Center.  Clicking on this field opens the Message Center 
window, containing system message information and any further description about the message if applicable, such 

as, the last measurement taken.  This window can be resized as a whole on each pane from within. 

 

  

The Message Center is used to review error, warning and information messages previously displayed in the Status 

Bar. The default maximum number of messages saved for display in the Message Center is 50.  

To change this, right click on the Message Center in the Status Bar, select Properties from the pop-up menu, and 

change the number of messages to save in the messages field.  

           

The Message Center is bound by the current MicroStation session and is cleared upon the closing of the design file.  

The running log can be saved to a text file by right-clicking on the Message Center window or on the Status Bar 

field and selecting Save Messages… from the pop-up menu. 
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Exercise 14.1  Using the Element Information Tool 

1. Open the file named c:\e\projects\12345678901\roadway\dsgnrd01.dgn. 

2. From the Primary tool bar located at the top of the application window, select the References  icon 

and ensure that the  display for TOPORD01.dgn and Utexrd01.dg are unchecked as shown below.  

Close the References dialog. 

 

3. Use the Window Area view tool to zoom into the hatch area near station 232+00 near the first 

intersection. 

4. Using the Element Selection tool, select the previously hatched element as shown below. 
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5. Select the Element Information  icon from the Primary Tools tool bar <OR> the MicroStation 

menu option Utilities > Key-in and enter ANALYZE ELEMENT.   

Note Using the Key-in results in the display of a prior version of the Element Information window. 

 

Note The element information is grayed out; no changes are allowed at this level within a Complex Shape.  Only 
when selecting the Complex Shape are any attributes open for changes. 
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6. Select Shape and modify the Level to CurbBack by making the selection from the dropdown arrow. 

 

7. Place a data point in the design file to deselect and notice the changes in the element symbology.   

8. Close Element Information dialog. 
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Exercise 14.2  Using Measure Distance Tool 

➢ Measure Distance between Two Points 

1. Continuing in the same file, from the Primary tool bar at the top of the application window, select the 

References   icon and check the display  column for TOPORD02.dgn. 

 

2. Locate the end blue building towards the end of the TOPORD02.DGN reference file beyond the end of 

the alignment as shown below. 
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3. From the Main task bar, select the Measure Distance  tool <OR> with the focus on home, type 

“9” “1”. 

 

4. Set the Method option to Between Points as show below. 

  

5. Snap to the left end of the line string, then to the right end of the line string. Notice the Distance reported 

in the tool settings and in the MicroStation status bar.  Right click to end process. 
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➢ Measure Distance Along an Element  

1. Continuing at the same location, set the Method option to Along Element in the Measure Distance 

Tool Settings window. Notice the MicroStation message prompt to Identify element in the Status Bar. 

  

2. Snap to the left end of the line string, then to the right end of the line string. Notice how the line string 

highlights and the Distance updates in the Measure Distance tool settings as well as in the 

MicroStation Status Bar and in the Message Center.   

  

  

  

3. Close Message Center.  Right click to end process. 
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➢ Measure Distance Perpendicular 

1. Continuing at the same location, set the Method option to Perpendicular in the Measure Distance 

Tool Settings window.  

 

2. Snap to the middle of the line string as shown below.  Notice that a line attaches perpendicular to this 

line string and moves with the cursor. 

 

3. Snap to the lower left corner of the building as shown below and data point to accept.  Notice the 

Distance in the Measure Distance tool settings updates.   

  

4. Slide the cursor along the wall of the building and place data points at various intervals.  Notice the 

Distance updates each time.  Right click to end process. 
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➢ Measure Distance Minimum Between 

1. Continuing at the same location, set the Method option to Minimum Between in the Measure Distance 

Tool Settings window. Notice the MicroStation message in the Status Bar prompting to Identify first 

element. 

  

 

2. Select by placing a data point anywhere on the line string.  The line string will highlight and the message 

in the MicroStation Status Bar confirms selection and prompts for the next step to Identify 2nd 

element/Reject.  

 

3. Select the building by placing a data point anywhere on the shape. 
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4. The minimum distance is drawn and highlighted between the line string and the building.  Notice the 

Distance updates in the tool settings is the same as the previous exercise. Right click to end process. 

Exercise 14.3  Using Measure Radius Tool 

1. From the MicroStation menu, select Edit > Find/Replace text, enter 257 for Find: field and click Find.  

MicroStation will automatically relocate to the intersection located at Station 257+00.00.  Close the 

Find/Replace text dialog. 

 



Chapter 14 ________________________________________________ INFORMATION & MEASURING TOOLS - Message Center 

14-18 © 2018 FDOT FDOT Bentley CADD Essentials  

2. From the Measure task toolbox, select the Measure Radius tool. 

 

3. Notice that there are no options to set in the Measure Radius tool settings and the MicroStation Status 

Bar prompts to Identify Element. 

  

4. Select an arc with a data point and click again to accept the element choice.  Notice the results in the 

tool settings. Right click to end process. 

  

  



INFORMATION & MEASURING TOOLS - Message Center ________________________________________________ Chapter 14 

FDOT Bentley CADD Essentials © 2018 FDOT 14-19 

Exercise 14.4  Using Measure Angle Tool 

1. Continuing at the same location, from the Measure task toolbox, select the Measure Angle  . 

 

2. Accept options as set in the Measure Angle Between Lines tool settings. 

 

3. Per the MicroStation prompt in the Status Bar, identify the first element by selecting one of the 

intersection lines as shown below.  The selected line will highlight. 
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4. Per the MicroStation prompt in the Status Bar, identify the second element by selecting the other 

intersection line as shown below.  The selected line will highlight. 

 

 

5. The Angle information automatically updates in the Measure Angle Between Lines Tool Settings 

window.  Notice that the Angle measurement matches the text placed in the design file.  Right click to 

end process. 

Exercise 14.5  Using Measure Length Tool 

1. Continuing in the same location, from the Measure task toolbox, select the Measure Length  . 

 

2. From the Measure Length tool settings, set Tolerance (%) to 0.1 as shown below. 
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3. Identify element by selecting one of the lines as shown below. Notice that the Length is the entire length 

along the element. 

 

4. Check on the Mass Property and Display Centroid options in the Measure Length Tool Settings 

window.  Select the arc as shown below.   

  

5. Notice a new Mass Properties dialog displays with additional information and a  (Centroid) appears 

in the middle of the arc. 

 

6. Close the Mass Properties dialog.  Right click to end process. 
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Exercise 14.6  Using Measure Area Tool 

➢ Measure Area Element 

1. Continuing in the file named c:\e\projects\12345678901\roadway\dsgnrd01.dgn. 

2. Return to the crosshatch area near Station 232+00. 

 

3. From the Measure task toolbox, select the Measure Area . 

 

4. From the Measure Area tool settings, set Method to Element and match all other settings as shown. 

 

5. Identify the element by selecting the shape as shown below.  Notice the results in the toolbox. Right 

click to end process. 
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➢ Measure Area Fence 

1. Continuing in the file named c:\e\projects\12345678901\roadway\dsgnrd01.dgn at the same location. 

2. From the Main task bar, select the Place Fence  tool. 

    

  

3. Set Fence Type to Block and Fence Mode to Inside, then place a fence around the shape in the design 

file as shown below. 

 

 

4. From the Measure task toolbox, select the Measure Area . 
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5. From the Measure Area tool settings, set Method to Fence, data point in the design file to accept the 

fence.   

 

6. Notice the Tool Settings measurements update to the fenced Area, along with the MicroStation Status 

Bar. 

7. Select the Element Selection tool from the Main task bar and place a data point in View 1 to clear the 

placement of the Fence and Measure Area tool settings. 
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➢ Measure Area Intersection 

The Measure Area tool has several other methods that are very similar in how they work.  Due to time 

restraints we will only do one exercise for the Intersection, Union, and Difference methods.  

1. Continuing in the file named c:\e\projects\12345678901\roadway\dsgnrd01.dgn at the same location.   

2. Pan upward in the design file until View 1 to a location void of any elements. 

3. From the Attributes tool bar, change the Level setting to Concrete. 

 

4. From the Drawing task bar, select the Place Block tool from the Polygons task bar and place a block in 

the design file. 

  

5. From the Drawing task bar, select the Place Circle tool from the Ellipses toolbox and place a circle 

overlapping the block as shown below. 

   

6. From the Measure task toolbox, select the Measure Area tool and set Method to Intersection and 

Tolerance (%) to 0.1.  

7. Select the block element, then the circle element and place a 

data point in the design file to accept.  The Measure Area 

tool settings measurements update as shown below. 

Note Measurements will vary with various blocks and circles drawn. 
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➢ Measure Area Flood 

1. Continuing in the same location, from the Main Classic task bar, select the Place Circle tool from the 

Ellipses task bar and place a circle within the block as shown below. 

 

2. From the Measure Area tool settings, set Method to Flood and check the Locate Interior Shapes option. 

3. Enter data point inside area shown below.  Notice the highlighted area. Enter another data point to 

accept and update measurements within the Measure Area tool settings. 

    

4. Do the same exercise without the Locate interior shape checked on.  Notice the difference in the area. 

  

5. Exit MicroStation. 
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15 REFERENCE FILES, RASTER 
IMAGES & POINT CLOUDS 

OBJECTIVES 

This chapter reviews the MicroStation Referencing tools.  Topics include: 

• What is a Reference File? 

• References  

• Attaching References 

• Working with References 

• Raster Images 

• Point Clouds 

INTRODUCTION 

In the past designers were often asked to use an existing drawing as a backdrop as they created new drawings.  They 

taped the existing drawing down onto their drafting table, and then taped a clean sheet (new design file) on top of 

the existing drawing (reference).  This procedure of working over a backdrop is still used today with automated 

techniques.  In today’s industry, individual members of a project team share electronic data files rather than the 

actual drawing sheets they used to share.  

Several companies may be involved in producing a plan sheet which includes many information types such as 

Survey (existing topography), Proposed Construction, Drainage and Right of Way. Design files are passed back and 

forth between all team members and all the pieces of the puzzle must fit together. Assume the responsibility for the 

Proposed Roadway construction portion of the plan.  Since the design must fit within the Right of Way and meet 

the Existing Construction at the beginning of the project, the location of these elements must be known.  In this 

case, the topographical plan must be seen in the background as a reference while designing the roadway plan.  

MicroStation does this with references.  

MicroStation referencing tools allow the user to view other models as work is done on the active model, much the 

way overlays are used in the real world. With overlays, work is done on the top overlay, while referring to the 

information on one or more overlays below. 

WHAT IS A REFERENCE FILE? 

A Reference File is a model attached to and displayed with the active model for printing or construction purposes. 

A model that resides in the open DGN file, another DGN file, or a DWG file can be attached as a reference file. 

Elements in a reference file display as though they are in the active model.  Although elements cannot be 

manipulated in a reference, users can snap to and even copy elements in a reference into the active model.  Reference 

files cannot be modified. A MicroStation reference is analogous to an AutoCAD external reference (XREF) or an 

AutoCAD overlay. 

MicroStation allows for an unlimited number of files to be referenced to a design file, as the operating system and 

hardware limit the number of reference files allowed.  MicroStation, AutoCAD and DXF files can be referenced 

into any MicroStation drawing.  When a file is referenced, a link is established to it.  If the referenced file is edited, 

then the file that it is referenced to updates to reflect those changes.  
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REFERENCES  

The References dialog attaches and detaches referenced models to an active design model, has a number of settings 

that control the attachments and displays of references in a model and allows for the selection of reference tools.   

The References dialog can be accessed from the MicroStation menu option File > Reference <OR> by selecting 

the References icon   from the Primary tool bar. 

  

 

 

The References dialog can also be accessed by right clicking on the active file listing in the Level Display dialog, 

also located in the Primary tool bar. 
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TOOLS  MENU 

The References Tools menu option provides tools for working with references. 

Many of these tools can also be accessed by selecting the Tool icons below the 

References menu bar  

 

SETTINGS MENU 

The References Settings menu option provides links to adjust settings for the 

attached reference files. 

 

LIST BOX (RIGHT-CLICK) MENU 

Right-clicking on a file name in the References List Box opens a popup menu that directly accesses options 

available in the Tools and Settings menus: 
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SHOW HIERARCHY AND LIST BOX 

 

The Show Hierarchy icon  is a toggle to display a tree showing the active design file with all attached 

references. References that have other references attached to them (nested references) are listed in black text, 

while references with no attached references are listed in gray text.  

If a reference in the hierarchy has a nest depth value of 1 or more, the reference can be selected to update the 

References List Box to include only the references that are attached to the selected reference. 

When toggled off, the arrow button next to the Show Hierarchy icon can be used to list the active file and 

any attached references for selection to update the References List Box. 

The References List Box displays columns containing many settings. The columns can be modified by the 

user, either by clicking them (for toggle settings) or by clicking them and selecting a new setting or value.   

The columns displayed can be modified by right clicking on the column header and selecting or deselecting 

column options as shown. 
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REFERENCE TASK ICONS 

 

The References task icons are used to: Attach referenced models to the active model; Control the 

positioning, scaling, clipping, and orientation of attached referenced models; and Detach referenced models 

from the active model.  These icons can also be found in the References toolbox that is accessed from the 

MicroStation menu option: Tools > References > Open as Toolbox. 

 

Attach Reference Opens the Attach Reference dialog, which allows for the 

attachment of a model to the active model. 

 

Clip Reference Uses a boundary, such as an element or fence, to clip a reference. 

The area of the reference outside the boundary is not displayed.  

 

Mask Reference Covers a portion of a reference that is inside a boundary. More than 

one clipping mask can be specified for a model.  

 

Delete Clip Deletes an existing clipping mask. 

 

Set Ref Back Clip 

Z (3D Files Only) 

Sets the back clipping plane, a boundary used to clip a referenced 3D 

model.  The position of the clipping plane is measured along the z-

axis.  Only the area in front of the back clipping plane is displayed. 

 

Set Ref Front Clip 

Z (3D Files Only) 

Sets the front clipping plane, a boundary used to clip a referenced 3D 

model. The position of the clipping plane is measured along the z-

axis.  Only the area behind the front clipping plane is displayed.  

 

Reload Reference Reloads and redraws a reference, allows the user to view changes 

made to the referenced model since it was last attached or reloaded.  

 

Move Reference Moves the location of the reference file in the design file.  

 

Copy Reference Copies the reference file. 

 

Scale Reference Resizes the reference file. 

 

Rotate Reference Rotates the reference file. 

 

Mirror Reference Reflects a reference file about a horizontal or vertical axis. 

 
Copy/Fold 

Reference 

Copies the selected reference file, and then attaches a view by folding 

it about an orthogonal axis or a defined line. 

 

Set Reference 

Presentation 

Sets options for displaying a reference file, such as Wireframe, 

Hidden Line, Filled Hidden Line and three types of shading. 

 
Detach Reference Detaches the reference file from the active model. 
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INFORMATION PANEL  

The References Information Panel, located at the bottom of the References dialog, displays the various 

settings for an attached reference selected in the References List Box.  The options displayed in the 

Information Panel can be modified by right clicking anywhere on the panel and selecting or deselecting any 

option from the popup menu. The table below describes each option. 

 

Scale 
  Displays and sets the ratio 

of master units in the active model to the master units in the attached model.  

Rotation 
  Displays and sets the rotation for the selected reference. 

For 2D files, enter the rotation angle for the z-axis only. In 3D, enter the rotation angles 

for the x-, y- and z-axes. 

Offset 
  Displays and sets the 

distance between the global origin of the reference from the global origin of the parent 

file, measured in units of the parent file. If the parent is 2D, Offset X and Y values are 

displayed. If the parent is 3D, Offset X, Y, and Z values are displayed. 

Nesting 
 

Nesting displays and sets how nested references (references attached to references) 

are handled for the selected attachments.  When working in a DWG or DXF file, live 

nesting is always on with no limit to nest depth. Therefore the nested attachment and 

Depth items are disabled. To control the display of nested attachments, use the Ignore 

Attachment When Live Nesting icon. 

Overrides controls how override settings are saved for nested references. For a 

specific nested reference, overrides controls the settings for reference display, locate, 

snap, raster reference display, and level display.  

Depth sets the number of levels of nested references that are displayed. Models can 

have their own referenced models, which, in turn, can have more referenced models.  

If Depth is set to 0, only the selected model is attached to the master model; models 

referenced to the selected model are ignored. 

New Level 

Display 
  Specifies whether a reference displays new 

levels. The setting also applies to new levels in nested references that are attached to 

the reference. 

Toggles 
 These toggles are Attachment 

Settings icons that correspond to columns in the References List Box, as well as to 

icons on the Reference Attachment Settings dialog.  If an icon is highlighted, the 

setting is on. Click the icons to toggle the settings on or off. 

Georeferenced  Sets the georeference mode. When a reference is 

attached in Reprojected mode, the current Reference Reprojection Settings are copied 

into the reference attachment and stored so every user who opens the master file uses 

the same Reprojection settings and thus, gets the same results. 
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HILITE MODE 

The Hilite Mode controls whether the selected references are highlighted 

and/or surrounded by a border. 

• None – Selected references are not highlighted in any way. 

• Boundaries – Places a dashed border around selected 

references. 

• Hilite – Highlights selected references. 

• Both – Places a dashed border and highlights selected references. 

ATTACHING REFERENCES  

MicroStation referencing tools allow viewing of other models while working on the active model, much the way 

overlays are used in the real world. With overlays, work is done on the top overlay, while referring to the information 

is done on one or more overlays below.  Models can be referenced from the open DGN file, or from other DGN's 

that may or may not currently be opened by other users. Similarly, other users can reference the active model. 

Referencing is a powerful tool in a multi-discipline office, in particular, where many people are working on different 

aspects of the same project. 

The References menu option: Tools > Attach, <OR> clicking the Attach Reference  icon, opens the Attach 
Reference dialog for selecting model(s) to attach to the active model.  Multiple files from multiple locations may 

be attached at the same time by selecting and adding to the Selected Files box.  

Note The Selected Files box is hidden by default and must be expanded by clicking the arrow just below the 
Files of type: setting as shown below. 

 

• Save Relative Path - If on, the path for the reference is saved with the file name. 

• Attachment Method - Attaches the reference by the method selected.  

• Interactive – Opens the Reference Attachment Settings dialog to manually adjust settings. 

• Coincident – Coordinates of the referenced model's design plane are aligned with those of the active model without any 

rotation, scaling or offset.  
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Upon completing the selection of attachments the Reference Attachment Settings dialog opens to set the 

attachment settings for the reference(s) selected.  If multiple files were selected, this dialog will open for each one 

to set the attachment settings.  

 

File Name Shows the reference's name. 

Full Path Shows the full file path for the reference. 

Model Drop down list of the models contained in the reference. This is used to select the model to be attached 

to the master model. 

Logical Name Sets the logical name of the model.  Since the same model can be attached many times, the logical 

name helps distinguish between references. 

Description Sets the optional description for the model. The maximum valid description is 40 characters. 
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Orientation Sets the view of the model being attached. The list may also include saved views and named fences. 

More than one orientation can be selected to attach. 

Coincident - Aligns the references with regard to design plane coordinates only. 

Coincident World - Aligns the references with the active model with regard to both Global Origin and 

design plane coordinates.  FDOT recommends using the Coincident World option when attaching 

reference, to ensure files from an older standard line up correctly when attached to a file with the current 

working units. FDOT CADD files created in MicroStation J have different resolutions than 

MicroStation V8. 

Standard Views - Identifies the views that can be used to display the reference: Top, Front, Right, 

Isometric, Bottom, Back, Left, or Right Isometric. If the file being attached is 2D, only the Top view 

can be selected. 

Saved Views - Identifies the saved views that are available in the reference. 

Named Fences - Identifies the named fences that are available in the reference.  When a named fence 

is used to attach a reference, all levels are on. If a particular level is desired, then use the named fence 

as a clip volume for a saved view in the reference, and select the saved view. 

Detail Scale Represents the Master:Ref scale in terms of the sheet scale.  For example, if the sheet scale (annotation 

scale) is 1/8” = 1´ and a detail reference of scale 1/4” = 1´ is to be placed, select the new scale from the 

Detail Scale drop-down list. It automatically computes the Master:Ref scale as 2:1. 

When attaching a reference (a design or drawing model) into a sheet model, the referenced model's 

annotation scale is applied as the detail scale, and the Reference Scale (Master:Ref Scale) is calculated 

from the referenced model's annotation scale and the active model's annotation scale. 

Scale 

(Master:Ref) 

Sets the ratio of the master units in the active model to the master units in the attached model.  

Named 

Group 

Identifies a named group used to limit the elements displayed in the reference. 

Revision If Design History is on in the referenced model, allows for the choice of the revision to reference. 

Level  (DWG Work Mode only) Sets the level for the reference to be attached.   

In an AutoCAD DWG or DXF file, each XREF or layout viewport is placed on a specific layer.  When 

a DWG file is opened in MicroStation, XREFs and layout viewports are treated as references, and 

placed on the same level (layer). To modify a reference's level, open the References dialog, double-

click on the reference to open the Attachment Settings dialog and modify the Level setting.  If a level 

is frozen, references on that level are not displayed. 

Nested 

Attachments 

Determines how nested references (the references attached to the model selected as the reference) are 

handled for this reference attachment.   

No Nesting - Nested references are ignored for this attachment. 

Live Nesting - The hierarchical structure of any nested references are maintained when attaching the 

reference. The child references are displayed if the nest Depth is set high enough and it does not have 

the Ignore Attachment When Live Nesting setting turned on. 

All of the nested attachments display in the view window; however only the parent reference in the 

References list box. To see the hierarchy of nested references, use the Show Hierarchy icon on the 

References dialog. 
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Depth Sets the number of levels of nested references that are displayed. Child references can have their own 

referenced models, which, in turn, can have more referenced models, and so on.   

If Depth is set to 0, only the model is attached to the master model; referenced models in the referenced 

model are ignored. 

Display 

Overrides 

Controls how overrides are saved for nested references. For each nested reference, overrides allow for 

the control of the settings for reference display, locate, snap, raster reference display, and level display. 

New Level 

Display 

Specifies whether a reference displays newly created levels. The setting also applies to new levels in 

nested references that are attached to the reference. 

Global Line 

Style Scale 

Controls the scaling of custom line styles. Every model can have a global line style scale factor that is 

applied to every line style within the model. This factor is set in the Element Attributes category of the 

DGN File Settings dialog (Settings > Design File).  

Alternatively, use the ACTIVE LINESTYLESCALE key-in to set the global scale factor for custom 

line styles. The specified scale factor has the same effect as the Scale Factor setting in the Line Styles 

dialog. 

Synchronize 

with Saved 

View 

This check box, when turned on, will synchronize saved view attachments with the original saved view.  

In order to change the appearance of a reference, the saved view that it is synchronized with must be 

modified. This is to ensure fidelity of display properties such as view attributes, level masks, clip 

volume, display styles and others. 

Toggles Defines settings for the reference.  The icons correspond to columns in the References List box and 

Information Panel.  If an icon is pressed, the setting is on. Click the icons to toggle the settings on or 

off. These are the same toggles found on (and described earlier) the References Information Panel.  

Drawing Title When attaching a reference on a sheet, a drawing title can optionally be created. A drawing title 

describes a drawing on a sheet. 

Create – Toggle to turn on the option to create a drawing title. 

Name – Enter a name for the drawing title, when Create is toggled on. 

WORKING WITH REFERENCES 

CLIPPING AND MASKING REFERENCES 

The user can control the reference display more precisely by using the clipping tools: 

• The Clip Reference tool allows the use of a boundary, such as an element, cell, or fence, to clip 

a reference. When a reference is clipped, the area of the reference outside the selected boundary 

is not displayed. 

• The Clip Mask tool allows the use of a fence to cover or not display a portion of a reference. 

Reference elements display only inside the clipping boundary and outside all clipping masks. Both clipping 

boundaries and clipping masks are on the same reference tool to control the display more precisely.  With 

the Boundary Display attribute turned ON in the View Attributes dialog, reference clip and clip volume 

boundaries display for that view. Reference clipping is defined relative to the world coordinates, and the 

clipped volume will therefore remain the same in all views.  The boundaries of a saved view can be used as 

the clipping boundary when a reference is attached. 
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MANIPULATING REFERENCES 

Users can manipulate references with the standard manipulation tools, or perform these tasks with tools 

specifically designed for reference manipulation.  Whichever method the user employs, the manipulation is 

for the reference attachment as a whole.  Individual elements cannot be manipulated in a reference unless it 

is changed to the active model.  

When changing the active model to a referenced model, it will appear as it was saved (Save Settings). There 

are two simple methods to activate a reference while maintaining the current view orientation: 

• Temporarily activate the referenced model in-place. Use this method when snapping to 

elements in the active model. 

• Make the referenced model the active model by exchanging to it. Use this method when 

focusing only on that model. 

USING STANDARD TOOLS TO MANIPULATE REFERENCES  

Users can manipulate a reference with MicroStation standard manipulation tools such as Move, Copy, 

Rotate, and Scale, treating the reference attachment as an element for the purpose of the manipulation.  When 

attaching references, the user can choose to enable the Treat Attachment as Element for Manipulation setting, 

or enable/disable it later by clicking on the relevant column in the References dialog.  

 

When the setting is:  On — manipulate a reference by snapping to any of its elements, or its boundary.   

Off — manipulate a reference only by snapping to its boundary 

The reference´s clip boundary can be manipulated even if the Treat Attachment as Element for Manipulation 

setting is off. This can be done by turning on the Boundary Display setting in the View Attributes dialog and 

selecting the boundary. However, in this case the boundary should be selected only by using the Element 

Selection tool and not by dragging or fence selection. 

USING REFERENCE TOOLS TO MANIPULATE REFERENCES 

Tools in the Reference Task allows for manipulation of references directly. The user can use these tools 

whether or not the Treat Attachment as Element for Manipulation setting is enabled.  

Every reference manipulation tool can contain any or all of the following tool settings. 

• If Move Boundary with Reference is on, then any clip boundaries/masks are manipulated with 

the reference. If this setting is off, then the reference is manipulated, while the clip 

boundaries/masks remain static. 

• If Use Reference Dialog List is turned on, the manipulation works on the models selected in the 

References dialog. 

• If a fence exists and Use Fence is turned on, any models that are in the fence are manipulated. 

If a selection set has been created, manipulation works on the models in that set. 
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TEMPORARILY ACTIVATING A REFERENCE FOR IN-PLACE EDITING 

A reference can be edited in-place from within the active model by first temporarily activating the reference. 

To return to editing the active model, the activated reference must be deactivated. 

To activate a reference for in-place editing by element selection: 

1. Right-click on an element in the reference. The popup menu will display. 

2. From the popup menu, select Activate. 

To activate a reference for in-place editing from References dialog: 

1. From the References dialog, right-click on an entry in the list box.  The popup menu will display. 

2. From the popup menu, select Activate. 

The reference cannot be activated if:  the display of the reference is turned off; the reference is open in another 

session; it is a perspective reference attachment; the display style is set to True Hidden Line; the orientation 

is Geographic Reprojected; the master file is read only and the reference is to another model in the master; 

the file format is anything other than V8 DGN, DWG, or DXF. 

When activating a reference, only operations on the activated reference are permitted and are locked from 

being edited in another session.  By default, all elements in references above the activated reference in the 

file hierarchy, as well as the active model, are displayed with an override color.   

The activated reference will automatically deactivate when another is activated.  DGN Library data, such as 

Levels or Level Filters, is not available. 

EXCHANGING TO A REFERENCES 

Temporarily activating a referenced model for in-place editing is the advisable method when maintaining the 

current view orientation and still be able to snap to elements in the active model.  There may be times when 

the current view orientation needs to be maintained, but focus exclusively on the referenced model.  In this 

situation, the Exchange option may be preferable.  

To exchange the referenced model for the active model: 

1. In the References dialog, select the reference then choose Tools > Exchange. 

2. Right-click the reference in the References dialog, then select Exchange from the pop-up menu. 

3. With the Element Selection tool, point at the referenced element and choose Exchange from the 

Reset pop-up menu. 

4. Use the key-ins REFERENCE EXCHANGE <file_name, model_name>, or XD= <file_name, 

model_name>.  

When using the key-ins, including the file name, model name, is optional. When using a key-in to exchange 

to a reference: 

1. Select the reference graphically (by not specifying a file name, nor selecting a reference in the 

References dialog). 

2. Include the reference filename and, where necessary, model name. 

3. Select the reference in the References dialog, prior to using the key-in. 

MERGING REFERENCES INTO THE ACTIVE MODEL 

The contents of one or more references can be merged into the active model.  The levels of elements in the 

attached reference are copied to the merged file only if they do not exist in the active model. Settings located 

in the MicroStation option: Workspace > Preferences under the Reference category control how levels are 

handled.   

Note Only the displayed elements in the reference are merged into the active model. 
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RASTER IMAGES 

Images of various formats, from monochrome to full color, can be opened and displayed using Raster Manager. 
Single images, or groups of images, can be set to display in one or more DGN file views. MicroStation drawing and 

annotation tools still can be used in views that display raster images. The list box in the Raster Manager dialog 

displays a list of all attached image files. The size of the list box can be set by dragging the horizontal/vertical edges, 

or the corners of the dialog. When the number of images in a list is larger than the number of lines displayed, a 

scroll bar appears to scroll up and down the listing. 

The location, display order, and various other settings of previously attached raster image files can be modified. 

Changes can be made via the Element Information dialog, the Modify tool, or the attachment information section 

of the Raster Manager dialog. Additionally, the Warp tool allows a raster image to be fit (warped) to a particular 

shape.  

When displaying a raster image file in a DGN file, it is attached in a Raster Reference Attachment. When a raster 

attachment is modified with Raster Manager, no changes are made to the original file, just to its attachment 

information in the DGN file. 

RASTER MANAGER 

The Raster Manager utility allows for the control and manipulation of raster images. The Raster Manager 
dialog, along with the Raster Display and Raster Control toolboxes control all aspects of attaching and 

manipulating raster image files.  

Raster Manager controls the display of one or more image files within a DGN file view. Raster attachments 

are treated as any standard element. The names of all attached image files (for all views) are displayed in the 

Raster Manager dialog. Information about the image files is stored with the DGN file. Warping, mirroring 

and resizing parameters are also stored in the DGN file's raster attachment. If the image is detached, these 

settings are deleted.  

Raster Manager is accessed from the MicroStation menu option: File > Raster Manager.  

 

Raster Display and Raster Control tools can be accessed by selecting Tools > Raster > Open as ToolBox  
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• Raster Display Toolbox – The Raster Display toolbox contains tools to change the display 

order of overlapping raster images, fit images to a view, display images at 1:1 resolution, or 

change their contrast/brightness settings. It is contained in the Raster toolbox, or may be opened 

separately by selecting Tools > Raster > Raster Display. 

• Rater Control Toolbox – The Raster Control toolbox contains tools to open the Raster 
Manager dialog:  to attach, select, modify or mirror images, and to clip, modify or remove a 

clipping polygon for a raster image. It is contained in the Raster toolbox, or may be opened 

separately by selecting Tools > Raster > Raster Control. 

The display of raster image files that have been attached to a design file may be modified in various ways. 

Included in Raster Manager are the tools that: 

• Clip, or crop an image's display 

• Mask off an area within an image 

• Modify or remove a clipping polygon 

• Move, and/or resize an image 

• Warp an image to fit an area in the design 

• Draping and rendering images 

• Re-project images using a different geocoordinate system (GCS).  

When a raster attachment is modified with Raster Manager, no changes are made to the original file, just 

to its attachment information in the design file. To keep warping, mirroring and resizing modifications, a new 

file must be created by choosing Save As in the file menu with the Option > Resample toggle set to yes. 

Clipping and transparency settings are not exported when an image is re-sampled. By default, these settings 

are kept in the design file attachment and are lost if the image is detached. 
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Exercise 15.1  Reference File Attachment 

1. Open the file named c:\e\projects\12345678901\roadway\planrd04.dgn, which is a blank file. 

2. From the Primary Tools toolbox, open the References dialog by selecting the References icon   

 

3. <OR> from the Menu Bar, select the File > Reference dropdown option. 

 

4. In the References dialog, select the Attach Reference icon .   

5. In the Attached Reference dialog, ensure that the Files of type: is set to CAD Files 

(*.dgn;*.dwg;*.dxf); expand the Select Files list box by clicking the arrow below the Files of type;  set 

the Attachment Method to Interactive; navigate to the c:\e\Projects\12345678901\roadway directory 

and select the algnrd01.dgn file to attach as a reference.  Click Open.  
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6. From the Reference Attachment Settings dialog, set the Model to ALGNRD50 from the drop down 

arrow; enter Alignment for the Logical Name; and ensure the remaining settings are set as shown below.   

Note The Model dropdown list is populated based on the file selected. 

   

 

7. Click OK to accept. 
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8. From the View Control at the top of View 1, select the Fit View  icon. Notice the elements that were 

added to the file. 

 

9. Repeat the process above with the file dsgnrd01.dgn in the same folder, and utexrd01.dgn and 

utprrd01.dgn  located in the Utils folder this time. Set the Logical Name to Design, Existing Utils, and 

Proposed Utils respectively and accept all other default settings in the resulting Reference 
Attachment Settings dialog. Notice the elements that were added to the file. 

 

 

10. Close the References dialog. 
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Exercise 15.2  Border Cell Placement 

1. Continuing in the same file, from the MicroStation menu, select Edit > Find/Replace text. Enter 257 

for the Find: field and click Find.  MicroStation automatically zooms into the intersection located at 

Station 257+00.00.  Close the Find/Replace text dialog and click OK when the Search Dismissed 

dialog displays. 

   

2. From View 1, zoom out to view the intersection as shown below. 

 

3. From the Drawing task bar, select Place Active Cell.  
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4. From the Place Active Cell tool settings, attach the Roadway cell library by clicking the magnifying 

glass   next to the Active Cell field to open the Cell Library dialog. From the Cell Library menu, 

select File and then select Roadway.cel from the dropdown list. The Cell Library dialog populates with 

the content of the selected cell library. 

 

5. From the Cell Library dialog, double-click on the Name list box title to sort by Name. Scroll down and 

double-click on SHPlan.  This makes the SHPlan the Active Cell and attaches the cell to the cursor for 

placement. 
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6. Place the cell with the following settings at the intersection: 
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Exercise 15.3  Reference Modification 

➢ Clip Reference Files 

1. Continuing in the same file, from the Main task, select the Fence tool and place a fence on the inside of 

the plan border. 

 

 

2. From the Primary toolbar at the top of the application window, open the References dialog. 

 

3. Highlight the four reference files as indicated below and select the Clip Reference icon (  ).  Notice 

the elements highlight and the Set Reference Clip Boundary Tool Settings displays. 
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4. From the Set the Reference Clip Boundary Tool Settings, set Method to Active Fence and check 

‘Use References Dialog List’. 

 

5. Per the MicroStation prompt in the Status Bar, ‘Accept/Reject Fence Clip Boundary’ by placing a Data 

Point in the file to accept.  Notice all information outside of the border is removed from the display. 
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➢ To Copy Elements from a Reference to the Active DGN File. 

1. Continuing in the same file, from the References list box, turn off the display   for all references 

except Design. Select the Design reference in which the elements are located and ensure that the 

Display, Snap, and Locate icons are turned on. 

 

2. From the Main task bar, select the Fence tool and place a fence around the elements to be copied as 

shown below. 

 

3. From the Main task, select the Copy Element tool. The Copy Element Tool Setting displays. 
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4. From the Copy Element Tool Setting, check settings as shown below. 

 

5. Hover cursor over center Key point snap and enter a data point to define the origin of the elements to be 

copied.  The elements are dynamically displayed as the pointer is moved about the screen.  Move cursor 

to note the attachment. 

 

6. Enter a data point back at the center Key point to define the origin of the copy of the elements in the 

active model.  Right-click to Reset and end process. Data point in the DGN to release fence. 

7. From the References dialog, deselect the Display  for the Design reference and note the elements 

are indeed placed in the Active DGN file along with the Boundary. 

8. Reselect the Display  for the Alignment, Utility and Survey references. 
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➢ To Temporarily Activate a Reference for In-place Editing. 

1. Continuing in the same file, from the References dialog, select the Utility reference, right-click on the 

reference and select Activate from the pop-up menu. 

➢ To Exchange to a Reference 

1. Continuing in the same file, from the References dialog, select the Utility reference. 

2. From the References menu, select Tools > Exchange.  The current model is closed and the selected 

reference is opened, maintaining the same view orientation as shown below. 

 

3. The utexrd01.dgn is now the Active DGN and ready for any manipulation using any standard 

MicroStation tool.  

4. Notice that the Previous Arrow located in the View Groups tool bar is now activated and displays in 

green.To return to the original Active DGN, from the MicroStation menu, select the green Previous 

Arrow.   

 

5. Close the References dialog.  Exit MicroStation. 
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